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Terms Of Use

Introduction

StationManager™, its options, and supplements are provided under the terms and conditions described
herein, which may be amended at any time at the Developer’s sole discretion. One paid-in-full License
entitles one User to access the program. An internet connection is required to verify the License and provide
updates and upgrades.

Definitions

The following definitions shall apply to these Terms Of Use:
Agreement shall mean this document;
Developer shall mean B3PE LLC;
License shall mean an allowance to access the Software;

Software shall mean the StationManager program version 2.1 and newer, documentation, and any
associated options, enhancements, or supplements;

User shall mean the individual or organization purchasing the License, the individual or organization

employing the persons to be using the Software, the individual or organization otherwise responsible
for the administration of the use of the Software, or any affiliate thereof.

Terms of Use

By installing the Software, the User consents and agrees to the terms of this Agreement. If the User does not
agree to the terms of this Agreement, the User is not obligated to install the Software and may request a
refund of the Software purchase or renewal cost (only) for the current License.

By use of the Software, the User consents and agrees to accept full responsibility for the use of the Software,
including interpretations, conclusions, or decisions based on any results derived from the Software; any
claims resulting from the use, accidental misuse, or intentional misuse of the Software by the User.

The Developer neither assumes nor incurs any explicit or implied responsibility or liability for conclusions
or decisions made by the User based on values produced or derived from the Software and makes no
warranty or claim as to the fitness for use of the Software for any specific purpose other than those described
and referenced in the accompanying documentation.
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The Software is not sold; it is provided on a licensed basis via the License. Purchase of one License provides
authority for one User to access the Software, updates, and upgrades to the Software, and certain technical
support for the unmodified, useable, and practical lifetime of the Software.

Ownership of the Software and any and all associated intellectual property and rights remain with the
Developer.

Certain User information will be collected and stored by the Developer. By use of the License, the User
consents to the Developer’s use of this information for the purpose of verifying and maintaining the License

and for providing certain communications and notices to the User.

Technical support for the use of the Software, as provided by the License, shall be limited to communication
by telephone or email.

No Warranty

29 ¢¢

The Software is provided “as is,” “with all faults,” “as available,” and without warranties of any kind. Use
of the Software is at the User’s own risk. The Developer does not warrant that the Software is secure, error-
free, complete, accurate, that its methods or results are correct, except to the extent that if a method used by
the Software is derived from a reference which provides benchmark data and results, best efforts have been
made to ensure that the Software results reasonably match the documented benchmarked results.

Additional Terms

Any additional terms or conditions contained in any purchase order, purchase agreement, service agreement,
or other contractual agreement concerning the Software, as may exist between the Developer and the User,
will remain in effect only so long as the required agreement or other contractual fees are current and paid
in full. Any additional terms and conditions shall be null and void, considered ineffectual, and not binding
upon failure to pay any said fee.

General

This Agreement shall complement and be considered a part of any other purchase, service, or other
contractual agreement concerning the Software as may exist between the Developer and the User. Conflicts
between adjacent agreements shall not affect or invalidate the non-conflicting parts of this Agreement.
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Trademark Notice

StationManager, GASCalc, and the “B-Cubed” logo are trademarks of B3PE LLC. dBase is a trademark of
ASHTON TATE, a division of Borland International. Windows, Access, and Excel (and its variations and
derivations) are trademarks of Microsoft Corporation. GasValve is a trademark of Peoples Natural Gas.

Copyright Warning

The StationManager software and User’s Manual are protected under United States and international
copyright laws and treaties. Making unauthorized copies of the software or the associated documentation
violates United States and international law. Don’t be a criminal; don’t copy.

User Limit

The number of Users that can simultaneously run the StationManager software depends on the number of
User licenses purchased with the subscription. This number is referred to as the User Limit.

When StationManager is executed, it determines the User Limit associated with the subscription and the
number of Users currently using the software - the Current Users. The Welcome screen displays these values.

Ifadding a new User does not exceed the User Limit, the Continue command button will be enabled, and you

can start StationManager. If the User Limit is exceeded by allowing a new User, you will not be able to
execute the StationManager software until one of the in-use licenses is returned.

About The User’s Manual

This User’s Manual attempts to provide the User with an understanding of the StationManager software by
providing extensive descriptions and documentation of its various features. The main body of the User’s
Manual presents descriptions of the various menu items and data screens. Separate sections are provided for
several of the more extensive features. The Appendix section presents technical documentation of the
database and the various equations and data files used and supported by StationManager.

Italics are used extensively throughout the User’s Manual. Italicized words are used in two manners - one
to emphasize a word or, more commonly, to indicate the name of a menu item, command button, or keyboard

key.

Additional information and documentation may be found on our website, www.b3pellc.com.
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Introduction

StationManager is designed to be easy and intuitive to use. However, there are a few general concepts that
need to be learned before becoming proficient with the software. There are two ways to get started with
StationManager.

First, this section in the User’s Manual provides an introduction to many of the basic concepts required to
use StationManager. Review this section to obtain general information needed to use the software.

The other method is to work the example contained in the Demonstration Guide. The guide will introduce
the basic concepts to create, populate, access, analyze, review, and print a simple example database. If time
is short, we suggest you start with the Demonstration Guide and then review the contents of the User’s
Manual when more time is available.

System/Hardware Requirements

StationManager will operate on any device configured to run Windows 8 through Windows 11. The
StationManager software will require a minimum of 26 MB of free hard disk space when installed. Each
station will require approximately 19 KB of free hard disk space.

License Management System

StationManager uses an internet-based licensing system. The software can be installed on any number of
devices. License information is stored on a B3PE server. When a User attempts to use the software, the
license availability is checked on the server. If the number of “in-use” licenses is less than the purchased
number of licenses (the User Limit), the User is allowed to continue; otherwise, the use of the software is
denied until the number of “in-use” licenses is below the User Limit.

A license can be “checked out” for up to thirty (30) days. Once “checked out,” the license is unavailable for

use by any other Users until the license is checked back “in.” An internet connection is not required to use
the software during the checkout period for the device and User who checked out the license.

Database Design

The StationManager software provides the User with a comprehensive predefined database for maintaining
design, operation, inspection, and compliance data associated with pressure-reducing stations. Data is
accessed through an easy-to-use spreadsheet-style interface. The spreadsheet interface is enhanced by several
complementary interface options.

E
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® A Data Entry Form allows “fill-in-the-blank™ access and entry.
® An Audit Report allows view-only access to station and compliance data and results.

® A powerful Schematic Data Interface allows graphical viewing of data values and results and
point-and-click access to the station data.

Integral to the database is a full calculation engine for performing capacity and pressure calculations to
ensure regulatory and operational compliance.

The StationManager database consists of files containing various values associated with different aspects
of the station data. These include a file containing general database setup and default information, a file
containing general station information, a file containing the data required for the hydraulic analysis, a file
containing inspection results, and a file containing specific equipment information for the pressure regulating
and relief devices. The Station Data file contains a record for each station. Each station record is linked to
the remaining data files so that all data can be accessed based on the selected station record.

StationManager defines a station as a collection of runs, stages, devices, and piping sections. A run consists
of one or more stages. A stage consists of one or more devices and the associated piping sections. A device
is a pressure limiting or overpressure device - regulator or relief valve. Devices are designated upstream
(regulator) or downstream (regulator or relief valve). The piping sections are defined as upstream (supply
or inlet), intermediate (between the upstream and downstream device), downstream (outlet of station), and
stack (outlet of relief valve).

A station can contain one or two runs. A run can contain one or two stages. A stage can contain one or two
devices. Stages can be configured as regulator only, regulator-regulator, regulator-relief valve, dual regulator-
relief valve, or relief valve only. Operation schemes for regulator-regulator configurations can be upstream
monitoring - downstream controlling, upstream working monitor - downstream controlling, or upstream
controlling - downstream monitoring.

When two stages are present, the downstream section of the first (upstream) stage is disabled, and the
upstream piping of the second (downstream) stage is assumed to be connected directly to the outlet of the
first-stage downstream device.

If a stage consists of a regulator only, the downstream device is disabled. The regulator must be assigned as
the upstream device. The intermediate piping is disabled, and the downstream piping is assumed to be
connected directly to the outlet of the upstream device (regulator).

If a stage consists of a relief valve only, the upstream device is disabled. The relief valve must be assigned
as the downstream device. The intermediate piping is disabled, and the upstream piping is assumed to be
connected directly to the inlet of the downstream device (relief valve).
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In addition to the station data, a set of data files called ‘“Property Tables” are also maintained. These files
contain common information about pipe, fitting, regulator, and relief valve properties. The common data
contains values such as inside pipe diameter, equivalent lengths for fittings, and valve factors for the
regulator and relief valves. The Property Tables can be customized by the User to reflect their needs.

Some of the supported station configurations are shown in the following figure.
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In addition to the configurations shown, relief valves can be “shared” between a parallel run and stage or
“combined” on stages in series. Sharing a relief valve refers to the case where regulators in a parallel run and
stage are protected by a single relief valve, assumed to be installed on one run or the other. Combining a
relief valve refers to the case where an upstream regulator is protected by two (different) downstream relief
valves - the capacity of the relief valves is combined during the compliance check. The combined relief
valves are assumed to be installed in series on the same run.

The device control lines are assumed to be connected as follows:

Control Line Sense Location

Configuration

Device

Sense Location

Regulator Only

Upstream (Control)

Inlet of Downstream Piping

Monitor - Upstream

Upstream (Monitor)

Inlet of Downstream Piping

Downstream (Control)

Inlet of Downstream Piping

Monitor - Downstream

Upstream (Control)

Inlet of Downstream Piping

Downstream (Monitor)

Inlet of Downstream Piping

Monitor - Upstream Working

Upstream (Control)

Inlet of Intermediate Piping

Upstream (Monitor)

Inlet of Downstream Piping

Downstream (Control)

Inlet of Downstream Piping

Regulator/Relief Valve

Upstream (Regulator)

Inlet of Intermediate Piping

Downstream (Relief Valve)

Outlet of Intermediate Piping

Relief Valve Only

Downstream (Relief Valve)

Outlet of Upstream Piping

Sample Database

A sample database is included when StationManager is installed. The database contains sample records for
each type of station configuration supported by StationManager. The database will be automatically opened
when StationManager is first executed. To open the database at other times, use the Open item from the File
menu. Instructions for browsing and manipulating the database contents are provided in the Example section
of this Demonstration Guide. If changes are made to the sample database, the original contents can be
restored using the Restore Samples item from the File menu.
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Database Interface

The values contained in the database are accessed through a spreadsheet-style report. The data is grouped
by functionality into separate report sections, which are displayed on separate report tabs. The report consists
of tabs, rows, and columns. Each row represents a record, and each column represents a specific data item.
Each station is represented by a record and sub-records for each run and stage.

Several options are available for viewing and entering data values and results. The primary means of access
is through the Station Data Report. This access option allows direct access to the data values and results and
provides a variety of data manipulation tools. The Report interface is complimented by several additional
specialized interfaces. The Data Form allows data to be entered using a fill-in-the-blank style interface, and
the results are presented in a similar style. The Audit Form allows view-only access to station and
compliance data. The Schematic Data Interface provides graphical access to the data values and results and
allows point-and-click data editing and graphical display of the calculation results.

The Station Data Report is the only access option that allows station records to be inserted or deleted.
Records can be added to the end of the database with any edit-enabled interfaces. The report must be open
to access the station data or other data access interfaces. Tools are provided to create a selection and sorted
sets, limit the data displayed, to add, enter, insert, and move records, update values en masse based on User-
defined selection criteria, and save a selected set of data.

Notes On Dimensional Units

When StationManager first starts, its default dimensional units are set to standard US values (feet, inches,
psi, Fahrenheit). However, you will notice that the software supports a variety of dimensional units.

As used in StationManager, unless otherwise specified, all pressure units represent “gauge” units. Within
the documentation, gauge pressure units are generally shown without a suffix, and absolute pressure units

are shown with an “a” or “(Abs)” suffix. Gas volume values or volumetric flow rates are expressed in
“standard” cubic units based on (adjusted to) the specified base pressure and temperature.

Notes For International Users

StationManager attempts to accommodate the needs of international Users by providing a robust set of
dimensional units. These units can be selected as appropriate for the User’s particular needs.
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StationManager does have a particular weakness when it comes to the various Property Tables that contain
predefined data. These lists are primarily oriented toward US manufacturers and sizes. The Property Tables
can be easily modified by the User to more specifically meet the particular needs of each User. The Property
Tables provided with the software are intended to provide a starting point to allow the User to create their
custom Property Tables.

Using The Help System

The help documents are stored on the B3PE server. You must be connected to the internet to access the
various StationManager help and support documents.

The StationManager Manual can be used for information on specific screens and commands and detailed
instructions, descriptions, and explanations.

Once a document is opened, it can be saved locally. If you save a help document to your machine for offline

access, open it directly in your Portable Document Format (PDF) document viewer. A suitable PDF
document viewer or reader is required to view and print the documents.

The Help Menu

Access to the various help documents and information is provided in the Help menu. You can also view our
contact information, send a help request, or visit our website. Note - Some of the features require an internet
connection to work properly.

Contact Us

Hours - Our normal work hours are 8:00 A.M. to 5:00 P.M. Mountain Time, Monday through Friday.
However, if you have a problem, please try anytime - we may be in.

By Telephone - (719) 578-9391

By Email - help@b3pe.com

By Website - www.b3pellc.com
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General Information

This section provides a general reference for using the StationManager menu bar and the associated menu
items. Grouped by functional topic, procedures are described for using each of the menu items available in
the StationManager menu bar. Most of the menu items will launch a data or specifications screen. Further
information describing the use and features of the screens is provided in later sections of this Manual.

Certain menu items are not enabled unless a database is open.

File - File Management

The StationManager database file management routines are grouped in the File menu. The routines located
in this menu are used to manage the database files only. That is, these routines manipulate the files directly
associated with a database. The contents and use of each of the StationManager files are described in the
Appendix section.

Access to the StationManager support files, such as the Property Tables, is handled by the individual routines
that access or manipulate those specific files. Management routines such as copying and deleting the support
files must be performed manually by the User.

A StationManager database consists of several files, each possessing the same name but varying extensions.
Some of the files represent the general station, inspection, equipment, and default data associated with each
database, while other files represent support or other data files. A full list of the specific file extensions is
contained in the Appendix section. StationManager manages the database files based on the name of the
general station data file, which ends in a “.sdb” extension. When prompting for a database name,
StationManager expects the “.sdb” extension to be present. Include the “.sdb” extension when manually
entering a database name.

Only one database may be open at a time. The name of the currently open database is displayed at the top
of the main StationManager screen. Certain menu items and commands will prompt for a filename if a
function that affects a database file is executed and a database has not already been opened. Once a database
has been opened, execution of subsequent database-related routines will apply to the open database.

The routines found in the File menu are described in the following sections.
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New - Create A New Database

The New routine creates a new set of database files. To create a new StationManager database...
® From the File menu, select the New item.

® The File Selection screen is displayed. Enter the desired name in the Filename data field or select
an existing name from the Files list. Click the Continue command button.

® The Station Data Report will automatically be displayed.

Notes & Considerations

® [f the name of an existing database is selected or entered, a message will be displayed. To overwrite the
existing database files, click the Yes command button. To return to the File Selection screen without
overwriting the existing database files, click the No command button. If you choose to overwrite the database
files, the contents of the original files will be sent to the Windows Recycle Bin.

® [f the path name is omitted when entering a new name, the current drive and directory (folder) will be
assigned as the path. If the extension is omitted, the “.sdb” extension will automatically be applied.

® When executed, StationManager will create and open a new set of database files.
® As new records are added, the values initially populating the data items from new records are extracted
from the default values. The default values and dimensional units may be set using the Default Data Values

routine found in the Utilities menu.

® Sce the File Selection topic in the Data Screens section for a detailed description of its features.

Open - Open An Existing Database

The Open routine opens an existing database for editing and reporting. To open an existing database...
® From the File menu, select the Open item.
® The File Selection screen is displayed. Enter the desired name in the Filename data field or select
an existing name from the Files list. If the file cannot be found, a message will be displayed. When

a valid filename has been entered, click the Continue command button.

® The Station Data Report will automatically be displayed.
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Notes & Considerations

® [f a database is already open, a message may be displayed asking whether to save the changes. Click the
Yes command button to save changes to the open database, close the database, and open the selected
database. Or, click the No command button to close the open database without saving changes and open the
selected database. Or, click the Cancel command button to return to the currently open database.

® When a valid database name has been entered, StationManager will create a temporary copy of the selected
database. Once the temporary database has been created, the various edit, report, and calculation routines
can be used to manipulate the database. Changes are saved to the temporary database and are not made to
the actual database file until the database is “saved.” Choose the desired function to proceed.

® Sce the File Selection topic in the Data Screens section for a detailed description of its features.

Open New Window

The Open New Window routine opens an existing database for editing and reporting. To open an existing
database...

® From the File menu, select the Open New Window item.

® The File Selection screen is displayed. Enter the desired name in the Filename data field or select
an existing name from the Files list. If the file cannot be found, a message will be displayed. When
a valid filename has been entered, click the Continue command button.

® The Station Data Report will automatically be displayed.

Notes & Considerations

® [f a database is already open, a message may be displayed asking whether to save the changes. Click the
Yes command button to save changes to the open database, close the database, and open the selected
database. Or, click the No command button to close the open database without saving changes and open the
selected database. Or, click the Cancel command button to return to the currently open database.

® When a valid database name has been entered, StationManager will create a temporary copy of the selected
database. Once the temporary database has been created, the various edit, report, and calculation routines
can be used to manipulate the database. Changes are saved to the temporary database and are not made to
the actual database file until the database is “saved.” Choose the desired function to proceed.

® Sce the File Selection topic in the Data Screens section for a detailed description of its features.
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Close - Close The Currently Open Database

The Close routine “closes” the currently open database. To close the current database...
® From the File menu, select the Close item.

Notes & Considerations

® [f changes have been made to the open database, a message will be displayed asking whether to save the
changes - respond appropriately.

® Each time StationManager is started, it will automatically open the last open database file. This feature
may be disabled by closing the database before exiting StationManager.

Save - Save Database Changes

The Save routine saves the changes made to the currently open database. To save changes...
® From the File menu, select the Save item.

Notes & Considerations

® Fach time the database is saved, a backup copy of the previous files are saved. If an existing set of backup
files already exist, they are moved to the Windows Recycle Bin.

Save As - Save Database To Another Name

The Save As routine saves the changes of the current database to another (different) database filename and
changes the name of the currently open database to the specified name. To save the current database changes
to another name...

® From the File menu, select the Save As item.

® The File Selection screen is displayed. Enter the desired name in the Filename data field or select
an existing name from the Files list. Click the Continue command button.

® The currently open database will now be displayed with the new database name.
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Notes & Considerations

® [f the name of an existing database is selected or entered, a message will be displayed. To overwrite the
existing database files, click the Yes command button. To return to the File Selection screen without
overwriting the existing database files, click the No command button. If you choose to overwrite the database
files, the contents of the original files will be sent to the Windows Recycle Bin.

® When a valid database name has been selected or entered, StationManager will copy the contents of the
currently open database into the database files associated with the new name.

® The Save As routine saves (copies) the contents of the data stored in memory, not the data stored in the
file on disk. To copy the data stored on the disk to another destination, use the Copy routine.

® Sce the File Selection topic in the Data Screens section for a detailed description of its features.

Rename - Change The Name Of The Currently Open Database

The Rename routine changes the name of the currently open database to another User-specified name. The
names of the various files associated with the database will be changed to the specified name. Unsaved
changes to the current database will not be saved. To change the name of the current database...

® From the File menu, select the Rename item.

® The File Selection screen is displayed. Enter the desired name in the Filename data field or select
an existing name from the Files list. Click the Continue command button.

® A message will be displayed when the Rename routine is complete. Click the OK command button
to clear the message.

Notes & Considerations

® [f the name of an existing database is selected or entered, a message will be displayed. To overwrite the
existing database files, click the Yes command button. To return to the File Selection screen without
overwriting the existing database files, click the No command button. If you choose to overwrite the database
files, the contents of the original files will be sent to the Windows Recycle Bin.

® When a valid database name has been entered or selected, StationManager will change the name of the
current database files to the User-specified name.
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® The Rename routine changes the name of the data files stored on the disk to a new User-specified name;
it does not save the data stored in memory. To save the data stored in memory to another destination, use the
Save As routine. The Rename routine does not make a copy of the disk files; it only changes the name of the
files. Use the Copy routine to make a copy of the disk files.

® Sce the File Selection topic in the Data Screens section for a detailed description of its features.

Copy - Copy The Database Files

StationManager provides a routine for copying the files associated with a database. The Copy routine will
automatically copy the various database files to a User-specified destination and database name. To copy the
files associated with the currently open database...

® From the File menu, select the Copy item.

® The File Selection screen is displayed. Enter the desired name in the Filename data field or select
an existing name from the Files list. Click the Continue command button.

® A message will be displayed when the copy has been completed. Either click the Yes command
button to open the new file or click the No command button to clear the message.

Notes & Considerations

® [f the name of an existing database is selected or entered, a message will be displayed. To overwrite the
existing database files, click the Yes command button. To return to the File Selection screen without
overwriting the existing database files, click the No command button. If you choose to overwrite the database
files, the contents of the original files will be sent to the Windows Recycle Bin.

® When a valid database name has been entered or selected, StationManager will copy the current database’s
files into the destination (target) database files.

® The Copy routine copies the contents of the data stored in the disk file, not the data stored in memory. To
save the data stored in memory to another destination, use the Save As routine.

® Sce the File Selection topic in the Data Screens section for a detailed description of its features.
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Copy With New Inspection Year

StationManager provides a routine to copy the files associated with a database and change the inspection
year. When using this routine, StationManager will automatically copy the various database files to a
specified destination database name and allow a new inspection year to be specified. To copy and change
the inspection year for the files and records associated with the currently open database...

® From the File menu, select the Copy With New Inspection Year item.

® The File Selection screen is displayed. Enter the desired name in the Filename data field or select
an existing name from the Files list. Click the Continue command button.

® The Copy With New Inspection Year screen is displayed. In the New Year Value data field, enter
the desired inspection year value, then click the Continue command button.

® Several messages will be displayed - respond appropriately.
® Upon completion of the copy routine, StationManager will prompt whether to open the new
database. Either click the Yes command button to open the new database or the No command button

to leave the current database open.

Notes & Considerations

® [f the name of an existing database is selected or entered, a message will be displayed. To overwrite the
existing database files, click the Yes command button. To return to the File Selection screen without
overwriting the existing database files, click the No command button. If you choose to overwrite the database
files, the contents of the original files will be sent to the Windows Recycle Bin.

® When a valid database name has been selected, StationManager will copy the current database’s files into
the destination (target) database files.

® The Copy With New Inspection Year routine copies the contents of the data stored in the disk file, not the
data stored in the temporary database. To save the data stored in the temporary database to another

destination, use the Save As routine.

® Sce the File Selection topic in the Data Screens section for a detailed description of its features.
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Delete - Delete The Database Files

The Delete routine deletes all files associated with a User selected database, including the backup files. To
delete an existing database’s files...

® From the File menu, select the Delete item.

® The File Selection screen is displayed. In the Filename data field, select or enter the name of the
database to be deleted. A message will be displayed if the file is not found. Once a valid name has
been entered or selected, click the Continue command.

® A message will be displayed asking to confirm the database’s deletion. Either click the Yes
command button to delete the selected database or click the No command button to cancel the

routine.

Notes & Considerations

® [f the database you are attempting to delete is open, an error message will be displayed. Click the OK
command button, then close the database and re-execute the Delete routine.

® After the selected database has been deleted, the File Selection screen will be redisplayed - either select
another database for deletion or click the Cancel command button to end the routine.

® When a valid database name has been selected, StationManager will “delete” the contents of each file
associated with the selected database. The files are not actually deleted but sent to the Windows Recycle Bin.

The files may be manually restored using Windows File Explorer.

® Sce the File Selection topic in the Data Screens section for a detailed description of its features.

Append - Append The Database Files

The Append routine provides a means for appending (joining) two databases together. The database files of
the selected database are added to the currently open database. The database to be appended must be open
before attempting to execute the Append routine. To append another database to the currently open
database...

® From the File menu, select the Append item.
® The File Selection screen is displayed. Enter the desired name in the Filename data field or select

an existing name from the Files list. A message will be displayed if a valid file is not found. When
a valid database name has been entered, click the Continue command button.
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® A message will be displayed asking to confirm the appending of the two databases. Either click
the Yes command button to append the selected databases or click the No command button to cancel
the routine.

® Additional messages may be displayed - respond appropriately.
® A message will be displayed when the Append routine is complete. Click the OK command button

to clear the message. Note - If the routine failed or the result was unexpected, close the model
without saving the changes.

Notes & Considerations

® Sce the File Selection topic in the Data Screens section for a detailed description of its features.

Merge - Update & Combine Databases

StationManager provides a routine for merging (combining) two databases together. The routine searches
for matching stations; if a match is found, the data in the open database is updated with the data from the
merging database; if a match is not found, a new station is added to the open database. To merge a database
with the currently open database...

® From the File menu, select the Merge item.

® The File Selection screen is displayed. In the Filename data field, either select or enter the
database name to merge with the currently open database. A message will be displayed if the file is
not found. When a valid database name has been entered, click the Continue command button.

® A message will be displayed asking to confirm the merging of the databases. Either click the Yes
command button to continue merging the selected databases or click the No command button to
cancel the routine.

® The Merge Specifications screen is displayed. In the Match By data list, select the items you wish
to use to check for matching stations. Either click the Continue command button to continue merging
the selected databases or click the Cancel command button to cancel the routine.

® A message will be displayed when the Merge routine is complete. Click the OK command button
to clear the message.

Notes & Considerations

® Sce the File Selection topic in the Data Screens section for a detailed description of its features.
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® Sce the Merge Specifications topic in the Data Screens section for a detailed description of its features.

Bundle - Bundle & Unbundle Database Files

StationManager provides a set of routines for bundling (zipping) and unbundling (unzipping) a database’s
file set. These routines are described in the following sections.

Bundle A Database - Zip A Database

The Bundle routine bundles all of a database’s files into a single “zip” format file. This is useful for
archiving, backing up, or sharing databases with others. The database must be open before it can be bundled.
To bundle the files associated with the currently open database...

® From the Bundle submenu of the File menu, select the Bundle A Database item.

® A message will be displayed asking whether to include assigned images in the bundled (zipped)
file. Click the Yes command button to include any assigned images or the No command button to
create the zipped file without including the assigned images.

® [fimages are included in the bundled file, a message will be displayed asking to include the image
pathname with the image names. Click the Yes command button to include the image pathname or
the No command button to create the zipped file without including the image pathname. Generally,
the pathname should not be included.

® A message will be displayed indicating whether the bundle operation succeeded or failed. Click
the OK command button to clear the message.

Notes & Considerations

® The file created by the Bundle routine will be created in the same folder as the original database file and
will be named the same as the database, except that it will end with a “.zip” extension. The bundled (zipped)
file’s format is compatible with PKZip 2.04g. The file may be unbundled using the StationManager
Unbundle routine, or it may be unzipped (extracted) using any compatible file compression program.
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Unbundle A Database - Unzip A Database

The Unbundle routine unbundles a set of files contained in a single “zip” format file. The zip file can be
created either by the StationManager Bundle routine or by another zip or compression application. To
unbundle a zip file of a database...

® From the Bundle submenu of the File menu, select the Unbundle A Database item.

® The File Selection screen is displayed. Enter the desired name in the Filename data field or select
an existing name from the Files list. If the name is manually entered, include the “.zip” extension.
A message will be displayed if a valid file is not found. When a valid database name has been
entered, click the Continue command button.

® [f one or more of the database files already exist, a message will be displayed asking whether to
overwrite the existing database files. Either click the Yes command button to overwrite the file and
continue, click the No command button to not overwrite the files and continue, or click the Cancel
command button to cancel the routine.

® A message will be displayed indicating whether the unbundle operation succeeded or failed. Click
the OK command button to clear the message.

Notes & Considerations

® Sce the File Selection topic in the Data Screens section for a detailed description of its features.

Paths (File Locations) - Set The Default File Locations

The Paths (File Locations) item allows the User to specify the default location of the various database files,
initialization files, the Property Tables, license file, and image files. These locations are used when a new
database is created or when a Property Table or file is needed. The default location is the directory (folder)
that StationManager uses first when dealing with the various file operations. In most cases, the User may
specify other locations when saving or retrieving a file. To specify the preferred locations...

® From the File menu, select the Paths (File Locations) item.
® The Path Settings screen is displayed. Select the desired data tab, then select the appropriate Drive
and Directory of the preferred location. The last open folder in the Directories list indicates the

selected path location. Click the Close command button to save changes.

Notes & Considerations

® Sce the Path Settings topic in the Data Screens section for a detailed description of its features.
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Property Tables - Set The Default Property Tables

The Property Tables item allows the User to specify which Property Tables (contained in the current
Property Table path) to use with the current database. To specify the desired Property Tables...

® From the File menu, select the Property Tables item.
® The Property Table Selection screen is displayed. To change the Property Table path, click the
Change Path Setting command button. Select the desired location, then select the desired Property

Table names. Click the Close command button to save changes.

Notes & Considerations

® Sce the Property Table Selection topic in the Data Screens section for a detailed description of its features.

Preferences

StationManager allows the User to specify certain User interface behaviors. The available settings are
described in the following sections.

Set Image Editor

When selected, the Image Editor Specifications screen is displayed. To change the name and path of the
image editor used by StationManager, type the appropriate path and name in the Program Path & Name data
field and click the Close command button. To close the screen without changing the path and name, click
the Cancel command button. If no path and name are entered, the default Windows viewer/editor will be
used.

Notes & Considerations

® Sece the Image Editor Specifications topic in the Data Screens section for a detailed description of its
features.

Set Preferences

The Set Preferences item allows the User to specify several settings that affect various behaviors of the
StationManager User interface. To change the preferences...

® From the Preferences submenu of the File menu, select the Set Preferences item.

=
,5 B3PE LLC Engineering & Software Services
24 Revision - 002, Copyright 2024, All Rights Reserved.




StationManager™ 2.1 Menu Items

Table Of Contents

® The Preference Settings screen is displayed. Select the desired options. Click the Close command
button to save changes.

Notes & Considerations

® Sce the Preference Settings topic in the Data Screens section for a detailed description of its features.

Set Calculation Options

When selected, the Calculation Options screen is displayed. Either enter or select the desired calculation
options. Click the Close command button to close the screen and save changes.

Notes & Considerations

® Sce the Calculation Options topic in the Data Screens section for a detailed description of its features.

Restore Previous Database - Restore Database Files

The Restore Previous Database item provides a routine for restoring the backup copies of a database’s data
files. StationManager automatically creates a backup copy of the various database files each time the Save
routine is used. To restore the backup version of the currently open database...

® From the File menu, select the Restore Previous Database item.

® A message will be displayed asking whether to proceed with the restoration. Either click the Yes
command button to proceed or click the No command button to cancel the routine.

® A message will be displayed once the restoration is complete. Click the OK command button to
clear the message.

Restore Samples - Restore The Sample Databases

When StationManager is installed, several sample (example) files and databases are copied to the destination
disk. As the various examples are worked, these files will change. To restore the original (unchanged)
example database files...

® From the File menu, select the Restore Samples item.
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® A message will be displayed when the sample databases have been restored. Click the OK
command button to clear the message.

Release Read-Only - Remove Read-Only Flag

When a StationManager database is opened, a “flag” is set so other Users may not save changes to the
opened database. If StationManager is closed unusually (crash or power is lost while running), or the
database is not closed properly, the Read-Only Flag may not be removed. The Release Read-Only menu item
may be used to remove the Read-Only Flag so that the database can be edited and saved. To remove the read-
only flag...

® From the File menu, select the Release Read-Only item.
® A message will be displayed asking whether to release the Read-Only Flag to allow others to
overwrite any changes. Click the Yes command button to proceed or the No command button to

cancel the routine. If the Yes command button is clicked, a message will be displayed when the Read-
Only Flag has been released. Click the OK command button to clear the message.

Exit StationManager - Closing StationManager

When the Continue command button is clicked on the StationManager Welcome screen to enter the software,
a license of the StationManager software will be “checked-out.”

When exiting the StationManager software, there are two options - to “return” the checked out license or to
keep the license “checked out.”

® To return the “checked out” license, from the Exit StationManager menu, click the And Return
License item. In order to return the “checked out” license, the device must be connected to the
internet so that the User Limit can be updated.

® To keep the license “checked out,” from the Exit StationManager menu, click the Without
Returning License item. The User Limit will not be updated, and the license will remain “checked
out” until the license is “returned.” This option allows for the software to be used without having
access to an internet connection for up to 30 days. Select the And Return License item from the Exit
GASWorkS menu to return a “checked out” license.

Notes & Considerations

® [fa database is open when StationManager is closed, that database will automatically be reopened the next
time StationManager is started.
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Edit - Enter & Edit Data

Most database data editing features are handled in the Station Data Report, Data Entry Form, or Schematic
Data Interface routines. A few special Edit routines are handled outside of those functions. These routines
are accessed through the Edit menu. The routines found in the Edit menu are described in the following
sections.

Mass Update - Update The Database Data

The Mass Update routine allows changes en masse to be made to a data value based on a User-specified
criteria. For example, the Mass Update routine could be used to set the Flowing Temperature value to 50°F
for all stations with an elevation of 5000 feet or greater. To make a mass data change...

® From the Edit menu, select the Mass Update item.

® The Mass Update Specifications screen is displayed. Either enter or select the desired values as
appropriate. Click the Update command button to perform the update.

Notes & Considerations

® [f an erroneous mass update is performed, immediately click the Restore command button to restore the
original data values.

® Sce the Mass Update Specifications topic in the Data Screens section for a detailed description of its
features.

Undo Change - Restore Changes Made Since The Last Mass Update

To undo all of the data value changes made to the database since the last mass update was made, select the
Undo Change item from the Edit menu. A message will be displayed - respond appropriately.

Notes & Considerations

® This command is intended to undo data value changes made by the Mass Update routine. This command
will undo all of the data value changes from all of the sources made since the last mass update was
performed. To minimize unintentionally undoing any non-Mass Update routine changes, this command
should be used as soon as possible after an unintentional Mass Update has been performed.
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Analysis - Calculating Values

The StationManager Calculation routines are grouped under the Analysis menu. The routines found in the
Analysis menu are described in the following section.

Calculate Station Values - Calculation Summary

The Calculate Station Values item recalculates station pressure and flow values under normal and failed
conditions and performs a compliance check. The Calculation Summary is displayed with summary
information, including the number of stations, runs and stages processed, and the number of stations passing
or failing. Click the OK command button to clear the message.

StationManager Message... X

o' Calculation Summary...

Stations Processed = 10
Runs/Stages Processed = 15

Results:
Runs/Stages Passed = 15
Runs/Stages Failed (Due To Compliance Issue)} = 0
Runs/Stages Ignored (Due To Calculation Error) = 0
Runs/Stages Skipped (Not Set To Calculate) = 0
Runs/Stages Overriden (By User Selection) = 0
Runs/Stages Not Calculated = 0

Last Calculated At 07:38 AM On 11/3,/2023
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Report - View & Print Data

The StationManager Report routines are grouped in the Report menu. The routines located in this menu are
used to view and print the data contained in the database and support files. The routines found in the Report
menu are described in the following sections.

Station Data - View & Edit Station Data

The Station Data Report creates a spreadsheet-style report in which the various functional data groups are
accessed by tabbed sections. Selected data values may be edited. Portions of the report format may be
configured by the User. To open the Station Data Report...
® From the Report menu, select the Station Data item.
® [f a database has not been previously opened, the File Selection screen is displayed. If the screen
is displayed, enter the name of an existing database. When a valid name has been entered, the Station
Data Report is displayed.
® Browse through the report and various data tabs. Edit data value as desired.

® To close the Station Data Report, click the Close command button.

Notes & Considerations

® Sce the Station Data Report topic in the Data Screens section for a detailed description of its features.

Property Tables - View/Edit The Property Table Report

StationManager uses several Property Tables to maintain common information associated with the various
hydraulic feature types. An extensive set of “standard” Property Tables are supplied by StationManager. To
view or edit the standard Property Tables...

® From the Report menu, select the Property Tables item.
® The Property Table Report is displayed. Select the desired data tab (Property Table). View or edit
the desired data values by clicking on the associated data cells. Click the appropriate icon to add,

delete, or insert a record into the Property Table. Click the Close command button.

® [f changes have been made, a message will be displayed asking whether to save the changes -
respond appropriately.
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Notes & Considerations

® Sce the Property Table Report topic in the Property Tables section for a detailed description of its features.

Calculation Summary - Process Statistics

StationManager provides a routine for reporting the calculation statistics. The Calculation Summary item
displays the Calculation Summary Report listing the number of stations processed, the number of runs and
stages processed, failed condition results, and normal condition results. Click the Close command button to
close the report.

Database Summary - Summarize The Database Contents

StationManager provides a routine for summarizing the contents of the database. For example, listing the
various regulators contained in the database and how many times they are assigned to a run. The Database
Summary item displays the Database Summary Report Options screen. The routine may display any or all
of the following summaries - Configuration, Downstream Device, Fitting, Pipe, or Upstream Device. Select
the desired options. The Database Summary Report will list the routine results. The report lists the Size/Type
Code of the various items in the database and the total quantity assigned. Click the Close command button
to close the report.

Notes & Considerations

® Sce the Database Summary Report topic in the Data Screens section for a detailed description of its
features.

® See the Database Summary Report Options topic in the Data Screens section for a detailed description of
its features.

Set Report Options - Set The Report Format Options

StationManager allows the User to specify various report format options, including the number of decimal
places that are used when displaying the data and analysis results, coordinate data, and the default data entry
screen. These settings are referred to as the Report Options. To set the Report Options...

® From the Report menu, select the Report Options item.

® The Report Options screen is displayed. Enter or select the desired settings. Click the Close
command button to save changes and close the screen.
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Notes & Considerations

® Sce the Report Options topic in the Data Screens section for a detailed description of its features.
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Utilities - Use The Utility Routines

StationManager provides routines for performing various database support functions. These features are
referred to as the Utility routines. They include routines for setting default values and performing various
Import and Export routines. The Utility routines are grouped in the Utilities menu. These routines are
described in the following sections.

Set Default Values - Specify The Default Data Values

The initial data and unit values used to populate the various data fields are referred to as the “default data.”
The Set Default Values routine allows the User to set the values for certain data items, which are
automatically populated when new station records are imported to create a new database or added to an
existing database. To specify the default data values...

® From the Utilities menu, select the Set Default Values item.
® The Default Data Values screen is displayed. Select the desired data tab, and enter or select the
appropriate default data or options. Click the Close command button to close the screen and save

changes.

Notes & Considerations

® The Set Default Values routine is commonly used to set default data values and dimensional units before
entering data. The default data values will be used when a new feature is added. However, the routine can
also change the data values for existing features by clicking the appropriate “Apply...Only” command button.
Be careful using the various “Apply” command buttons when features already exist in the model - all
associated values will be changed to the specified default data values.

® Sce the Default Data Values topic in the Data Screens section for a detailed description of its features.

Import/Merge - Import & Merge Data

StationManager provides various Import and Merge routines for exchanging data with other applications
through a variety of file formats. These routines are controlled through the Import/Merge screen. To import
or merge database data...

® From the Utilities menu, select the Import/Merge item.

® The Import/Merge screen is displayed. Select the desired file format from the File Type list, then
click the appropriate command button.
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® The File Selection screen is displayed. Select the desired target and source files, then select the
Continue button.

® Depending on the specified File Type, additional data screens may be displayed to define the
Import or Merge Specifications further - respond appropriately.

® The Import/Merge Log on the Import/Merge screen will display the status of the Import/Merge
routine. When finished, click the Close command button to exit the screen.

Notes & Considerations

® The Import routine creates a new database file from the source file.

® The Merge routine adds, combines, or updates data from a source file to a target file.

® When a valid database name has been entered, a new database will be created to input the data.

® [f the name of an existing database is selected or entered, a message will be displayed. To overwrite the
existing database files, click the Yes command button. To return to the File Selection screen without
overwriting the existing database files, click the No command button. If you choose to overwrite the database
files, the contents of the original files will be sent to the Windows Recycle Bin.

® Sce the File Selection topic in the Data Screens section for a detailed description of its features.

® See the Import/Merge topic in the Import & Merge Routines section for a detailed description of its
features.

Import GasValve File - Import A GasValve File

StationManager provides a specific routine for importing GasValve files. To import a GasValve file...
® From the Utilities menu, select the Import GasValve File item.

® The File Selection screen is displayed. Select the desired source location and target name, then
click the Continue command button.

® After the translation is complete, click the Close command button.

Notes & Considerations

® Sce the File Selection topic in the Data Screens section for a detailed description of its features.
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® Sce the Import A GasValve Database topic in the Import Routines section for a detailed description of its
features.

Export - Export Data

StationManager provides various Export routines for sharing its data with other applications through a variety
of file formats. These routines are controlled through the Export screen. To export data from the currently
open database...

® From the Utilities menu, select the Export item.

® The Export screen is displayed. Select the desired file format from the File Type list, then click
the Export command button.

® The File Selection screen is displayed. Enter the desired name in the Filename data field, then
click the Continue command button.

® Depending on the specified File Type, additional data screens may be displayed to further define
the Export Specifications - respond appropriately.

® The Export Log on the Export screen will display the status of the Export routine. When finished,
click the Close command button to exit the screen.

Notes & Considerations

® The database from which the data is exported must be open before selecting the routine.
® The Export routine creates a selected format target file from a database file.

® Sce the Export topic in the Export Routines section for a detailed description of its features.
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Window - Window (Screen) Access Utilities

Several utilities are provided to arrange and access open windows (screens). These routines are grouped in
the Window menu. These routines are described in the following sections.

Arrange Screens - Arrange The Open Screens

When several screens are open and overlapping, it is sometimes helpful to have the screens automatically
arranged for easier viewing. Select the Arrange Screens item from the Window menu to arrange any open
screens automatically. The screens will be placed in a stacked arrangement.

Windows List - Access The Open Screens

A list of open screens is displayed in the Window menu. When several screens are open and overlapping, it
is sometimes difficult to access a specific screen. A screen may be easily and quickly accessed by selecting
its name from the Window List. When a screen name is selected, it is moved to the top (or in front) of the
other screens.
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Help - View The Help Resources

Access to various information and documents is provided in the Help menu. These routines are described
in the following sections.

An internet connection is required to display and view the various StationManager help and support

documents. Once a document is opened, it can be saved locally. If the document is saved locally, we suggest
storing the documents in the “\app\docs” subfolder of the root (main) StatMan program folder.

View Getting Started Guide

StationManager provides a Getting Started Guide to help with the installation and execution of the software.
To view the Getting Started Guide while connected to the internet, click the View Getting Started Guide item
from the Help menu.

View Demonstration Guide

The information contained in the Demonstration Guide is intended to provide an overview of the
StationManager software. To view the Demonstration Guide while connected to the internet, click the View
Demonstrated Guide item from the Help menu.

View User’s Manual

The User’s Manual attempts to provide the User with an understanding of the StationManager software by
providing extensive descriptions and documentation of its various features. The main body of the User’s
Manual presents descriptions of the various menu items and data screens. To view the User’s Manual while
connected to the internet, click the View User’s Manual item from the Help menu.

View Calculation References

The equations used by StationManager are similar to the equations and methods used by our GASCalc
software. To avoid duplicating the equation documentation, the GASCalc Calculation References for the
applicable calculations can be viewed using the items in the View Calculation References submenu.
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Technical Support - How To Contact Us

Several support options are contained in the Technical Support submenu. These items are described in the
following sections.

Contact Information

To view our contact information, select the Contact Information item from the Technical Support submenu
of the Help menu. Our Contact Information is displayed. Click the OK command button to close the screen.

Send Help Request

To send a help request to us, select the Send Help Request item from the Technical Support submenu of the
Help menu. An email will be generated and displayed. Describe the nature of your problem or issue in an
email. After completing the problem description, “send” the email. We will reply to the help request at our
earliest convenience.

Visit Website

Our website contains links to software updates, additional documentation, and general information about our
products and services. To visit our website directly, select the Visit Website item from the Technical Support
submenu of the Help menu. An internet connection is required for the link to work.

Terms Of Use

Select the Terms Of Use item to display the Terms Of Use document for the current StationManager software
installation.

About StationManager - Software Information

Select the About StationManager item to display the version and setup information about the current
StationManager software installation. The StationManager Information screen is displayed. Once reviewed,
click the OK command button to close the screen.
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The previous section described the function of the StationManager menu items. In that section, numerous
data and specification screens were introduced. This section provides a detailed description of many of those
screens. Separate sections are also provided for the more extensive routines and functional groups. The
descriptions are listed in alphabetical order based on the screen name.

Audit Report

The Audit Report displays a summary of the station data and results. The Audit Report is accessed
by clicking the Display Audit Report icon from the Station Data Report. The features associated | |===
with the report are described as follows.

Station Record: 1 - Sample, Anytown, CO, Sample 1 X
Location Information. . Inspection Results. ..
District Identification: Sample FY: 2005 Past Due By 6604 Days
City/Town, State: Anptown, CO Previous Date: 0770572004
Station Identification: Sample 1 Required Date: 1070472005
Area/Description: PRY To Somewhere Inspection Date:
Location: Anywhere Inspected By: Joe Inspector
Notes: Regulator/Relief Valve Findings: 4 Items Failed Inspection. Required Action Not
Completed.

Configuration/E quipment Information. ..

Run/Stage Configuration: Working - 1st Cut. Regulator - Relief Valve

Upstream Device... Downstream Device...
Manufacturer: Fisher Controls Manufacturer: Fisher Controls
Model: 299 Model: 1808
Body Size: 1-1/2 Inches Body Size: 2 Inches
Orifice Size: 1/2 Inches Orifice Size:
MNormal/F ailed Coefficient: 200 / 203 Mormal/F ailed Inlet P: 30.00 / 40.00 Psi
Set Point: 30.00 Psi Set Point: 40.00 Psi
Nominal Inlet P Min/Max: 50.00 / 100.00 Psi Coefficient: 1410

Calculated Inlet P Norm/Fail: 49.98 / 99.93 Psi

Calculation Results. ..

Pressures.... Capacities. ..
MADP: Max Allowable: Max Calculated: Required: Normmal: Failed:
Up: 100.00 100.00 100.00 Psi Up: 10.000 15.158 29.978 Mcth
Int: 100.00 110.00 40.10 Psi Dn: 29.978 157.522 Mcfh
Dn: 66.00 72.60 40.00 Psi
Calculation Reviewed By: Station Passed, Stage Passed

Aun 1 - Stage 1

<< Previous Station I« Mid >| Mext Station >> Last »| [
Print Close [
5 . . .
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Displayed Items

Calculation Results -

Calculation Review By - Displays the name of the person who reviewed the calculation.
Review Date - Displays the date when the calculation was reviewed.

Capacities -

Failed - Displays the failed capacity of the associated device.
Normal - Displays the normal capacity of the associated device.

Required - Displays the required capacity of the associated device.

Pressures -

MAQOP - Displays the Maximum Allowable Operating Pressure of the associated piping
section.

Maximum Allowable - Displays the maximum code-allowed pressure under failed
conditions of the associated piping section.

Maximum Calculated - Displays the maximum calculated pressure under failed conditions
of the associated piping section.

Configuration/Equipment Information -

Run/Stage Configuration - Displays the station’s run and stage configuration.

Downstream Device -

Body Size - Displays the body size associated with the selected Size/Type Code.
Coefficient - Displays the sizing/rating factor for the associated device.

Manufacturer - Displays the manufacturer’s name associated with the selected Size/Type
Code.

Model - Displays the model name or number associated with the selected Size/Type Code.

Normal/Failed Inlet Pressure - Displays the inlet/upstream pressure to the device under
normal and failed conditions.
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Orifice Size - Displays the orifice size associated with the selected Size/Type Code.
Set Point - Displays the set/control point for the associated device.

Upstream Device -
Body Size - Displays the body size associated with the selected Size/Type Code.

Calculated Inlet Pressure Normal/Failed - Displays the calculated inlet/upstream pressure
to the device under normal and failed conditions.

Manufacturer - Displays the manufacturer’s name associated with the selected Size/Type
Code.

Model - Displays the model name or number associated with the selected Size/Type Code.
Nominal Inlet P Minimum/Maximum - Displays the “nominal” minimum and maximum
inlet/upstream pressure to the device. Nominal pressure represents the supply/inlet pressure

to the upstream piping.

Normal/Failed Coefficient - Displays the sizing/rating factor for the associated device for
normal and failed conditions.

Orifice Size - Displays the orifice size associated with the selected Size/Type Code.
Set Point - Displays the set/control point for the associated device.
Location Information -
Area/Description - Displays additional descriptive information about the station.
City/Town, State - Displays the city or town and state associated with the station location.
District Identification - Displays the pressure or operating district associated with the station.
Location - Displays the descriptive location of the station.
Notes - Displays comments and notes for the associated station.
Station Identification - Displays the station’s identification assignment.
Inspection Results -

Findings - Displays a summary of the field inspection results.
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FY - Displays the calendar year for which the inspection/review applies.

Inspected By - Displays the name of the person who performed the field inspection.
Inspection Date - Displays the date when the field inspection was performed.
Previous Date - Displays the previous inspection/review date.

Required Date - Displays the date when the current inspection is due.

Command Buttons

Close - Closes the report screen.

First - Displays the first station in the current report.

Last - Displays the last station in the current report.

Middle - Displays the station in the middle of the current report.

Next Station - Displays the next station in the current report.

Previous Station - Displays the previous station in the current report.

Print - When clicked, the Print Settings screen is displayed to print the contents of the currently displayed

report.

Notes & Considerations

® The Audit Report only allows the viewing and display of the data and results. The report cannot be used
to revise or change data.

® The content of the screen will vary depending on the station configuration.

® Sce the Database Definition topic in the Appendix section for additional information on the data items
displayed on this screen.
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Calculation Options

StationManager allows the User to set various options and limits for the calculation and review of the station
hydraulic values and results. These values are set using the Calculation Options screen. The Calculation
Options screen is accessed by selecting the Set Calculation Options item from the Preferences submenu from
the File menu. The features associated with the screen are described as follows.

Calculation Options...
Check Limits/Values. ..

Regulatory Code/Specification: [US DOT Part 192 L]
Inspection Frequency: [US DOT Part 192 Ll
Inspection Interval: Annually, Not To Exceed 15 Months
Atmospheric Calculation Method: [AGAJ"Smilhsonian L‘
Failure Style For Two Stage Set: [Single (Independent) Failure L]
Velocity Limit - Failed Conditions:  |1500.00

VYelocity Limit - Normal Conditions: 200.00 Feet/sec

Outlet To Set Pressure Ratio Limit:  |90.00 Feet/sec

Other Options: Ignore Reset Differential Handling

v| Limit Pipe Flow To Sonic Yelocity
v Limit Relief Inlet To Mo Less Than Reset Pressure I

¥ Limit Relief Stack Outlet To Atmospheric Pressure

Cancel | Close I

Data Items

Atmospheric Calculation Method - Specifies the method to calculate the atmospheric pressure values.
Failure Style For Two Stage Set - Specifies the failure mode for runs containing two pressure stages.
Inspection Frequency - Specifies ISSUE

Inspection Interval - Specifies ISSUE

Outlet To Set Pressure Ratio Limit - Specifies the check value for the station outlet to the control device
set pressure ratio.

Regulatory Code/Specification - Specifies the regulatory code or specification for the compliance check
calculation.
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Velocity Limit - Failed Conditions - Specifies the maximum velocity limit for failed condition checks.

Velocity Limit - Normal Conditions - Specifies the maximum velocity limit for normal condition checks.

Other Options -

Allow Empty Component Lists - When selected, allows no components to be assigned to a piping
section. If the option is not selected and one of the component lists is empty, an error message will
occur during the calculation.

Ignore Inlet/Relief Valve Or Security Valve Set Pressure Check - When selected, indicates
whether the relief valve set pressure is checked against the maximum station supply pressure during
calculations. ISSUE

Ignore Relief Valve Build-Up Pressure Check - When selected, the relief valve inlet (build-up)
pressure may fail below the set pressure plus the minimum build-up pressure during the failed
pressure calculations. If the option is not selected, the relief valve inlet pressure is maintained at or
above the set pressure plus minimum build-up pressure. In either case, the set pressure plus minimum
build-up pressure value is used during the MAOP comparison.

Ignore Minimum Differential Pressure Check - When selected, the minimum differential is set
to zero (0) during the calculation. If the option is not selected and the minimum differential is not
met during the calculation process, an error will be generated, and the station/run will be ignored.

Ignore Reset Differential Handling - When selected, the minimum reset differential is ignored
when calculating the relief valve reset pressure.

Limit Pipe Flow To Sonic Velocity - When selected, the flow through all pipe sections is limited
to a velocity less than or equal to sonic velocity. If the option is not selected, the flow velocity is
unlimited.

Limit Relief Inlet To No Less Than Reset Pressure - When selected, the relief valve inlet pressure
cannot fall below the associated reset pressure during the failed calculations.

Limit Relief Stack Outlet To Atmospheric Pressure - When selected, the pressure at the
downstream (outlet) end of the relief vent stack cannot exceed atmospheric pressure during the failed
calculations.

Reset Review Date When Station Calculated - When selected, the review date value will be set
to the current date when the station record is calculated. If the option is not selected, the review date

is unchanged when a calculation is performed.

Use Downstream Allowable Buildup Pressure For Failed ISSUE - When selected ISSUE
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Command Buttons

Cancel - Closes the screen without saving changes.

Close - Closes the screen and saves changes.

Notes & Considerations

® When the Limit Pipe Flow To Sonic Velocity calculation option is selected, the pipe flow in the various
sections of the station, including the stack piping, is limited to sonic velocity (choked flow). When the stack
piping is limited, the capacity of the relief valve may also be limited. The relief valve cannot pass any more
volume than the stack can pass. When this option is not selected, the flow velocity in the piping sections and
the stack are allowed to be unlimited; this may yield unrealistic and overly optimistic capacity results for the
relief valve.

® The Failure Style For Two Stage Set calculation options are used as follows:

Failure Style Use

Single (Independent) Failure | Assumes only one device has failed when performing the second
stage failed condition calculation. For example, if the station is
configured with a monitor regulator in the first stage and a
regulator and relief valve in the second stage, only the regulator
in the second stage is assumed to have failed when computing the
required capacity for the relief valve.

Double (Coincident) Failure | Assumes that multiple devices have failed when performing the
second stage failed condition calculation. For example, if the
station is configured with a monitor regulator in the first stage
and a regulator and relief valve in the second stage, both the
monitor and controlling regulator in the first stage and the
regulator in the second stage are assumed to have all failed when
computing required capacity for the relief valve.

® Normally, an error is generated, and the station cannot be calculated if the relief valve set pressure value
is higher than the maximum station supply pressure value - this normally indicates that a data entry error has
occurred. However, there may be cases where it is desirable to allow the relief valve set pressure to be greater
than the supply pressure. In these cases, although the relief valve is present, it would never theoretically be
activated. To allow these types of stations to be calculated, select the Ignore Inlet/Relief Or Security Valve
Set Pressure Check calculation option. ISSUE
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® The Outlet To Set Pressure Ratio Limit checks for acceptable pressure drop across the downstream or take-
away piping. Excess pressure drop across this portion of piping is often a cause of unsatisfactory downstream
system pressures.

® The Velocity Limits are only used to check for excess pipe velocity values under the associated conditions.
They do not limit or affect the flow capacity of the piping sections.

® When the Limit Relief Stack Outlet To Atmospheric Pressure calculation option is selected, the pressure
at the downstream (outlet) end of the vent stack piping is limited to no more than atmospheric pressure. In
cases where the flow velocity in the stack piping reaches sonic velocity (choked flow), using this option will
underestimate the capacity of the stack and, thus, the relief valve, yield conservative results. When the option
is not selected and choked flow is present, the stack outlet pressure can increase to more realistic values,
yielding more realistic stack and relief valve capacity values.

® When the Limit Relief Inlet To No Less Than Reset Pressure calculation option is selected, the pressures
downstream are maintained at or above the reset pressure of the relief valve. In cases where the relief valve
will automatically reset itself, this option allows the pressures downstream of the regulator to be more
accurately represented. When the option is not selected, the pressures downstream of the regulator can drop
below the relief valve set pressure. In this case, the calculated pressure values represent the pressures that
would be present if the relief valve remained open and no backflow was present from the downstream
system.
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Calculation Summary Report

The Calculation Summary Report is accessed by selecting the Calculation Summary item from the Report
menu. The screen lists the number of stations processed, the number of runs and stages processed, failed
condition results, and normal condition results. The features associated with the screen are described as
follows.

=l Calculation Summary Report - C:\Program Files (x86)\StatMan 2.1\ini\4810742... E=RcE ™

=|

Calculation Summary._..

Stations Processed = 10
Runs/Stages Processed = 15

Results:
Runs/Stages Passed = 15
Runs/Stages Failed (Due To Compliance lssue) = 0
Runs/Stages lgnored (Due To Calculation Error) = 0
Runs/Stages Skipped [Not Set To Calculate) = 0
Runs/Stages Overriden (By User Selection]) = 0
Runs/Stages Not Calculated = 0

Last Calculated At 01:22 PM On 11/4/2024

‘ Close

Icons

Maximize Screen Size - Increases the report’s size to fill the StationManager display.

Print - Prints the contents of the report. When clicked, the Print Settings screen is displayed.

Reset Screen Size - Sets the report’s size to its “normal” dimensions and position.
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Command Buttons

Close - Closes the report screen.

Notes & Considerations

® The Calculation Summary Report is created when the database is “calculated.” If changes have been made
to the database since it was last calculated, the values in the report may not be current. If the database has
not been calculated, the report will be empty.
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Columns

The User may select the data items (columns) that are displayed in many of the various Reports.
The Columns specification screen is used to make these selections. The Columns specification @
screen is accessed by clicking the Set Columns icon from the associated report screen. The
features associated with the screen are described as follows.

SET

Columns...

v Location Information Distrnict Identification

+ Location Information City/Town

v Location Information State |
v Location Information Legal Description

v Location Information Station ldentification

+ Location Information Station Description

v Location Information Location

v Location Information X Coordinate

+ Location Information ¥ Coordinate

v Configuration Operating Status

Cancel Apply

Data Items

Columns - When selected, the associated data item (column) will be displayed in the associated report. The
contents of the Columns list will vary by report.

Command Buttons

Apply - Closes the screen and applies the changes.

Cancel - Closes the screen without applying changes.

Notes & Considerations

® The Set Columns routine may be used to adjust the report width when printing. Normally, the report will
contain more information than will fit on a single page. Use the Columns specification screen to eliminate
some of the undesired columns from the report by unselecting the unwanted data items (columns).

® To display a specific column, select the column name.

® To display all of the columns, click the Restore Columns icon.
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Copy With New Inspection Year

The Copy With New Inspection Year screen is accessed by selecting the Copy With New Inspection Year
item from the File menu. The features associated with the screen are described as follows.

Copy With New Inspection Year...

Mew Year Value: |2025

Cancel | Continue._.

Data Items

New Year Value - Specifies the new inspection year. Enter a value using the following format -
MM/DD/YYYY.

Command Buttons

Cancel - Closes the screen without copying the database with a new inspection year.

Continue - Proceeds with the routine.
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Data Entry Form

interface used by the Data Entry Form provides a “fill in the blank” style format. The form is
accessed by clicking the Display Data Entry Form icon from the Station Data Report. Changes
made using this form will be reflected in the Station Data Report. The features associated with
the form are described as follows.

StationManager provides several User interface styles for accessing and entering data. The ‘

General Tab - Location/Configuration Tab

+  Station Record: 1 - Sample, Anytown, CO, Sample 1

General ] Run 1 Stage 1 \i Compliance 1 Inspection ] Images

Location Information...

District Identification: |Sample

City/Town: [An_vtovm State: |[CO ~ I

Legal Description: [Sec Rng Twn

Station Identification: [Sample 1

Area/Description: [PRV To Somewhere
Location: [An_vwhele
X Coordinate: W Y Coordinate: W Degrees L/L
Configuration... Capacity...
Operating Status: |In Service = Minimum Required: [1.00 Mcfh
PN Lt | 1 ~| Stages Per Run: [1 -] Maximum Required: [10.00 Mcfh

<Back MNext>

Location/Configuration J Gas Properties/Miscellaneous

I< First << Previous Station Ik Mid >1 Next Station >> | Last >] |

Cancel Print | Calculate Close |

Data Items

Area/Description - Specifies additional descriptive information about the station.
City/Town - Specifies the city or town associated with the station location.

District Identification - Specifies the pressure district or operating district associated with the station.
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Legal Description - Specifies the “legal” description of the station location - for example, Southwest 1/4
of Section 28.

Location - Specifies the descriptive location of the station. For example, the Northeast corner of 1¥ and Main
Streets.

Maximum Required - Specifies the maximum required flow capacity of the station.

Minimum Required - Specifies the minimum required flow capacity of the station.

Number Of Runs - Specifies the number of runs for the station.

Operating Status - Specifies the station’s operating status.

Stages Per Run - Specifies the number of pressure cuts/stages for each run.

State - Specifies the state associated with the station location.

Station Identification - Specifies the station’s identification assignment - for example, TBS #1.

X Coordinate/Y Coordinate - Specifies the coordinates for the station’s location.

Notes & Considerations

® Descriptive data items, such as Area/Description and Location, are not used in the hydraulic calculations.
These items can be used to enter any alphanumeric data values.

® Sce the Database Definition topic in the Appendix section for additional information on the data items
displayed on this data tab.
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General Tab - Gas Properties/Miscellaneous Tab
General 1 Run 1 Stage 1 I Compliance ] Inspection T Images
Gas Properties... Miscellaneous. ..
Elevation: 0 t In-Service Date: [0?!04!2004
Atmospheric Pressure: |[14.73 Psi [Abs) Junsdiction: [I.IS poT _j
Flowing Temperature:  |60.0 F Designed By: [Joe Designer
Base Pressure: 14.73 Psi [Abs) Design Date: [03!05?2004
Base Temperature: 60.0 F Entered/Revised By: [Joe Entry

Entiy/Revision Date: [07.’07.’2004

Comments/Notes:

Specific Gravity: 0.600 Regulator/Relief Valve

Viscosity: 0.000007 Lbm/Ft-sec

Specific Heat Ratio: 1.300
<Back Next>

Location/Configuration l Gas Properties/Miscell

Data Items

Base Pressure - Specifies the pressure basis for the entered and calculated volumes.
Base Temperature - Specifies the temperature basis for the entered and calculated volumes.

Comments/Notes - Displays the comments and notes associated with the station configuration, location, or
operation.

Design Date - Specifies the date when the station was initially designed. Enter a value using the following
format - MM/DD/YYYY.

Designed By - Specifies who designed the station.
Elevation - Specifies the height above the mean sea level of the station’s location.
Entered/Revised By - Specifies who entered or last reviewed the data for the station.

Entry/Revision Date - Specifies the date when the station data was entered or last revised. Enter a value
using the following format - MM/DD/YYYYY.

Flowing Temperature - Specifies the average gas flowing temperature at the station’s inlet.
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In-Service Date - Specifies the date when the station was put into service. Enter a value using the following
format - MM/DD/YYYY.

Jurisdiction - Specifies the regulatory jurisdiction for the station.

Specific Gravity - Specifies the average specific gravity of the gas flowing through the station. The value
is dimensionless.

Specific Heat Ratio - Specifies the average heat ratio of the gas flowing through the station. The value is
dimensionless.

Viscosity - Specifies the average absolute or dynamic viscosity of the gas flowing through the station.

Calculated Items

Atmospheric Pressure - Displays the calculated atmospheric pressure based on the specified elevation.

Notes & Considerations

® Sce the Database Definition topic in the Appendix section for additional information on the data items
displayed on this data tab.
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Run/Stage Tab - Up(stream) Piping Tab
General ] 1 Compliance W Inspection ] Images
Run Configuration... Hydraulic Data...
Run Type: |Wolking - 1st Cut L' Min Inlet Pressure: [50.00 [Psi L'
Stage Style: [Regulatm - Relief Valve j Max Inlet Pressure: [100.00 Psi
MAOP: 100.00 Psi
o e Efficiency: 95.00 Percent
P: 25-5TD - Len: 10.0
Flow Equation: [Iﬁ T-lmproved Ll
Calculated Yalues... MNommal... Failed...
Outlet Pressure: [ 49.98 [ 99.93 Psi
Pressure Drop: [ 0.02 [ D.07 Psi
add | Delete | Flow Rate: [ 10000 | 29.978 Mcth
Ireseat | L Velocity: [ 2713 4591 Feetsec
<Back Next>
Up Piping J Up Device l Int Piping J Down Device J Down Piping J Stack Piping J Meter/Recorder

Data Items

Efficiency - Specifies the pipe flow efficiency value to use for the upstream piping components associated
with the selected run and stage.

Flow Equation - Specifies the pipe flow equation for the upstream piping components associated with the
selected run and stage.

MAOP - Specifies the Maximum Allowable Operating Pressure of the upstream piping components
associated with the selected run and stage.

Maximum Inlet Pressure - Specifies the maximum actual operating pressure at the inlet/upstream end of
the upstream piping.

Minimum Inlet Pressure - Specifies the minimum actual operating pressure at the inlet/upstream end of the
upstream piping.

Piping Components - Displays the components associated with the upstream piping of the associated stage
and run. The Piping Components list can contain pipe and fittings. Use the command buttons directly below

the list to modify the contents. The list must contain at least one component.

Run Type - Specifies the operating type of the associated run.
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Stage Style - Specifies the configuration type at the associated stage.

Calculated Items

Flow Rate - Displays the calculated flow rate through the upstream piping under the associated operating
conditions.

Outlet Pressure - Displays the calculated pressure at the outlet/downstream end of the upstream piping of
the selected run and stage.

Pressure Drop - Displays the calculated linear pressure drop across the upstream piping of the selected run
and stage.

Velocity - Displays the maximum calculated velocity in the upstream piping of the selected run and stage.

Command Buttons

Add - Adds an item to the Piping Components list. The new item will be added to the end of the list.

Clear - When associated with the Piping Components list, removes all of the components from the associated
list. Otherwise, it sets all data items to blank (null) values.

Delete - Deletes an item from the Piping Components list. The currently highlighted item will be deleted
from the list.

Insert - Inserts an item into the Piping Components list. The new item will be added to the list immediately
before the currently highlighted item.

Notes & Considerations

® Sece the Database Definition topic in the Appendix section for additional information on the data items
displayed on this data tab.
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Run/Stage Tab - Up(stream) Device Tab - Device Data Tab

General ] Run 1 Stage 1 1 Compliance ] Inspection ] Images
Device Data ] Equipment D ata Calculated Values ] Field Settings
Size/Type Code | [FC 299172 ~] il Romal
Inlet Pressure: 4998 |  99.93 Psi
Rated Valve Factor: 200 / 203

Outlet Pressure:

3000  40.10 Psi

l
- i I
Set Pressure: I30'00 IPSI Li Presswie Drop: [ 19.98 I 59.82 Psi
l
l

Flow Rate: 10.000 [ 29.978 Mcth

|~ Entered Capacity Value:
15.158 [ 29.978 Mcrth

Maximum Capacity:

[~ Token Relief Installed Normal Operating Mode...
[Conllolling Regulator In Control Mode.

Failed Operating Mode...
[Eontlolling Regulator In Failure Mode - Assumed

<Back Next>

Up Piping [ Up Device l Int Piping J Down Device l Down Piping J Stack Piping J Meter/Recorder

Data Items

Entered Capacity Value - When selected, a data field will be displayed to specify the entered capacity
value.

Monitor Set Pressure - Specifies the set pressure for an upstream device that is configured as an upstream
or working monitor. This item is only displayed when the upstream device is configured as one of these

monitor types.

Set Pressure - Specifies the set pressure for the upstream device. This item is only displayed when the
device is a regulator and a non-monitor device.

Set Pressure Regulator 1 - If there are dual regulators, specifies the set pressure for the “first” upstream
devices. This item is only displayed when the stage style is set to a dual regulator configuration.

Set Pressure Regulator 2 - If there are dual regulators, specifies the set pressure for the “second” upstream
device. This item is only displayed when the stage style is set to a dual regulator configuration.

Size/Type Code - Specifies the Size/Type Code associated with the device.

Token Relief Installed - When selected, a token relief valve is installed. This item is only displayed when
the upstream device is a regulator.
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Token Set Pressure - If a token relief valve is installed, specifies the set pressure for the token relief valve.
This item is only displayed when the Token Relief Installed option is selected.

Working Set Pressure - Specifies the set pressure for an upstream device that is configured as a working
monitor. This item is only displayed when the upstream device is configured as a working monitor.

Calculated Items

Rated Valve Factor - Displays the working/failed factors associated with the associated specified valve.

Command Buttons

i - Displays information about the associated item. The contents of the information screen generally reflect
the various data values contained in the associated Property Table.

Size/Type Code - Displays a selection screen to select the device being used.

Notes & Considerations

® The contents of the Device Data data tab will vary depending on the run and station configuration.

® A token relief valve is only considered to signal that an overpressure condition has occurred. It is not
considered an Over Pressure Protection (OPP) device.

® When the Entered Capacity Value option is selected, the entered value is used in the compliance
comparison; no capacity and limited hydraulic calculations are performed for the associated device.

® Sce the Database Definition topic in the Appendix section for additional information on the data items
displayed on this data tab.
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Run/Stage Tab - Up(stream) Device Tab - Equipment Data Tab

General ] Run 1 Stage 1 ] Compliance ] Inspection ] Images

Device Data ] Equipment Data Calculated Values ] Field Settings

Data Item... Item Value... ﬂ = Settings
Device
Device - Size/Type Code FC 299172 Initial |Final Units
Device - Manufacturer Fisher Controls Device/Pilot 1 0 0 Psi
Device - Model 293 Pilot 2 0 Psi
Device - Body Size, Inches 1172
Device - Orifice Size. Inches |1/2 Performed By: |
Device - Senial Number Date: [
Device - Connection Style Screwed/Threaded
Device - Max Body Pressure |125.00
Device - Spring Number
Device - Spring Color Unknown ﬂ
<Back Next>
Up Piping iUpd J Int Piping J Down Device J Down Piping J Stack Piping l Meter/Recorder

Data Items

Device -

Connection Style - Specifies the end connection style of the device.

Diaphragm Size - Specifies the main body diaphragm size of the device.

Diaphragm Type - Specifies the main body diaphragm type of the device.

Maximum Body Pressure - Specifies the maximum pressure of the device’s main body.

Pressure Units - Specifies the dimensional units for the associated pressure values.

Serial Number - Specifies the serial number of the device.

Spring Color - Specifies the color of the main spring color used in the device.

Spring Maximum Pressure - Specifies the maximum pressure rating of the main spring.

Spring Minimum Pressure - Specifies the minimum pressure rating of the main spring.
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Spring Number - Specifies the sizing/rating number of the main spring.

Pilot 1/Pilot 2 -

Manufacturer - Specifies the manufacturer’s name of the associated pilot regulator.

Maximum Body Pressure - Specifies the maximum body rating of the associated pilot regulator.
Model - Specifies the model name or number of the associated pilot regulator.

Pressure Units - Specifies the dimensional units of the associated pressure values.

Spring Color - Specifies the color of the spring used in the associated pilot regulator.

Spring Maximum Pressure - Specifies the maximum pressure rating of the spring used in the
associated pilot regulator.

Spring Minimum Pressure - Specifies the minimum pressure rating of the spring used in the
associated pilot regulator.

Spring Number - Specifies the sizing/rating number of the spring used in the associated pilot
regulator.

Calculated Items

Device - These values are taken from the associated Property Table for the specified Size/Type Code.

Body Size - Displays the body size associated with the selected Size/Type Code.

Manufacturer - Displays the manufacturer’s name associated with the selected Size/Type Code.
Model - Displays the model name or number associated with the selected Size/Type Code.
Orifice Size - Displays the orifice size associated with the selected Size/Type Code.

Size/Type Code - Displays the Size/Type Code of the selected device (for reference only).

Notes & Considerations

® Sce the Database Definition topic in the Appendix section for additional information on the data items
displayed on this data tab.
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Run/Stage Tab - Up(stream) Device Tab - Calculated Values Tab

General ] Run 1 Stage 1 1 Compliance ] Inspection ] Images
Device Data ] Equipment D ata Calculated Values ] Field Settings
Size/Type Code | [FC 299172 ~] il Romal
Inlet Pressure: 4998 |  99.93 Psi
Rated Valve Factor: 200 / 203
Outlet Pressure: 30.00 [ 40.10 Psi
Set Pressure: (30.00 |Psi Li

Flow Rate: 10.000 [ 29.978 Mcth

|~ Entered Capacity Value:
15.158 [ 29.978 Mcrth

l
l
Pressure Drop: | 19.98 | 59.82 Psi
l
l

Maximum Capacity:

[~ Token Relief Installed Normal Operating Mode...
[Conllolling Regulator In Control Mode.

Failed Operating Mode...
[Eontlolling Regulator In Failure Mode - Assumed

<Back Next>
Up Piping [ Up Device l Int Piping J Down Device l Down Piping J Stack Piping J Meter/Recorder

Calculated Items

Failed Operating Mode - Displays the calculated operating mode for the upstream device under failed
conditions.

Flow Rate - Displays the calculated flow rate through the upstream device at the associated conditions.

Inlet Pressure - Displays the calculated pressure at the inlet/upstream side of the device at the associated
conditions.

Maximum Capacity - Displays the calculated maximum flow rate, which could be produced by the upstream
device at the associated conditions.

Normal Operating Mode - Displays the calculated operating mode under normal conditions for the
upstream device.

Outlet Pressure - Displays the calculated pressure at the outlet/downstream side of the upstream device at
the associated conditions.

Pressure Drop - Displays the calculated linear pressure drop across the upstream device at the associated
conditions.
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Notes & Considerations

® Sce the Database Definition topic in the Appendix section for additional information on the data items
displayed on this data tab.
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Run/Stage Tab - Up(stream) Device Tab - Field Settings Tab

General ] Run 1 Stage 1 ] Compliance ] Inspection ] Images

Device Data ] Equipment Data Calculated Values ] Field Settings

Data Item... Item Value... ﬂ = Settings
Device

Device - Size/Type Code FC 299172 Initial |Final Units
Device - Manufacturer Fisher Controls Device/Pilot 1 0 0 Psi
Device - Model 293 Pilot 2 0 Psi
Device - Body Size, Inches 1172
Device - Orifice Size. Inches |1/2 Performed By: I
Device - Senial Number Date: [
Device - Connection Style Screwed/Threaded
Device - Max Body Pressure |125.00
Device - Spring Number
Device - Spring Color Unknown ﬂ

<Back Next>
Up Piping | gD

J Int Piping J Down Device l Down Piping J Stack Piping l Meter/Recorder

Data Items

Date - Specifies the date when the settings were made or observed. Enter a value using the following format -
MM/DD/YYYY.

Device/Pilot 1 - Specifies the initial (as found) and the final (as left) settings for the main device and/or main
pilot.

Performed By - Specifies who made or observed the settings.

Pilot 2 - Specifies the initial (as found) and the final (as left) settings for the secondary pilot.

Notes & Considerations

® Sce the Database Definition topic in the Appendix section for additional information on the data items
displayed on this data tab.
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Run/Stage Tab - Int(ermediate) Piping Tab
General ] 1 Compliance ] Inspection ] Images
Piping Components... Hydraulic Data...
P: 25-5TD - Len: 1.0 MADP: 100.00 Psi
F: First Relief Branch - Qty: 1
P: 25-STD - Len: 1.0 Efficiency: 95.00 Peicent
F: Second Relief Branch - Qty: 1
P: 25-5TD - Len: 5.0 Flow E quation: [IG T-Improved LI
Calculated Yalues.. Nommal... Failed...
Inlet Pressure: [ 30.00 [ 40.10 Psi
Dutlet Pressure: [ 30.00 | 40.00 Psi
Pressure Drop: [ 0.00 [ 0.10 Psi
Add | Delete | Flow Rate: [ 10000 [ 29978 Mcth
Insert | Cleay | Velocity: [ 3926  96.17 Feet/sec
<Back Next>
Up Piping J Up Device l Int Piping J Down Device l Down Piping J Stack Piping J Meter/Recorder

Data Items

Efficiency - Specifies the pipe flow efficiency value for the intermediate piping components associated with
the selected run and stage.

Flow Equation - Specifies the pipe flow equation for the intermediate piping components associated with
the selected run and stage.

MAOP - Specifies the Maximum Allowable Operating Pressure of the intermediate piping components
associated with the selected run and stage.

Piping Components - Displays the components associated with the intermediate piping of the associated

stage and run. The Piping Components list can contain pipe and fittings. Use the command buttons directly
below the list to modify the contents.

Calculated Items

Flow Rate - Displays the calculated flow rate through the intermediate piping under the associated operating
conditions.
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Inlet Pressure - Displays the calculated pressure at the inlet/upstream end of the intermediate piping of the
selected run and stage.

Outlet Pressure - Displays the calculated pressure at the outlet/downstream end of the intermediate piping
of the selected run and stage.

Pressure Drop - Displays the calculated linear pressure drop across the intermediate piping of the selected
run and stage.

Velocity - Displays the maximum calculated velocity in the intermediate piping of the selected run and stage.

Command Buttons

Add - Adds an item to the Piping Components list. The new item will be added to the end of the list.

Clear - When associated with the Piping Components list, removes all of the components from the associated
list. Otherwise, it sets all data items to blank (null) values.

Delete - Deletes an item from the Piping Components list. The currently highlighted item will be deleted
from the list.

Insert - Inserts an item into the Piping Components list. The new item will be added to the list immediately
before the currently highlighted item.

Notes & Considerations

® Sce the Database Definition topic in the Appendix section for additional information on the data items
displayed on this data tab.
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Run/Stage Tab - Down(stream) Device Tab - Device Data Tab

General ] 1 Compliance ] Inspection ] Images

Device Data ] Equipment D ata Calculated Values ] Field Settings

SirelTynE Cado | [FC 1808 j j Nommal... Failed...

Inlet Pressure: 30.00|  40.00 Psi
Rated Valve Factor: [1 410

Maximum Capacity:

Outlet Pressure: [ 0.00 [ 0.27 Psi
Set Pressure: (40.00 |Psi Li

Pressure Drop: | 30.00 | 39.73 Psi
Min Build-Up Pressure: |0.00 Psi

Flow Rate: [ N/C |  28.978 Mcth
Number Of Valves: 1 v I [

N/C | 157.522 Mcth
|~ Entered Capacity Value:

Normal Operating Mode...

[Conlinuuusly Closed
Failed Operating Mode...
[Popping - The Full Open Inlet Pressure To The Relief

<Back Next>

Up Piping J Up Device l Int Piping l Down Device J Down Piping J Stack Piping J Meter/Recorder

Data Items

Entered Capacity Value - When selected, a data field will be displayed to enter the capacity value.

Minimum Build-Up Pressure - Specifies a User-defined minimum build-up pressure for the downstream
device. This item is only displayed when the downstream device is a relief valve.

Number Of Valves - Specifies the quantity (number) of relief valve devices installed. This item is only
displayed when the downstream device is a relief valve.

Set Pressure - Specifies the set pressure for the downstream device.

Shared Device - When selected, this device is shared between runs for the same stage. This item is only
displayed when the downstream is a relief valve. This item is useful when single regulators are installed on
runs one and two, and they share the same relief valve.

Size/Type Code - Specifies the Size/Type Code for the selected device.

Token Relief Installed - When selected, a token relief valve is installed. This item is only displayed when
the downstream device is a regulator.
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Token Set Pressure - If a token relief valve is installed, specifies the set pressure for the token relief valve.
This item is only displayed when the Token Relief Installed item is selected.

Calculated Items

Rated Valve Factor - Displays the specified or rated valve factor or coefficient associated with the specified
device.

Command Buttons

i - Displays information about the associated item. The contents of the information screen generally reflect
the various data values contained in the associated Property Table.

Size/Type Code - Displays a selection screen to select the device being used.

Notes & Considerations

® The content of the Device Data tab will vary depending on the run and station configuration.

® When the shared option is selected, a relief valve will be shown for the stage for both runs. When the
calculation is performed, the relief valve capacity is compared against the failed regulator capacity for each
run. The intermediate piping for each run is assumed to connect between the associated upstream device and
the shared relief valve. The downstream piping is assumed to connect from the downstream end of the
intermediate piping.

® A token relief valve is only considered to signal that an overpressure condition has occurred. It is not
considered an Over Pressure Protection (OPP) device.

® Sce the Database Definition topic in the Appendix section for additional information on the data items
displayed on this data tab.
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Run/Stage Tab - Down(stream) Device Tab - Equipment Data Tab

General ] ] Compliance ] Inspection ] Images

Device Data ] Equipment Data Calculated Values ] Field Settings
Data Item... Item Value... ﬂ = Settings
Device - Size/Type Code FC 1808 Byers Initial |Final Units
Device - Manufacturer Fisher Controls Device/Pilot 1 0 0 Psi
Device - Model 1808 Pilot 2 0 Psi
Device - Body Size, Inches 7
Device - Orifice Size, Inches
Device - Senal Number
Device - Connection Style N/A
Device - Max Body Pressure |0.00
Device - Spring Number
Device - Spring Color Unknown

=]

<Back

Up Piping J Up Device l Int Piping J

Down Device J

Next>

Down Piping J

Stack Piping l Meter/Recorder

Data Items

Device -

Connection Style - Specifies the end connection style of the device.

Diaphragm Size - Specifies the main body diaphragm size of the device.

Diaphragm Type - Specifies the main body diaphragm type of the device.

Maximum Body Pressure - Specifies the maximum pressure of the device’s main body.

Pressure Units - Specifies the dimensional units for the associated pressure values.

Serial Number - Specifies the serial number of the device.

Spring Color - Specifies the color of the main spring color used in the device.

Spring Maximum Pressure - Specifies the maximum pressure rating of the main spring.

Spring Minimum Pressure - Specifies the minimum pressure rating of the main spring.
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Spring Number - Specifies the sizing/rating number of the main spring.

Pilot 1/Pilot 2 -

Manufacturer - Specifies the manufacturer’s name of the associated pilot regulator.

Maximum Body Pressure - Specifies the maximum body rating of the associated pilot regulator.
Model - Specifies the model name or number of the associated pilot regulator.

Pressure Units - Specifies the dimensional units of the associated pressure values.

Spring Color - Specifies the color of the spring used in the associated pilot regulator.

Spring Maximum Pressure - Specifies the maximum pressure rating of the spring used in the
associated pilot regulator.

Spring Minimum Pressure - Specifies the minimum pressure rating of the spring used in the
associated pilot regulator.

Spring Number - Specifies the sizing/rating number of the spring used in the associated pilot
regulator.

Calculated Items

Device - These values are taken from the associated Property Table for the specified Size/Type Code.

Body Size - Displays the body size associated with the selected Size/Type Code.

Manufacturer - Displays the manufacturer’s name associated with the selected Size/Type Code.
Model - Displays the model name or number associated with the selected Size/Type Code.
Orifice Size - Displays the orifice size associated with the selected Size/Type Code.

Size/Type Code - Displays the Size/Type Code of the selected device (for reference only).

Notes & Considerations

® Sce the Database Definition topic in the Appendix section for additional information on the data items
displayed on this data tab.
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Run/Stage Tab - Down(stream) Device Tab - Calculated Values Tab

General T ] Compliance ] Inspection ] Images

Device Data ] Equipment D ata Calculated Values ] Field Settings

SirelTynE Cado | [FC 1808 j ﬂ Nommal... Failed...

Inlet Pressure: 30.00|  40.00 Psi
Rated Valve Factor: [1 410

Outlet Pressure: [ 0.00 [ 0.27 Psi
Set Pressure: (40.00 |Psi Ll

Pressure Drop: | 30.00 | 39.73 Psi
Min Build-Up Pressure: |0.00 Psi

Flow Rate: [ N/C |  28.978 Mcth
Number Of Valves: 1 v I [

Maximum Capacity: N/C [ 157.522 Mcth
|~ Entered Capacity Value:

Normal Operating Mode...

[Conlinuuusly Closed
Failed Operating Mode...
[Popping - The Full Open Inlet Pressure To The Relief

<Back Next>

Up Piping J Up Device l Int Piping I Down Device J Down Piping J Stack Piping J Meter/Recorder

Calculated Items

Failed Operating Mode - Displays the calculated operating mode, under failed conditions, for the
downstream device.

Flow Rate - Displays the calculated flow rate through the downstream device at the associated conditions.

Inlet Pressure - Displays the calculated pressure at the inlet/upstream pressure side of the downstream
device at the associated conditions.

Maximum Capacity - Displays the calculated maximum flow rate, which could be produced by the
downstream device at the associated conditions.

Normal Operating Mode - Displays the calculated operating mode, under normal conditions, for the
downstream device.

Outlet Pressure - Displays the calculated pressure at the outlet/downstream side of the downstream device
at the associated conditions.

Pressure Drop - Displays the calculated linear pressure drop across the downstream device at the associated
conditions.
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Notes & Considerations

® Sce the Database Definition topic in the Appendix section for additional information on the data items
displayed on this data tab.
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Run/Stage Tab - Down(stream) Device Tab - Field Settings Tab

General ] ] Compliance ] Inspection ] Images
Device Data ] Equipment Data Calculated Values ] Field Settings

Data Item... Item Value... ﬂ = Settings

- = Device — : =
Device - Size/Type Code FC 1808 Initial |F|na| Units
Device - Manufacturer Fisher Controls Device/Pilot 1 0 0 Psi
Device - Model 1808 Pilot 2 0 Psi
Device - Body Size, Inches 7
Device - Orifice Size, Inches
Device - Serial Number
Device - Connection Style N/A
Device - Max Body Pressure |0.00
Device - Spring Number
Device - Spring Color Unknown ﬂ
<Back Next>

Up Piping J Up Device l Int Piping J Down Device J Down Piping J Stack Piping l Meter/Recorder

Data Items

Date - Specifies the date when the settings were made or observed. Enter a value using the following format -
MM/DD/YYYY.

Device/Pilot 1 - Specifies the initial (as found) and the final (as left) settings for the main device and/or main
pilot.

Performed By - Specifies who made or observed the settings.

Pilot 2 - Specifies the initial (as found) and the final (as left) settings for the secondary pilot.

Notes & Considerations

® Sce the Database Definition topic in the Appendix section for additional information on the data items
displayed on this data tab.
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Run/Stage Tab - Down(stream) Piping Tab
General ] ] Compliance ] Inspection ] Images
Piping Components... Hydraulic Data...
P: 25-5TD - Len: 10.0 MADP: 66.00 Psi
Efficiency: 95.00 Peicent
Flow Equation: [IGT-Improved LI
Calculated Yalues... MNommal... Failed...
Inlet Pressure: [ 30.00 [ 40.00 Psi
Dutlet Pressure: [ 29.97 | 40.00 Psi
Pressure Drop: [ 0.03 [ 0.00 Psi
add | Delete | Flow Rate: [ 10000 [ 1000 Mcth
Insert | Clear | Velocity: [ 39.28 [ 3.21 Feet/sec
<Back Next>
Up Piping J Up Device l Int Piping J Down Device J Down Piping J Stack Piping J Meter/Recorder

Data Items

Efficiency - Specifies the pipe flow efficiency value for the downstream piping components associated with
the selected run and stage.

Flow Equation - Specifies the pipe flow equation for the downstream piping components associated with
the selected run and stage.

MAQP - Specifies the Maximum Allowable Operating Pressure of the downstream piping components
associated with the selected run and stage.

Piping Components - Displays the components associated with the downstream piping of the associated

stage and run. The Piping Components list can contain pipe and fittings. Use the command buttons directly
below the list to modify the contents. The list must contain at least one component.

Calculated Items

Flow Rate - Displays the calculated flow rate through the downstream piping under the associated operating
conditions.
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Inlet Pressure - Displays the calculated pressure at the inlet/upstream end of the downstream piping of the
selected run and stage.

Outlet Pressure - Displays the calculated pressure at the outlet/downstream end of the downstream piping
of the selected run and stage.

Pressure Drop - Displays the calculated linear pressure drop across the downstream piping of the selected
run and stage.

Velocity - Displays the maximum calculated velocity in the downstream piping of the selected run and stage.

Command Buttons

Add - Adds an item to the Piping Components list. The new item will be added to the end of the list.

Clear - When associated with the Piping Components list, removes all of the components from the associated
list. Otherwise, it sets all data items to blank (null) values.

Delete - Deletes an item from the Piping Components list. The currently highlighted item will be deleted
from the list.

Insert - Inserts an item into the Piping Components list. The new item will be added to the list immediately
before the currently highlighted item.

Notes & Considerations

® Sce the Database Definition topic in the Appendix section for additional information on the data items
displayed on this data tab.
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Run/Stage Tab - Stack Piping Tab
General ] 1 Compliance ] Inspection ] Images
Piping Components... Hydraulic Data...
P: 25-STD - Len: 5.0 Efficiency: 95.00 Percent
Flow E quation: [IG T-lmproved Li
Calculated Yalues... Nommal... Failed...
Inlet Pressure: [ 0.00 [ 0.27 Psi
Dutlet Pressure: [ N/C | 0.00 Psi
Pressure Drop: [ N/C [ 0.27 Psi
Add | Delete | Flow Rate: [ N/C[ 28978 Mcth
Insert | Cleay | Velocity: [ N/C | 34539 Feet/sec
<Back Next>
Up Piping J Up Device l Int Piping J Down Device l Down Piping J Stack Piping Meter/Recorder

Data Items

Efficiency - Specifies the pipe flow efficiency value for the stack piping components associated with the
selected run and stage.

Flow Equation - Specifies the pipe flow equation for the stack piping components associated with the
selected run and stage.

Piping Components - Displays the components associated with the stack piping of the associated stage and

run. The Piping Components list can contain pipe and fittings. Use the command buttons directly below the
list to modify the contents. The list must contain at least one component.

Calculated Items

Flow Rate - Displays the calculated flow rate through the stack piping under the associated operating
conditions.

Inlet Pressure - Displays the calculated pressure at the inlet/upstream end of the stack piping of the selected
run and stage.
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Outlet Pressure - Displays the calculated pressure at the outlet/downstream end of the stack piping of the
selected run and stage.

Pressure Drop - Displays the calculated linear pressure drop across the stack piping of the selected run and
stage.

Velocity - Displays the maximum calculated velocity in the stack piping of the selected run and stage.

Command Buttons

Add - Adds an item to the Piping Components list. The new item will be added to the end of the list.

Clear - When associated with the Piping Components list, removes all of the components from the associated
list. Otherwise, it sets all data items to blank (null) values.

Delete - Deletes an item from the Piping Components list. The currently highlighted item will be deleted
from the list.

Insert - Inserts an item into the Piping Components list. The new item will be added to the list immediately
before the currently highlighted item.

Notes & Considerations

® Sece the Database Definition topic in the Appendix section for additional information on the data items
displayed on this data tab.
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Run/Stage Tab - Meter/Recorder Tab
General [ ] Compliance ] Inspection Images
Meter Data...
Size/Type Code: | ’:j

Data Recorder Data...
Make/Type: |None ~v_l

<Back Next>

Up Piping | Up Device l Int Piping I Down Device J Down Piping J Stack Piping J Meter/Recorder

Data Items

Connection Type - Specifies the end connection type for the meter. This item is only displayed when a meter
Size/Type Code has been selected.

High Range - Specifies the upper or high-pressure range of the recorder. This item is only displayed when
a recorder make/type has been selected.

Low Range - Specifies the lower or low-pressure range of the recorder. This item is only displayed when
a recorder make/type has been selected.

Make/Type - Specifies the manufacturer’s name and model or type of the data recorder (if any) installed at
the station.

Maximum Capacity - Specifies the maximum flow capacity of the meter. This item is only displayed when
a meter Size/Type Code has been selected.

Minimum Capacity - Specifies the minimum flow capacity of the meter. This item is only displayed when
a meter Size/Type Code has been selected.

Pressure Rating - Specifies the pressure rating of the meter. This item is only displayed when a meter
Size/Type Code has been selected.
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Size/Type Code - Specifies the Size/Type Code for the meter (if any) installed at the station.

Notes & Considerations

® The meter Size/Type Code may be entered by typing or selecting from the list of existing values. When
a new type is entered by typing, it is added to the list of existing values and can then be selected if it is used
with another station.

® The pressure recorder make and type value may be entered by typing or selecting from the list of existing
values. When a new type is entered by typing, it is added to the list of existing values and can then be
selected if it is used with another station.

® Sce the Database Definition topic in the Appendix section for additional information on the data items
displayed on this data tab.
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Compliance Tab - Run/Stage Tab
General ] Run 1 Stage 1 ] ] Inspection ] Images
Capacity. ..
Regulator [Failed): [ 29.978 Mcfth Relief Yalve: I 157.522 Mcth
Pressure. ..
Allowable Build-Up  Maximum Calculated
MAOP Pressure Pressure Percent Of MAOP
Upstieam Piping: [ 100.00 | 100.00 | 100.00 Psi 100.00
Intermediate Piping: | 100.00 | 110.00 | 4010 Psi 40.10
Downstream Piping: | 66.00 | 72.60 | 40.00 Psi 60.61
Calculation Message: [Normal: Passed Reviewed By: [
Failed: Passed
Compliance: Passed Review Date: ['l 273041899
<Back Next>
Run 1 Stage 1

Data Items

Override Failed Conditions - See Notes - When selected, the status of a failed station will be ignored or
“overridden” by the User. This item is only displayed when at least one stage of a station has failed.

Review Date - Specifies the date when the station data and calculation results were reviewed. Enter a value
using the following format - MM/DD/YYYYY.

Reviewed By - Specifies who reviewed the station data and calculation results.

Calculated Items

Allowable Build-Up Pressure - Displays the maximum allowable build-up pressure during failed conditions
for the associated piping section.

Calculation Message - Displays the status of the calculation results.
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Capacity -
At Maximum Inlet - Displays the maximum capacity of the station when the supply pressure is set
to the minimum entered inlet pressure. This item is only displayed when the station is a monitor-style
configuration.
At Minimum Inlet - Displays the maximum capacity of the station when the supply pressure is set
to the minimum entered inlet pressure. This item is only displayed when the station is a monitor-style
configuration.
Regulator (Failed) - Displays the maximum capacity of the regulator during failed conditions.
Regulator (Normal) - Displays the maximum capacity of the regulator during normal conditions.
Relief Valve - Displays the maximum calculated relief valve capacity.

Required - Displays the required relief capacity for relief valve-only stages.

MAQOP - Displays the Maximum Allowable Operating Pressure during normal operating conditions for the
associated piping section.

Maximum Calculated Pressure - Displays the maximum calculated pressure during failed or normal
conditions for the associated piping section.

Percent Of MAOP - Displays the ratio of the maximum calculated pressure to the MAOP in percentage
units.

Notes & Considerations

® Ifthe Override Failed Conditions - See Notes option is selected for a failed station, it is suggested that a
comment explaining the justification for the override action be added to the Comments/Notes section for the
station.

® Sece the Calculation Method topic in the Appendix section for information on how the regulator and relief
valve capacities are calculated.

® Sce the Database Definition topic in the Appendix section for additional information on the data items
displayed on this data tab.
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Inspection Tab
General ] Run 1 Stage 1 \[ Compliance ] T Images
Inspection Results...
Fo Year 2014 = i Findings/Actions: [\ = @ < DK NZA i‘
Previous Inspection Date:  |07/05/2004 Paint 0K NZ/A
Required Inspection Date: |10/04/2005 Site Protection OK N/A
Si 0K
Inspection Status: “:alerldal Year Emor s
VYents OK Yes
: ] Strainers OK Yes
nspection Notes: : : Valves OK Yes
Inspected Upon Completion Of Construction
Locks OK Yes _.J
Required Actions: |Confirm Pressure Test
Inspected By: [Joe Inspector
Inspection Date: [ Completed By: [Joe Inspector Date:
<Back Next>

Data Items

Completed By - Specifies who performed the required corrective actions.

Date - Specifies the date when any required actions were completed. Enter a value using the following
format - MM/DD/YYYY.

Findings/Actions -

Data Recorders OK - Specifies the status of the condition of any installed pressure recorders at the
station.

Enclosures OK - Specifies the status of the condition of any enclosure, housing, or vault installed
at the station.

Locks OK - Specifies the status of the condition and presence of any security locks installed at the
station.

OPP Capacity Field Verified - Specifies the flow capacity of the Over Pressure Protection (OPP)
device was field verified or tested.
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OPP Devices Lock-Up OK - Specifies the Over Pressure Protection (OPP) device passed the “lock-
up” (shut off) test.

OPP Devices Operated - Specifies the Over Pressure Protection (OPP) device was operated during
the field inspection.

OPP Internals Inspected - Specifies the Over Pressure Protection (OPP) device was dismantled,
and the condition of its internal components was inspected.

Paint OK - Specifies the status of the condition of the paint or atmospheric corrosion protection for
the station.

Regulator Internals Inspected - Specifies the regulator device was dismantled, and the condition
of its internal components was inspected.

Regulators Lock-Up OK - Specifies the regulator device passed the “lock-up” (shut off) test.
Regulators Operated - Specifies the regulator device was operated during the field inspection.

Signs OK - Specifies the status of the condition of the warning signs and posted notices for the
station.

Site Protection OK - Specifies the status of the condition of the site protection for the station - for
example, fencing, bollards, or livestock guards.

Strainers OK - Specifies the status of the condition of any strainers or filters installed at the station.
Valves OK - Specifies the status of the condition of the valves for the station.

Vents OK - Specifies the condition of the device and enclosure vents for the station.

For Year - Specifies the calendar year that the inspection is associated with.

Inspected By - Specifies who performed the field inspection.

Inspection Date - Specifies the date when the field inspection was performed. Enter a value using the
following format - MM/DD/YYYY.

Inspection Notes - Displays any notes and comments associated with the inspection.

Previous Inspection Date - Specifies the date of the most previous field inspection. Enter a value using the
following format - MM/DD/YYYY.

Required Actions - Displays any corrective actions that must be taken to bring the station into compliance.
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Calculated Items

Inspection Status - Displays the status of the latest field inspection results for the specified year.

Required Inspection Date - Displays the date for the next required field inspection.

Notes & Considerations

® [f an item does not apply to the station, select “N/A” (Not Applicable) for the inspection result.
® [fan item has “passed” inspection, select “Yes” for the inspection result.

® [f an item does not pass inspection or was not inspected, leave the result empty.

® Each item must have a “Yes” or “N/A” entry to “pass” inspection for the current inspection year.

® Sce the Database Definition topic in the Appendix section for additional information on the data items
displayed on this data tab.
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Images Tab

General ] Run 1 Stage 1 1 Compliance Inspection images!

Click To Add An Image

<Back Next>

Displayed Items

Click To Add An Image - When selected, the Image Specifications screen is displayed to assign a new or
additional image to the station.

Image - If an image is displayed, click the image to open the Image Specifications screen to change, view,
edit, or unassign the image.

Notes & Considerations

® Sce the Image Specifications topic in the Data Screens section for more information about working with
images.

Command Buttons

Back - Displays the data tab to the left of the current data tab, or if clicked on the leftmost data tab, makes
the rightmost data tab visible.

Calculate - Calculates the associated values.
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Cancel - Closes the screen without saving changes.

Close - Closes the screen and saves the current data values.
First - Displays the first station record in the current report.
Last - Displays the last station record in the current report.
Middle - Displays the station in the middle of the current report.

Next - Displays the data tab to the right of the current data tab, or if clicked on the rightmost data tab, makes
the leftmost data tab visible.

Next Station - Displays the next station in the current report.
Previous Station - Displays the previous station in the current report.

Print - Prints the contents of the report. When clicked, the Print Settings screen is displayed.
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Database Summary Report

The Database Summary Report is accessed by selecting the Database Summary item from the Report menu.
The Database Summary routine may display any or all of the following summaries - Downstream Device,
Fitting, Pipe, or Upstream Device. The report lists the various selected devices associated with the current
record. The features associated with the report are described as follows.

=] Database Summary Report - c:\program files (x36)\statman\files\sample... || S = @
Q[E] [~
Downstream Device Summary... j
Relief Valves:
Size/Type Code Number Found
FC 1808 7
Total 7
Regulators:
Size/Type Code Number Found
FC 299172 2
FC 2991 1
Total 3
Upstream Device Summary...
Size/Type Code Number Found ..'_!
‘ Close |

Copy To Clipboard - Copies the contents of the Database Summary Report to the Windows
Clipboard. Once copied, the contents may be pasted into another application.

Maximize Screen Size - Increases the report’s size to fill the StationManager display.

Print - Prints the contents of the report. When clicked, the Print Settings screen is displayed.
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Reset Screen Size - Sets the report’s size to its “normal” dimensions and position.

Command Buttons

Close - Closes the report.

Notes & Considerations

® The Database Summary Report is created each time the associated menu item is selected. The report is not
saved. The contents of the report may change each time the report is generated, depending on changes that
have been made to the database since the last report generation.
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Database Summary Report Options

The Database Summary Report includes several specialized report options. The User may indicate which
sections they wish to include in the Database Summary Report. The Database Summary Report Options
screen is accessed by selecting the Database Summary item from the Report menu. The features associated
with the screen are described as follows.

Database Summary Report Options...

Select Items To Include. ..

v Downstream Device Summary
v Upstream Device Summary
v Fitting Summary

MiPipe Summary
Cancel ‘ Continue... ‘

Data Items

Downstream Summary - When selected, the downstream device data will be included in the Database
Summary Report.

Fitting Summary - When selected, the fitting data will be included in the Database Summary Report.
Pipe Summary - When selected, the pipe data will be included in the Database Summary Report.
Upstream Device Summary - When selected, the upstream device data will be included in the Database

Summary Report.

Command Buttons

Cancel - Closes the screen without creating the Database Summary Report.

Continue - Proceeds with the Database Summary Report routine.
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Default Data Values

When a new station is created, some items are initially assigned default values. These values are set using
the Default Data Values screen. The screen is accessed by selecting the Set Default Values item from the
Utilities menu. The features associated with the screen are described as follows.

Hydraulic Data Tab

Default Data Values...

Hydraulic Data ] Base/Gas Properties ] Dimensional Units

Default Data Yalues. ..
Pipe Flow Equation: IGT-Improved -
Pipe Efficiency: f95 Percent

Pipe Components...
Upstream:  |P: 25-STD - Len: 10.0

Intermediate: EP: 25-5TD - Len: 1.0
Downstream: EP: 25-5TD - Len: 10.0

Stack: |P- 25-STD - Len: 5.0
Station Inlet Pressure - Min: El] Max: E5I]I] Psi
Required Flow - Min: Eﬂ Max: [1 0 Mcfh

Station Elevation: [l] ft
Flowing Temperature: EEI] F

Inspection For Year: [2003

Apply Hydraulic Data Values Only | Apply All Values |

Cancel | Close I

Data Items

Flowing Temperature - Specifies the default flowing temperature of the gas to use during the hydraulic
calculations.

Inspection For Year - Specifies the default calendar year to use for calculating the inspection status.
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Pipe Components -

Downstream - Displays the Piping Components screen to specify the default downstream pipe
Size/Type Code and length.

Intermediate - Displays the Piping Components screen to specify the default intermediate pipe
Size/Type Code and length.

Stack - Displays the Piping Components screen to specify the default stack pipe Size/Type Code and
length.

Upstream - Displays the Piping Components screen to specify the default upstream pipe Size/Type
Code and length.

Pipe Efficiency - Specifies the default pipe efficiency (hydraulic efficiency) value to use during the
hydraulic calculations.

Pipe Flow Equation - Specifies the default pipe flow equation to use during the hydraulic calculations.
Required Flow Minimum/Maximum - Specifies the default maximum and minimum required flow values.
Station Elevation - Specifies the default elevation above mean sea level of the station location.

Station Inlet Pressure Minimum/Maximum - Specifies the default maximum and minimum inlet pressure
values.
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Base/Gas Properties Tab

Default Data Values...

reisvws | Deacaremms | Disrekuloke

Base Conditions._.

Pressure: 1473 Psi (Abs)
Temperature: FF F

Default Gas Property Values. ..

Viscosity: El].l]l]l]l]l]? Lbm/Ft-sec
Specific Gravity: 0.6
Specific Heat Ratio: [1 3

Apply Gas Property Values Only | Apply All Values [

Cancel | Close [

Data Items

Pressure - Specifies the default pressure to be used to calculate a “standard” volume of gas.
Specific Gravity - Specifies the default specific gravity value for the gas composition.

Specific Heat Ratio - Specifies the default specific heat ratio value (ratio of the specific heat at constant
volume to the specific heat at constant pressure) for the gas composition.

Temperature - Specifies the default temperature to be used to calculate a “standard” volume of gas.

Viscosity - Specifies the default absolute or dynamic viscosity for the gas composition.
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Default Data Values...

Hydraulic Data ]

ﬂa:!lﬁax Properties

]

Default Dimensional Units. ..

Coordinates: m
Diameter: m
Efficiency: m
Elevation: ft -
Flow Rate: m
Length: ft -

Pressure [Abs]): Psi [Abs) VI
Pressure (Gauge): |Psi Vi

Temperature: F - I
VYelocity: Feet/sec b l
Viscosity: Lbm/Ft-sec ~ l

Apply Dimensional Units Only

Apply All Values I

Cancel

Close i

Data Items

Coordinates - Specifies the dimensional units to use for the coordinate values.

Diameter - Specifies the dimensional units to use for the diameter values.

Efficiency - Specifies the dimensional units to use for the pipe flow efficiency values.

Elevation - Specifies the dimensional units to use for the elevation values.

Flow Rate - Specifies the dimensional units to use for the flow, rate, and capacity values.

Length - Specifies the dimensional units to use for the length values.

Pressure (Abs) - Specifies the dimensional units to use for the absolute pressure values.
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Pressure (Gauge) - Specifies the default dimensional units to use for the gauge pressure values.
Temperature - Specifies the dimensional units to use for the temperature values.
Velocity - Specifies the dimensional units to use for the velocity values.

Viscosity - Specifies the dimensional units to use for the viscosity values.

Command Buttons

Apply...Only - Applies the default data values associated with the currently displayed data tab to all of the
records in the currently open database. This routine is useful when only a specific set of the default data
values needs to be changed (for example, to reset the dimensional units).

Apply All Values - Applies all of the default data values and settings to all of the records in the currently
open database. This routine is useful when a new database is created using the wrong default data values and
settings.

Cancel - Closes the screen without saving changes.

Close - Closes the screen and saves changes.

Notes & Considerations

® The Close command button saves the data but does not apply the changes to the current database. The new
values are only assigned to new records that are added to the database.

® Use care when clicking the Apply Dimensional Units Only command button - the command applies a// of
the default dimensional units to all of the database records. If you have made changes or entries to the
database, your changes may be overwritten with the default values.

® Use care when clicking the Apply Gas Property Values Only command button - the command applies a/l
of the default gas property data values to all of the database records. If you have made changes or entries to
the database, your changes may be overwritten with the default values.

® Use care when clicking the Apply Hydraulic Data Values Only command button - the command applies
all of the default hydraulic data values to all of the database records. If you have made changes or entries to
the database, your changes may be overwritten with the default values.
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® Use care when clicking the Apply All Values command button - the command applies a// of the default data
values to all of the database records. If you have made changes or entries to the database, your changes may
be overwritten with the default values.

® When the data field for a pipe component item is clicked, the Piping Components screen is displayed. See
the Piping Components topic in the Data Screens section for information on its use.

® With the exception of the gauge pressure units, the dimensional units are applied to and used by all the
values for all the records in the current database.

® Multiple components can be assigned to the default values, or the default component list can be left empty.
Select the Allow Empty Component List calculation option if you want to allow empty component lists to be
allowed during the calculation process.
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Device Selection

The Device Selection screen can be used to determine the Size/Type Code for a regulator or relief valve to
be used in the associated station. To select a Size/Type Code, click the Size/Type Code command button from
the associated device screen. If the Size/Type Code is known, use the Full List data tab to select the desired
Size/Type Code. If the Size/Type Code is not known, use the Manufacturer/Model data tab to generate the
associated Size/Type Code for the desired device. The features associated with the screen are described as
follows.

Manufacturer/Model Tab

Device Selection...

Manufacturer/Model ] Full List
M anufacturer: Fisher Controls -
Model: 1299 |
Body Size: 1172 |
Orifice Size: 172 v
Size/Type Code: [FE 299172 EI ﬂ
Cancel ‘ Apply |

Data Items

Body Size - Specifies the body size associated with the desired device.

Manufacturer - Specifies the manufacturer’s name associated with the desired device.
Model - Specifies the model name or number associated with the desired device.
Orifice Size - Specifies the orifice size associated with the desired device.

Size/Type Code - Specifies the Size/Type Code of the defined device.
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Full List Tab

Manufacturer/Model 1 Full List
FC 298K & KB 8 VP
FC 298 K & KB 8 Q0
FC298K & KB 10 VP
FC 298 K & KB 10 Q0
FC 298 K & KB 12 VP

FC298K & KB 12Q0
FC 299 1/4x3/8
FC 299 3/8

FC 299 1/2

Cancel ‘ Apply

Data Items

Full List - Displays all the available Size/Type Codes in the current Regulator or Relief Valve Property
Table.

Command Buttons

i - Displays information about the associated item. The contents of the information screen generally reflect
the various data values contained in the associated Property Table.

Apply - Closes the screen and applies the selected Size/Type Code.

Cancel - Closes the screen without applying the Size/Type Code.

Notes & Considerations

® All values shown in the data lists are taken from the associated Property Tables.

® To select a device using the Manufacturer/Model data tab, first select the Manufacturer, then the Model,
Body Size, and Orifice Size. The available device Size/Type Codes corresponding to the selected values will
be displayed in the Size/Type Code list. Select the desired Size/Type Code from the list.
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File Selection

The File Selection screen is displayed when the User selects a command or routine that needs to open or
access an existing database. For example, selecting the Open item from the File menu will cause the screen
to be displayed. The features associated with the screen are described as follows.

New Database Name...

Filename: :\program files [xB6])\statman\files\sample_sdb

=l
Drives: [ e [05] j
Directories: He\

‘A program files [x86)
iy statman

Files: first.sdb
rfv.sdb

File Statistics: | Station Data: 10 Records - Last Modified: 2/3/2014 4:41:10 PHM
Run Data: 40 Records - Last Modified: 27372014 4:41:10 PM
Equipment Data: 40 Becords - Last Modified: 2/3/2014 4:41:10 PM
Inspection Data: 10 Records - Last Modified: 27372014 4:41:10 PM

Cancel Continue...

Displayed Items

File Statistics - Displays the various information about the currently selected (highlighted) file. The contents
of the display will vary depending on the version of the selected file.

Data Items

Directories - Specifies the directory (folder) to use on the selected disk drive. When a directory has been
selected, any files contained in that directory will be displayed in the Files list.

Drives - Specifies the disk drive to use. When a drive is selected, the directories contained on that drive will
be displayed in the Directories list.
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Filename - Specifies the name of the file to be used. A list of the most previously used files may be accessed
from the drop-down list. The Filename may be entered by various means. If the Filename is manually
entered, include the path.

Files - Specifies the files found in the selected directory on the selected disk drive.

Command Buttons

Cancel - Closes the screen without selecting a file.

Continue - Proceeds with the routine.

Notes & Considerations

® When manually entering a database name, remember to include the “.sdb” file extension.
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Find

searching for a specified data value. The search criteria are entered using the Find specification
screen. The Find specification screen is accessed by clicking the Find Record icon from the
Property Table Report. The features associated with the screen are described as follows.

The Find routine is used by the Property Table Report. It allows records to be located by @

Find...
Size/Type Code. ..
Value: [

Cancel ‘ Search

Data Items

Value - Specifies the Size/Type Code to search for.

Command Buttons

Cancel - Closes the screen without performing the search.
Find Next - If enabled, searches for another occurrence of the most previously specified search value.

Search - Initiates the search.

Notes & Considerations

® When executed the first time, searching begins from the start of the file or current selection set for a record
matching the search criteria. If a match is found, the matching record is made current. To find other
occurrences, re-execute the Find Record routine and click the Find Next command button. If no match is
found, a message will be displayed.

® When the Find Next command button is clicked, the search begins at the last matching record and then
searches to the end of the file or selection set. If no match is found, the search begins again at the beginning
of the file or selection set and continues until a match is found or the entire file or selection set has been
searched.
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Find Specifications

value. The search criteria are entered using the Find Specifications screen. The screen is accessed
by clicking the Find Record icon from the Station Data Report. The features associated with the
screen are described as follows.

The Station Data Report allows station records to be located by searching for a specified data @

.F_Il'id Specifications...

em  [FUTIGSSSRSE R -
Value: [ LJ

Cancel I ‘ Search ]

Data Items

Item - Specifies which data item is to be searched.

Value - Specifies the value to search for.

Command Buttons

Cancel - Closes the screen without performing the routine.
Find Next - If enabled, searches for another occurrence of the most previously specified search value.

Search - Initiates the search.

Notes & Considerations

® When a search is performed with a data item that contains an alphanumeric string value (for example, a
search using the “District” data item), a match is found only when all characters match the specified search
value.

® When the Search command button is clicked, the search begins at the first record in the database and
proceeds through the station records until a match is found or the last record is encountered.
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® When the Find Next command button is clicked, the search begins at the currently selected record and
proceeds through the station records until a match is found or the last record is encountered. When the last
record is encountered, the search starts again at the first record at the beginning of the database.
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Go To Record

number that is to be found is entered using the Go To Record screen. The Go To Record screen
is accessed by clicking the Go To Record icon from the Station Data Report. The features
associated with the screen are described as follows.

The Station Data Report allows a station record to be found by its record number. The record % ‘

Go To Record...

Record Number: [

Cancel [ Continue._. J

Data Items

Record Number - Specifies the number of the record to display at the top of the associated report.

Command Buttons

Cancel - Closes the screen without proceeding with the Go To Record routine.

Continue - Proceeds with the Go To Record routine.
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Image Editor Specifications

StationManager allows the User to set the image editor used to edit or view images attached to a database.
To specify which editor to use, select the Set Image Editor item from the Preferences submenu of the File
menu. The features associated with the screen are described as follows.

Image Editor Specifications...

Program Path & Name: [

Cancel Close

Data Items

Program Path & Name - Specifies the Program Path & Name for the Image Editor to be used with
StationManager if different than the default program.

Command Buttons

Cancel - Closes the screen without saving changes.

Close - Closes the screen and saves changes.

Notes & Considerations

® [f the Program Path & Name value is empty, the default system editor/viewer will be used. If a value is
entered, the full path and application executable filename and extension must be entered.
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Image Specifications

StationManager allows one or more images to be attached to a station data record. The images are viewed
and managed using the Image Specifications screen. The screen can be used to add an image, view or edit
an image, or unassign an image. The screen is accessed by clicking on an existing image or by clicking on
the “Add Image” label on the /mages data tab of the General Station Data screen associated with the
Schematic Data Interface or on the /mages data tab associated with the station record Data Entry Form. The
features associated with the screen are described as follows.

Image Specifications...

Directory...
s
‘A Program Files [x86)
‘_3 StatMan e b

it

. /r’“’ —
<Previous Image | Yiew/Edit ‘ Mext Image> I
Cancel | Unassign | Assign i

Data Items

Directory - Specifies the directory (folder) to use on the selected disk drive. When a directory has been
selected, any files matching the specified extension or search pattern will be displayed in the Files panel.

Filename - Specifies the matching files found in the selected directory on the selected disk drive.

Command Buttons

Assign - Assigns an image or changes an image assigned to the current station.

Cancel - Closes the screen without saving changes.
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Next Image - Displays the next image assigned in the current station.

Previous Station - Displays the previously assigned image in the current station.

Unassign - Removes an image that has been previously assigned to the current station.

View/Edit - Opens the image in the assigned image editor/viewer. See the following Notes & Considerations

section for more information.

Notes & Considerations

® The image editor/viewer that is used when the View/Edit command button is clicked is assigned using the
Set Image Editor item in the Preferences submenu of the File menu.

® StationManager supports images stored in files saved as Windows Bitmap (.bmp), JPEG compressed (.jpg),
Graphic Interchange Format (.gif), or Windows Meta File (.wmf) format. Images can be “pictures,” drawings,
or other digital data stored in one of the supported formats.

® The data associated with the attached image is not actually stored in the database. Only the name and
location of the file associated with the image are stored in the database. When moving a database from one
machine to another, remember to also move the image files to the new machine. The Bundle and Unbundle
routines are useful when moving database files from one machine to another. See the Bundle topic in the
Menu Items section for more information on these routines.
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Items To Print

By clicking the Print command button from the Data Entry Form, the User can specify which items to print.
The features associated with the screen are described as follows.

ltems To Print...

Include...

v Compliance Results
v Equipment Data

v Failed Results

v General Data

v Hydraulic Data

v Images

+ Inspection Results
v Hormal Results

™ Pressure Settings

Cancel j Continue._. ]

Command Buttons

Cancel - Closes the screen without saving changes.

Continue - Proceeds with the Print routine.
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Mass Update Specifications

Mass changes may be made to the station data using the Mass Update routine. This type of change
is referred to as a “mass update.” The Mass Update routine is controlled using the Mass Update ?

Specifications screen. The screen is accessed by selecting the Mass Update item from the Edit e
menu or by clicking the Perform Mass Update icon from the Station Data Report. The features
associated with the screen are described as follows.
Mass Update Specifications...
Value Setting...
Set... Equal To...
Equip - Dn Device - Connection K| IN/A =
Search Specification...
Where... Is... Value...
|Equip - Dn Device - Connection | |= j |N!A ﬂ
Close ' Restore ‘ Update ‘
Data Items

Equal To - Specifies the new value for the specified Sef item. The characteristics and contents of this item
will change depending on the selected Set item.

Is - Specifies the search operator to be used during the Mass Update. The search operator specifies the
relation between the Where and Value items, except in the case of the “All” operator. When the “All”
operator is selected, the values of the Where and Value fields are ignored - in this case, all data features
associated with the specified Where item are selected.

Set - Specifies the data item to be updated.

Where - Specifies which data item is to be used as the search item during the query selection.

Value - Specifies the check value to be used during the query selection. The characteristics and contents of
this item will change depending on the selected Where item.

Command Buttons

Close - Closes the screen and saves changes.

Restore - Restores the data values that existed just prior to the executed update.
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Update - Performs the Mass Update using the User-specified settings and data values.

Notes & Considerations

® The meanings of the search operators are:

Operator Description Applies To
= Finds all records with a Where item is equal Numeric & String values
(Equal To) to the Value item.
<> Finds all records with a Where item is not Numeric & String values

(Not Equal To)

equal to the Value item.

<
(Less Than)

Finds all records with a Where item is less
than the Value item.

Numeric values only

> Finds all records with a Where item is greater | Numeric values only
(Greater Than) | than the Value item.
<= Finds all records with a Where item is less Numeric values only
(Less Than Or | than or equal to the Value item.
Equal To)
>= Finds all records with a Where item is greater | Numeric values only
(Greater Than Or | than or equal to the Value item.
Equal To)
All Finds all records associated with the specified | Any
Where item.
Ends With Finds all records that end with the specified String values only
Value item.
Like records with a Where item that contains the String values only
specified Value item.
Maximum Finds a specified number of records which Numeric values only
possess the highest Value items.
Minimum Finds a specified number of records which Numeric values only
possess the lowest Value items.
Not Like Finds all records that do not contain the String values only
specified Value item.
B3PELLC Engineering & Software Services
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Operator Description Applies To

Starts With Finds all records that start with the specified String values only
Value item.

® When the “All” option is used and a previous selection set has been created, the specified changes will
only apply to the records in the selection set.
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Merge Specifications

StationManager allows the User to merge data from another database into the currently open database. For
some file formats, the merge routine attempts to find matches between the new database and the current
database by way of certain station data. The matching process is controlled by settings in the Merge
Specifications screen. The features associated with the screen are described as follows.

Merge Specifications...
Match By._.

Distnict ~
v City/Town
v| State

Station Identification

Station Description

Legal Descnption

Location v

Cancel LContinue.

Data Items

Match By - When selected, the associated data items will be used to match station records between the two
databases.

Command Buttons

Cancel - Closes the screen without proceeding with the routine.

Continue - Proceeds with the Merge routine.

Notes & Considerations

® The Merge routine allows data values and records from a source database to be merged into a target
database. The target database represents the currently open database - the database being merged into. The
source database represents the database that data is being read from - the database being merged from. When
the Merge routine is executed, the merge process reads through the station records in the source database and
attempts to find a matching record in the target database. A match is made when the values for the specified
“match by” items are the same for a station in both the source and target databases. If a match is found, the
data from the target database is replaced with the data from the source database for the matching record. If
no match is found, the record from the source database is added to the end of the target database.
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® [fmultiple station records exist in the source database with identical “Match By’ item values, the matching
record values in the target database will be replaced with the values from the last duplicate record in the
source database.

® [fmultiple station records exist in the target database with identical “Match By” item values, only the first
matching record in the target database will be updated with the values from the matching record in the source
database.
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Merge Station Specifications

The routine is controlled using the Merge Station Specifications screen. The screen is accessed
by clicking the Merge Two Stations icon from the Station Data Report. The features associated
with the screen are described as follows.

StationManager provides a routine that allows two station records to be merged into one record.
=

Merge Station Specifications...

Record Humber OFf Base Station [Station To Be Merged To): |1
Record Mumber Of Station To Merge With The Base Station: |1

Cancel Continue.... ‘

Data Items

Record Number Of Base Station (Station To Be Merged To) - Specifies the record number of the station
that will receive the merged information.

Record Number Of Station To Merge With The Base Station - Specifies the record number of the station
that will be merged with the base station.

Command Buttons

Cancel - Closes the screen without performing the routine.

Continue - Proceeds with the Merge Station routine.

Notes & Considerations

® The Merge routine adds the run records from the merge station to the station data of the base station. Other
data (for example, general and inspection data) from the merge station is ignored.

® The base and merge stations can only contain one run each and must contain the same number of stages.

® [f the base and merge station numbers are the same, the routine is not performed.
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® The merge station record is combined with the base station record. That is, the merge data is added to the
base data, and the merge station record is deleted from the Station Data Report.

® The results of the Merge routine cannot be directly or completely undone. The results of the Merge routine
can be partially restored by creating a copy of the combined station (insert or add a copy of the station to the
Station Data Report). Delete the merged run to recreate the original base station from the original combined
station. Delete the base run from the copy of the combined station to partially recreate the original merge
station. The uncombined data (general and inspection data) from the original merge station will not be
restored.

® Because the merge (source) station record is being deleted, the number of stations in the database will
change, and the station record numbers will change after the merge is complete.
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Move Specifications

A record in the Station Data Report can be moved from its current location to another location
(record number). The relocation is controlled by the Move Specifications screen. The screen is
accessed by clicking the Move Record icon from the Station Data Report. The features associated
with the screen are described as follows.

Move Specifications...

Move Record Number: |1
To Record Number: 1

Cancel ! LContinue. .. ‘

Data Items

Move Record Number - Specifies the record number of the station that will be moved.

To Record Number - Specifies the record number that the station will be moved to.

Command Buttons

Cancel - Closes the screen without performing the routine.

Continue - Proceeds with the Move routine.

Notes & Considerations

® [f the “move” and “to” record numbers are the same, no change is made.

® The number of stations in the database will not be changed by this routine. However, the station record

numbers will change after the move is complete.
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Path Settings

The default directory (folder) locations for the various files associated with a StationManager database and
the support files are controlled using the Path Settings screen. The Path Settings screen is accessed by
selecting the Paths (File Locations) item from the File menu. The features associated with the screen are
described as follows.

Path Settings...

Database Files ] Initialization Files ] Property Files 1 License File 1 Image Files

Current Setting: IC:\F'loglam Files (x86)\StatMan\files\

Select Desired Location...

i ye=cpos |}

Directories...
A C:A
‘2 Program Files (x86)
i StatMan

Cancel Close

Data Items

Current Setting - Displays the current setting for the associated file type. Use the Drive and Directories
items to change the current setting.

Directories - Specifies the directories associated with the selected drive. The last open “folder” indicates
the selected directory.

Drive - Specifies the available disk drives.

Command Buttons

Cancel - Closes the screen without saving changes.

Close - Closes the screen and saves changes.
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Notes & Considerations

® For Database Files, the location setting specifies the default location to use when opening or saving a
database.

® For Initialization Files, the location setting specifies the location to store and retrieve the various temporary
and initialization files used by StationManager. Data screen initialization files store data about a screen’s size
and position. Other files contain temporary data used by various commands and routines.

® For Property Files, the location setting specifies where to find the various Property Tables used by
StationManager. The Property Tables contain various information about pipes, fittings, regulators, and relief
valves.

® For the License File, the location setting specifies the location of the StationManager license file.
Generally, this location should not be changed.

® For Image Files, the location setting specifies the default location for image files assigned/attached to the
database. If an assigned image file is not found in the specified location, StationManager will also look in
the location where the database is stored. Specifying the correct location speeds up access to the image files
when they are needed for display or review.
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Piping Components - Long Form

The Piping Components screen can be accessed by clicking in the associated Piping Components data cell
from the Station Data Report. The features associated with the screen are described as follows.

Components Tab

Piping Components...

Components ] Settings/Results

P: 25-5TD - Len: 10.0

Segment Data...
Size/Type: |25-STD il
Length: 10 ft
ID Number: |
Piping J Fittings
Add | Insert | Delete [
Cancel ‘ Close I [

Data Items

ID Number - Specifies the identification number or another description of the associated component. The
description can contain up to twenty (20) alphanumeric characters. For example, the number may represent
a valve number, a pipe section number, the facility number, or similar.

Length - Specifies the length of the piping component. This item is only displayed for Piping components.
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Piping Components - Displays the components associated with the selected piping segment. The
Components list can contain pipes and fittings. Use the command buttons directly below the list to modify
the contents. The list must contain at least one component.

Quantity - Specifies the number or quantity of the selected fitting component. This item is only displayed
for Fitting components.

Size/Type - Specifies the Size/Type Code of the associated component.

Command Buttons

Add - Adds an item to the Components list. The new item will be added to the end of the list.

Back - Displays the data tab to the left of the current data tab, or if clicked on the leftmost data tab, makes
the rightmost data tab visible.

Cancel - Closes the screen without saving changes.
Close - Closes the screen and saves changes.

Close & Calculate - Closes the screen, saves changes, and calculates the results for the current station. A
message will be displayed reporting the results of the calculation.

Delete - Deletes an item from the Components list. The currently highlighted item will be deleted from the
list.

Enter - Saves changes to the selected (highlighted) component.

Insert - Inserts an item into the Components list. The new item will be added to the list immediately before
the currently highlighted item.

Next - Displays the data tab to the right of the current data tab, or if clicked on the rightmost data tab, makes
the leftmost data tab visible.

Notes & Considerations

® To add an item to the end of the Components list, enter the associated data in the Segment Data or Fitting
Data section, then click the Add command button.
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® To edit the data associated with an existing component, select the item in the Components list. The data
associated with the selected item will be displayed in the Segment Data or Fitting Data section. Make the
desired changes, then click the Enter command button to save the changes.

® To insert an item into the Components list, select the component in the list to insert the new component
before. Enter the associated data in the Segment Data or Fitting Data section, then click the /nsert command
button.

® To delete an item from the Components list, select the component to delete in the list, then click the Delete
command button.

® The screen title/heading will change depending on the pipe section that was selected to access the screen.
® The SMYS value is only used under certain high-pressure/high-stress conditions where certain regulatory
codes require that the allowable build-up pressure be based on the SMYS value. In these cases, the User must

enter an appropriate value for the SMYS value. In most cases, the value is ignored and can be left empty.

® When the Back or Next command buttons are clicked, the data contained on the screen is saved, and the
next “logical” data screen or data tab will be displayed.
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Piping Components - Short Form

The Piping Components screen can be accessed by clicking either the Add or Insert command buttons from
various data tabs on the Data Entry Form. The features associated with the screen are described as follows.

Piping Tab

Piping Compeonents...

Piping T Fittings
Segment Data.__
Diameter:  |25-5TD ~] ]
Length: 100 Feet
1D Number: |
Cancel ‘ Apply

Data Items

Diameter - Specifies the diameter of the piping component.
ID Number - Specifies the identification number or another description of the associated piping component.
The description can contain up to twenty (20) alphanumeric characters. For example, the number may

represent a valve number, a pipe section number, the facility number, or similar.

Length - Specifies the length of the piping component.
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Fittings Tab

Piping Components...

P | Fittings
Awailable Fittings...
Size/Type: |1/2 TB ~| il
Quantity: Iﬁ Each
1D Number: |
Cancel ‘ Apply

Data Items

ID Number - Specifies the identification number or another description of the associated fitting component.
The description can contain up to twenty (20) alphanumeric characters. For example, the number may
represent a valve number, a pipe section number, the facility number, or similar.

Quantity - Specifies the number or quantity of the selected fitting component.

Size/Type - Specifies the Size/Type Code of the associated component.

Command Buttons

Apply - Closes the screen and applies changes.

Cancel - Closes the screen without saving changes.
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Preference Settings

Various StationManager program behaviors may be set using the Preference Settings screen. The Preference
Settings screen is accessed by selecting the Set Preferences item from the Preferences submenu of the File
menu. The features associated with the screen are described as follows.

Preference Settings...

Options. ..

v| Automahically Open Database ~
Hide Components - Downstream
Hide Components - Intermediate
Hide Components - Stack
Hide Components - Upstream
Hide Equipment Data & Messages
Hide Field Settings & Messages W

Cancel Close

Data Items

Automatically Open Database - When selected, on start up, the last database that was active when
StationManager was last exited will automatically be opened.

Display Reminders - When selected, additional messages will be displayed during certain commands and
routines, providing reminders to the User. When not selected, the display of most reminder messages will
be suppressed.

Hide Components - Downstream - When selected, data items and options associated with the downstream
piping components will be hidden (not displayed or printed).

Hide Components - Intermediate - When selected, data items and options associated with the intermediate
piping components will be hidden (not displayed or printed).

Hide Components - Stack - When selected, data items and options associated with the stack piping
components will be hidden (not displayed or printed).

Hide Components - Upstream - When selected, data items and options associated with the upstream piping
components will be hidden (not displayed or printed).

Hide Equipment Data & Messages - When selected, data items and options associated with the device
equipment data will be hidden (not displayed or printed).
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Hide Field Settings & Messages - When selected, data items and options associated with the device field
settings will be hidden (not displayed or printed).

Hide Image Data - When selected, data items and options associated with the station image data will be
hidden (not displayed or printed).

Hide Inspection Data & Messages - When selected, data items and options associated with the inspection
data will be hidden (not displayed or printed).

Hide Meter Data & Messages - When selected, data items and options associated with the meter and
pressure recorder data will be hidden (not displayed or printed).

Show Tooltips - When selected, the tooltips will be displayed when the cursor is rested (hovered) over an

icon, menu item, command button, data field, drop-down list, etc. When not selected, the display of tooltip
messages will be suppressed.

Command Buttons

Cancel - Closes the screen without saving changes.

Close - Closes the screen and saves changes.

Notes & Considerations

® When a group of data items is not used, they can be hidden by selecting the appropriate “hide” option.
Using the “hide” options can minimize the clutter in the report and data entry screen. For example, if the
equipment data group is not going to be used, select the Hide Equipment Data & Messages preference option
to prevent data items associated with that group from being displayed. Hiding or unhiding a data group does
not affect existing data for those items.

® [f changes are made to the hidden/unhidden items, reset the displayed columns in the Station | g
Data Report using the Restore Columns icon.
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Print Settings - L.ong Form

StationManager uses two Print Settings screens - a “long” form and a “short” form. The “Long =]
Form” is displayed when the Print icon is clicked from the Station Record Report. The Print |[ ]
Settings screen allows various printer settings to be set by the User. The features associated with
the screen are described as follows.

Print Settings...
Page Layout... Include. ..
Top Margin: |l].5l] |Inches ﬂ Left Margin: |0.50  Inches v| Compliance Results
; £ : v| Equipment Data
Bottom Margin: |0.50  Inches Right Margin: (0.50  Inches -+ Failed Results
v| General Data
Font Settings. .. v| Hpdraulic Data
v| Ingpection Results
Mame: ﬂlﬁuial Size: ﬂ 8 points v Hormal Results

| Pressure Settings

Other Settings. .

* Grid Format... [ Current Record Only
¥ Print Page Humbers
v Landscape Orientation

Number OFf Copies: |1 -

[v Collate Pages

Inspection Form
GasVYalve Style Design

Printer...
Adobe PDF ~|

Printer Setup |

Cancel Print |

Displayed Items

Name - Displays the name of the font to be used when printing. Double-click in the data field to open the
Font settings screen. Select the desired font, then click the OK command button.

Size - Displays the size of the font to be used when printing. Double-click in the data field to open the Font

settings screen. Select the desired size, then click the OK command button. The size is expressed in printer
points. One printer point is approximately equal to 1/72 of an inch.

Data Items

Bottom Margin - Specifies the distance from the bottom of the paper page to the bottom of the printed page.
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Collate Pages - When selected, the pages are collated when multiple copies are printed.

Current Record Only - When selected, the data and results will be printed for the current record only. When
not selected, the data and results will only be printed for records in the current selection set.

Grid Format - When selected, the report will be printed using a grid (spreadsheet) style format, and the
additional options located below the Grid Format option are enabled.

Include (Report Sections) - Specifies which sections of the database data and results are included in the
printed report.

Landscape Orientation - When selected, landscape orientation will be used when printing. When
unselected, the pages will be printed using portrait orientation.

Left Margin - Specifies the distance from the left side of the paper page to the left side of the printed page.
Number Of Copies - Specifies the number of copies to be printed. Enter a value greater than zero (0).
Print Page Numbers - When selected, the page numbers will be printed.

Printer Setup - Specifies the print device to use.

Right Margin - Specifies the distance from the right side of the paper page to the right side of the printed
page.

Top Margin - Specifies the distance from the top of the paper page to the top of the printed page.

Command Buttons

? - Displays the Font screen.
Cancel - Closes the screen without printing.
Print - Proceeds with the Print routine.

Printer Setup - Displays the Print Setup screen. The contents of the screen will vary depending on the
selected print device and the operating system being used.

2
,5 B3PE LLC Engineering & Software Services
Revision - 002, Copyright 2024, All Rights Reserved. 127




StationManager™ 2.1 Data Screens

Table Of Contents

Notes & Considerations

® [fthe Current Record Only option is not selected, data and results will be printed for all records displayed
in the report.

® [f the Grid Format option is selected, the report will be printed in a spreadsheet-style grid format.

® [f'the Inspection Form item is selected, a blank inspection form will be printed for each associated station
record. The Inspection Form can be used as a guideline for performing field inspections.

® [fthe GasValve Style Design item is selected, an abbreviated document-style report containing information
similar to that produced by the defunct GasValve software will be printed.
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Print Settings - Short Form

“Short Form” is displayed when either the Print icon or the Print command button is clicked from
one of the various data screens and some reports. The Print Settings screen allows various printer
settings to be set by the User. The features associated with the screen are described as follows.

StationManager uses two Print Settings screens - the “long” form and the “short” form. The =]
I

Print Settings... *
Page Layout._.
Top Margin: ||].5|] |Inches ﬂ Left Margin: |0.50 Inches
Bottom Margin: |[0.50  Inches Right Margin: |0.50  Inches

Font Settings...

Mame: ﬂ |Arial Size: ﬂ 8.0 points

Other Settings. ..

Humber OFf Copies: |1 - v Print Border

I+ Landscape Orientation

Printer. ..
Adobe PDF ~|

Printer Setup |

Cancel Print Cloze |

Displayed Items

Name - Displays the name of the font to be used when printing. Double-click in the data field to open the
Font settings screen. Select the desired font, then click the OK command button.

Size - Displays the size of the font to be used when printing. Double-click in the data field to open the Font

settings screen. Select the desired size, then click the OK command button. The size is expressed in printer
points. One printer point is approximately equal to 1/72 of an inch.

Data Items

Bottom Margin - Specifies the distance from the bottom of the paper page to the bottom of the printed page.
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Landscape Orientation - When selected, landscape orientation will be used when printing. When
unselected, the pages will be printed using portrait orientation.

Left Margin - Specifies the distance from the left side of the paper page to the left side of the printed page.
Number Of Copies - Specifies the number of copies to be printed. Enter a value greater than zero (0).
Print Border - When selected, a border will be included on the printed report.

Printer - Specifies the printer or plotter to be used. Select a printer from the list.

Right Margin - Specifies the distance from the right side of the paper page to the right side of the plotted
image.

Top Margin - Specifies the distance from the top of the paper page to the top of the plotted image.

Command Buttons

? - Displays the Font screen.

Cancel - Closes the screen without proceeding with the Print routine.

Close - Closes the screen and saves changes without proceeding with the Print routine.
Print - Proceeds with the Print routine.

Printer Setup - Displays the Print Setup screen. The contents of the screen will vary depending on the
selected printer and the configuration of the computer system.
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The various Property Tables used by StationManager may be set using the Property Table Selection screen.
The Property Table Selection screen is accessed by selecting the Property Tables item from the File menu.
The features associated with the screen are described as follows.

Property Table Selection...
Current Property Path. _.

C:\Program Files [x86)\5tatMan 2\propertiest

Change Path Setting

Select Desired Tables. ..
Pipe:
Regulator:
Relief Yalve:

Fitting:

Cancel

e =l
|legulatnl j
|reliel j
(fitting -]

| Cloze

Displayed Items

Current Property Path - Displays the current location (path) of the Property Table files. The path may be
changed by clicking the Change Path Setting command button or by double-clicking on the current path

label.

Data Items

Fitting - Specifies the current Fitting Property Table to be used for the fitting values.

Pipe - Specifies the current Pipe Property Table to be used for the pipe values.

Regulator - Specifies the current Regulator Property Table to be used for the regulator values.

Relief Valve - Specifies the current Relief Valve Property Table to be used for the relief valve values.
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Command Buttons

Cancel - Closes the screen without saving changes.
Change Path Setting - Displays the Path Settings screen to change the path location for the Property Tables.

Close - Closes the screen and saves changes.

Notes & Considerations

® The Property Table lists only contain Property Tables stored in the currently specified Property Table
location. All of the Property Tables used by a database need to be located in the same directory.
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Query Specifications

The station records displayed in the Station Data Report can be selectively filtered to create what |y

is known as a “selection set.” A selection set is created using the Query Specifications screen. The -J]
screen is accessed by clicking the Make Selection Set icon from the Station Data Report. The =
features associated with the screen are described as follows.

Cuery Specifications...

Find Records Where.._.
Where... Is... Yalue...

|Hyd - Dn Relief Yalve - Size/Type ~| = ~| ] -]

Saved Specifications__

Save Cumnrent 5pecification ‘ Delete Digplayed 5 pecification ‘

Perform Query | Close ‘

Data Items

Is - Specifies the search operator to be used during the Query Selection. The search operator specifies the
relation between the Where and Value items.

Saved Specifications - Specifies a previously saved Query Specification to use for the current specification.
Where - Specifies which data item is to be used as the search item during the Query Selection.
Value - Specifies the value to be used as the check value during the Query Selection. The characteristics of

this item will change depending on the selected Where item.

Command Buttons

Close - Closes the screen.

Delete Displayed Specification - Deletes the currently displayed specification in the Saved Specifications
list.

Perform Query - Performs the query selection.
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Save Current Specification - Saves the currently displayed specification in the Find Records Where data

fields.

Notes & Considerations

® A selection set is cleared by clicking the Reset Selection Set icon from the Station Data Report.

® The meanings of the search operators are:

5

Operator Description Applies To
= Finds all records with a Where item is equal | Numeric & String values
(Equal To) to the Value item.
<> Finds all records with a Where item is not Numeric & String values
(Not Equal To) | equal to the Value item.
< Finds all records with a Where item is less Numeric values only
(Less Than) than the Value item.
> Finds all records with a Where item is Numeric values only
(Greater Than) | greater than the Value item.
<= Finds all records with a Where item is less Numeric values only
(Less Than Or | than or equal to the Value item.
Equal To)
>= Finds all records with a Where item is Numeric values only
(Greater Than | greater than or equal to the Value item.
Or Equal To)
All Finds all records associated with the Any
specified Where item.
Ends With Finds all records that end with the specified | String values only
Value item.
Like records with a Where item that contains the String values only
specified Value item.
Maximum Finds a specified number of records which Numeric values only
possess the highest Value items.
Minimum Finds a specified number of records which Numeric values only
possess the lowest Value items.
Z
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Operator Description

Applies To

Not Like Finds all records that do not contain the

String values only
specified Value item.

Starts With Finds all records that start with the specified

String values only
Value item.

® [fa selection is repeatedly used, it is convenient to save the specification and then select it from the Saved
Specifications list when it is needed.
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Report Options

The number of decimal places displayed by the various report and data screens may be set using the Report
Options screen. The screen is accessed by selecting the Set Report Options item from the Report menu. The
features associated with the screen are described as follows.

Report Options...
Humber Of Decimals To Report___

Pressure [Gauge]: |2 -

Coordinates:

Diameter: Specific Gravity: |3 -
Efficiency: Temperature: 1 -

Elevation: m Valve Factors: m
Flow Rate: m Velocity: m
Heat R atio: m Yiscosity: m
Length: m
Pressure [Abs]: m

Other Settings. ..

Coordinate Heading: |X Coordinate, Y Coordinate

Coordinate Data Type: |Numeric 1.23)

Led Led Lo

Default Data Screen: |5tatinn Data Entry Screen

Cancel | Cloze |

Data Items

Coordinate Data Type - Specifies the numeric format to be used to enter and display coordinate values.

Coordinate Heading - Specifies the text to display for the column heading or data label for coordinate
values.

Default Data Screen - Specifies the default data screen that is displayed when the station, run, or stage item
is double-clicked on the Station Data Report screen.

Number Of Decimals To Report - Specifies the number of decimal places to display for the associated item.
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Command Buttons
Cancel - Closes the screen without saving changes.
Close - Closes the screen and saves changes.
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Schematic Data Interface

The Schematic Data Interface allows data and results to be edited and viewed graphically. The
interface allows data to be entered and reviewed by selecting an item on the schematic display. The ||*
Schematic Data Interface is accessed by clicking the Schematic Interface icon from the Station
Data Report. Additional data screens are accessed by clicking on an item or graphic displayed on
the schematic. The features associated with the screen are described as follows.

Station Record: 1 - Sample / Anytown, CO / Sample 1 @
Station Information. ..
Dist ID/Town/S5ta ID: Sample /7 Anytown, CO / Sample 1 Passed Compliance
Description: PAY To Somewhere Inspection Past Due [DId FY)
Location: Anywhere
Motes: Regulator/Relief Yalve
Schematic...
25-5TD 25-5TD
100.00 Psi N/C 25-5TD
FC 299172 66.00 / 72 60 Psi
30.00 Psi
50.00 Psi | 30.00 Psi e 29.97 P=i
49.98 Psi 30.00 Psi | 10000 Mo
FC 1808
40.00 Psi
100.00 / 110.00 Psi
25-5TD...
Upper ¥alues = Hormal Values/Results
l< First << Previous Station I« Mid >| Next Station »> Last »| |
Cancel Print Calculate Close |
Displayed Items
Schematic -
Device Size/Type Code - Displays data for a specific device.
5 . . .
_Z | B3PE LLC Engineering & Software Services
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Device Set Pressure - Displays set pressure for a specific device.

Flow Values - Displays data or results for a specific location. See the following Notes &
Considerations section for more information.

MAOP/Allowable Pressure Values - Displays the MAOP and allowable build-up pressure values
for a specific pipe segment.

Pipe Size/Type Code - Displays data or results for a specific pipe segment.

Set/Calculated Pressure Values - Displays data or results for a specific location. See the following
Notes & Considerations section for more information.

Station Information -
Area/Description - Displays additional descriptive information for the associated station.
Compliance Status - Displays the status of the latest calculation results for the associated station.

District ID/Town/Station ID - Displays the descriptive information for the district identification,
the town, and the station identification information for the associated station.

Inspection Status - Displays the status of the latest field inspection results for the specified year for
the associated station.

Location - Displays the descriptive location of the associated station.

Notes - Displays comments and notes for the associated station.

Command Buttons

Calculate - Calculates the current station results. A screen is displayed reporting the results of the
calculation.

Cancel - Closes the screen without saving changes.
Close - Closes the screen.
First - Displays the first station record in the current report.

Last - Displays the last station record in the current report.
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Middle - Displays the station in the middle of the current report.
Next Station - Displays the next station in the current report.
Previous Station - Displays the previous station in the current report.

Print - Displays the Print Settings screen to print the contents of the schematic.

Notes & Considerations

® Sclect a displayed data item value on the Schematic Data Interface to access the associated data entry
screen. For example, select the upstream pipe Size/Type Code to access the Data Entry Form for the
upstream piping. Data screens are associated with all of the displayed data values. Device data entry screens
can also be accessed by selecting the associated device symbol.

® To set the station and run configuration, click in an empty area of the schematic. The Station Configuration
screen is displayed.

® When two values are displayed for a data or results item, the upper or darker text represents the value
associated with normal operating conditions - and the lower or lighter text represents the value associated
with failed operating conditions.

® The supply is assumed to be located on the left side of the schematic, and the flow is from left to right
through the station. The components associated with the first stage are grouped on the left side of the
schematic, and the second-stage components are grouped on the right side of the schematic. The components
associated with the first run are displayed in the upper portion of the screen, and the second run components
are displayed in the lower portion of the screen.

® When an error occurs during the calculation, the affected item may be colored red on the schematic
display.

® When the stack flow velocity reaches sonic velocity (choked flow), the associated stack component item
will be colored orange.

® The various data screens are accessed by selecting an associated item displayed on the schematic. The
following figure identifies the selectable items and the associated data screens. The selected item will flash
to remind the User which item the display data screen is associated with.
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Station Record: 1 - Sample / Anytown, CO f Sample 1
— Station Information...
Dist ID/Town/5ta ID: Sample / Anytown, CO / Sample 1 B Pazzed Compliance |
Description: PRY To Somewhere i A C_ Inspection Past Due [0ld FY)
Location: Anywhere
Motes: Regulator/Relief Valve D
|
- Sch hic. ..
F —| 2ss1D 25-5TD F
100.00 Psi M/C F : ) 25-5TD
FC 299 1/2 0.00 Psi 66.00 / 72 60 Psi
30.00 Psi — G
50.00 Psi 29.97 Psi
100.00 Psi 6.56 Psi
10.000 Mcfh
I H —1 7000 mcrh
T00.00 7 110.00 P
25-5TD...
Upper ¥alues = Hormal Yalues/Results Lower ¥alues = Failed Yalues/Results
<< Previous Station I< Mid >| Mext Station >3 Last 3| |
Cancel Print Calculate Cloze |

A: General Station Data Items E: Inlet Pressure Data Items

B: Compliance Data Items F: Piping Data Items

C: Inspection Data Items G: Device Data Items

D: Station Configuration Data Items H: Station Capacity Data Items

® Sece the Database Definition topic in the Appendix section for additional information on the data items
displayed on the schematic.
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Compliance Data

When using the Schematic Data Interface, the Compliance Data is accessed by clicking on the Compliance
Results data item (the “B” item group) displayed on the Schematic Data Interface. When the appropriate item
is selected, the Compliance Data screen is displayed. The screen contains a separate data tab for each run
and stage of the station. The features associated with the screen are described as follows.

Compliance Data...

M aximum Capacities._.

Regulator [Failed): 30.053 Relief Yalve: 116.657 Mcth

Pressure...
MAOP Allowable Max Calculated
Upstream Piping:  |100.00 | 100.00 | 100.00 Psi
Intermediate Piping: [100.00 | 110.00 | 4010 Psi
Downstream Piping: |66.00 | 72.60 | 40.00 Psi
Calculation...
Status/Emor Normal: Passed
Message: Failed: Passed
Compliance: Passed
Reviewed By: Review Date: Ii

<Back Mext>

Run 1 Stage 1 l Run 1 Stage 2 J\ Run 2 Stage 1 l Run 2 Stage 2

<Previous Station | Cancel | LClose | Hext Station> ‘

Close & Calculate |

Data Items

Date - Specifies the date when the station data and calculation results were reviewed. Enter a value using
the following format - MM/DD/YYYY.

MAQP - Specifies the Maximum Allowable Operating Pressure during normal operating conditions for the
associated piping section.

Override Failed Conditions - See Station Notes - When selected, the status of a failed station will be

ignored or “overridden” by the User. This item is only displayed when at least one stage of a station has
failed.
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Reviewed By - Specifies who reviewed the station data and calculation results.

Calculated Items

Allowable Build-Up Pressure - Displays the maximum code allowable build-up pressure during failed
conditions for the associated piping section.

At Maximum Inlet Pressure - Displays the maximum capacity of the station when the supply pressure is
set to the minimum entered inlet pressure. This item is only displayed when the station is a monitor-style
configuration.

At Minimum Inlet Pressure - Displays the maximum capacity of the station when the supply pressure is set
to the minimum entered inlet pressure. This item is only displayed when the station is a monitor-style

configuration.

Maximum Calculated Pressure - Displays the maximum calculated pressure during failed conditions for the
associated piping section.

Regulator (Failed) - Displays the maximum capacity of the regulator under failed conditions.
Regulator (Normal) - Displays the maximum capacity of the regulator under normal conditions.
Relief Valve - Displays the maximum calculated relief valve capacity.

Required - Displays the required relief capacity for relief valve only stages.

Status/Error Message - Displays the status of the calculation results.

Command Buttons

Back - Displays the data tab to the left of the current data tab, or if clicked on the leftmost data tab, makes
the rightmost data tab visible.

Cancel - Closes the screen without saving changes.
Close - Closes the screen and saves changes.

Close & Calculate - Closes the screen and calculates the results for the current station. A message will be
displayed reporting the results of the calculation.
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Next - Displays the data tab to the right of the current data tab, or if clicked on the rightmost data tab, makes
the leftmost data tab visible.

Next Station - Displays the next station in the current report.

Previous Station - Displays the previous station in the current report.

Notes & Considerations

® [fthe Override Failed Conditions option is selected for a failed station, it is suggested that a comment be
added to the notes section for the station explaining the justification for the override action.

® Sece the Database Definition topic in the Appendix section for additional information on the data items
displayed on this screen.

® Sce the Appendix section for a description of the calculation methods for the various compliance results.
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Device Settings

When using the Schematic Data Interface, the Downstream Device Data and Upstream Device Data are
accessed by clicking on any of the Downstream or Upstream Device symbols or data items (the “G” item
groups) displayed on the Schematic Data Interface. When an appropriate item is selected, the associated
Device Settings screen is displayed. The features associated with the screen are described as follows.

Device Settings - Device Tab

Upstream Device Settings...

Device T Set Pressures T E quipment T Meter/Recorder
Device Data...

M anufacturer: |Fisher Controls ﬂ

Model: |299 |

Body Size: [1-172 -]

Diifice Size: 172 -]

Size/Type Code: |FC 299 1/2 ~l il

Valve Factor - HoimalMwWide Open: |200 7 203

[~ Entered Capacity ¥alue:

<Back Cancel Cloze | Mext> |

Cloze & Calculate |

Data Items

Body Size - Specifies the body size associated with the desired device.

Entered Capacity Value - When selected, a data field will be displayed to enter the capacity value.
Manufacturer - Specifies the manufacturer’s name associated with the desired device.

Model - Specifies the model name or number associated with the desired device.

Number Of Valves - Specifies the number of relief valves installed at the downstream device location.
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Orifice Size - Specifies the orifice size associated with the desired device.

Shared Relief Valve(s) - When selected, this device is shared between runs. This item is only displayed
when the downstream device is a relief valve.

Size/Type Code - Specifies the Size/Type Code of the defined device.

Calculated Items

When the Downstream Device is a Relief Valve -

Valve Factor/Orifice Area - Displays the valve factor (first value) and the orifice area (second value) for
the selected valve. The value is taken from the associated Property Table.

When the Downstream Device is a Regulator -

Valve Factor - Normal/Wide Open - Displays the working factor (the first value) and the failed factor (the
second value) for the selected valve. The value is taken from the associated Property Table.
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Device Settings - Set Pressures Tab

Table Of Contents

Upstream Device Settings...
Device T Set Preszures T E quipment T Meter/Recorder
Mominal Set Pressure._.
Set Pressure: |3l] |Psi ﬂ
[~ Token Relief Installed
Mommal... Failed._.

Inlet Pressure: | 4998 | 9993 Psi
Outlet Pressure: | 30.00 | 40,10 Psi
Pressure Drop: | 19.98 | 59.82 Pa
Flow Rate: | 10000 |  30.058 Mcfh
Maximum Capacity: | 15199 |  30.058 Mcfh

<Back Cancel | Closze ‘ Mext> ‘

Close & Calculate ‘

Data Items

Set Pressure - Specifies the set pressure for the downstream device.

If the Downstream Device is a Relief Valve -

Minimum Build-Up - Specifies a User-defined minimum build-up pressure for the downstream
device. See the following Notes & Considerations section for more information.

Calculated Items

Flow Rate - Displays the calculated flow rate through the downstream device at the associated conditions.

Inlet Pressure - Displays the calculated pressure at the inlet/upstream side of the downstream device at the

associated conditions.

Maximum Capacity - Displays the calculated maximum flow rate, which could be produced by the
downstream device at the associated conditions.
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Outlet Pressure - Displays the calculated pressure at the outlet/downstream side of the downstream device
at the associated conditions.

Pressure Drop - Displays the calculated linear pressure drop across the downstream device at the associated
conditions.
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Device Settings - Equipment Tab

Upstream Device Settings...

Device T Set Pressures T Equipment T Meter/Becorder
Equipment...

Data Item... Item Yalue... ﬂ

Device - Size/Type Code FC 299152

Device - Manufacturer Fizher Controls

Device - Model 299 ﬂ

Field Settings.__

Device Initial | Final | Uniits.
Up Device/Pilot 1 1] 0 Psi
Up Pilot 2 1] 0 Psi
Performed By: Date:
<Back ‘ Cancel Cloze ‘ Mext> ‘

Close & Calculate ‘

Data Items

Equipment Device -
Connection Style - Specifies the end connection style of the device.
Diaphragm Size - Specifies the main body diaphragm size of the device.
Diaphragm Type - Specifies the main body diaphragm type of the device.
Maximum Body Pressure - Specifies the maximum pressure of the device’s main body.
Pressure Units - Specifies the dimensional units for the associated pressure values.
Serial Number - Specifies the serial number of the device.
Spring Color - Specifies the color of the main spring of the device.

Spring Maximum Pressure - Specifies the maximum pressure rating of the main spring.
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Spring Minimum Pressure - Specifies the minimum pressure rating of the main spring.

Spring Number - Specifies the sizing/rating number of the main spring.

Equipment Pilot 1/Pilot 2 -

Manufacturer - Specifies the manufacturer’s name of the associated pilot regulator.

Maximum Body Pressure - Specifies the maximum pressure rating of the body of the associated
pilot regulator.

Model - Specifies the model name or number of the associated pilot regulator.
Pressure Units - Specifies the dimensional units for the associated pressure values.
Spring Color - Specifies the color of the spring of the associated pilot regulator.

Spring Maximum Pressure - Specifies the maximum pressure rating of the spring of the associated
pilot regulator.

Spring Minimum Pressure - Specifies the minimum pressure rating for the spring for the associated
pilot regulator.

Spring Number - Specifies the sizing/rating number of the spring of the associated pilot regulator.

Field Settings -

Date - Specifies the date when the settings were made or observed. Enter a value using the following
format - MM/DD/YYYY.

Dn Device/Pilot 1 (Initial/Final) - Specifies the initial (as found) and the final (as left) settings for
the main device or main pilot.

Dn Pilot 2 (Initial/Final) - Specifies the initial (as found) and the final (as left) settings for the
secondary pilot.

Performed By - Specifies who made or observed the settings.
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Calculated Items

Equipment Device - These values are taken from the associated Property Table for the specified Size/Type
Code.

Body Size - Displays the body size associated with the selected Size/Type Code.

Manufacturer - Displays the manufacturer’s name associated with the selected Size/Type Code.
Model - Displays the model name or number associated with the selected Size/Type Code.
Orifice Size - Displays the orifice size associated with the selected Size/Type Code.

Size/Type Code - Displays the Size/Type Code of the selected device (for reference only).
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Device Settings - Meter/Recorder Tab

Upstream Device Settings...

Device T Set Pressures T E quipment T Meter/Becorder
Meter Data...
Size/Type Code: | j
Connection Type: |NJ'A j
Capacity - Min: | Ma:u:| Mcth
Pressure Rating: | |in-wc j

Data Recorder Data...

Make/Type: |Nune j
Low Range: |[|_|]|] |Psi ﬂ
High Range: 0.00 Psi
<Back Cancel | Cloze ‘ Mext> ‘

Close & Calculate ‘

Data Items

Capacity - Maximum - Specifies the maximum capacity of the meter installed at the station. If a meter is
installed, enter a value by typing it into the data field. Otherwise, leave the data field empty.

Capacity - Minimum - Specifies the minimum capacity of the meter installed at the station. If a meter is
installed, enter a value by typing it into the data field. Otherwise, leave the data field empty.

Connection Type - Specifies the meter end connection type of the meter.

High Range - Specifies the upper limit of the pressure recorder installed at the station. If a recorder is
installed, enter a value by typing it into the data field. Otherwise, leave the data field empty.

Low Range - Specifies the lower limit of the pressure recorder installed at the station. If a recorder is
installed, enter a value by typing it into the data field. Otherwise, leave the data field empty.

Make/Type - Specifies the name of the manufacturer and model or type of the data recorder installed at the
station. If a recorder is installed, select an item from the list. Otherwise, leave the drop-down list empty.
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Pressure Rating - Specifies the maximum pressure rating of the meter installed at the station. If a meter is
installed, enter a value by typing it into the data field. Otherwise, leave the data field empty.

Size/Type Code - Specifies the Size/Type Code of the meter installed at the station. If a meter is installed,
select an item from the list. Otherwise, leave the drop-down list empty.

Command Buttons

Back - Displays the data tab to the left of the current data tab, or if clicked on the leftmost data tab, makes
the rightmost data tab visible.

Cancel - Closes the screen without saving changes.
Close - Closes the screen and saves changes.

Close & Calculate - Closes the screen and calculates the results for the current station. A message will be
displayed reporting the results of the calculation.

Next - Displays the data tab to the right of the current data tab, or if clicked on the rightmost data tab, makes
the leftmost data tab visible.

Notes & Considerations

® All values shown in the Device Data lists are taken from the associated Property Table.

® To select a device, first select the Manufacturer, then the Model, Body Size, and Orifice Size. The
corresponding device Size/Type Codes will be listed in the Size/Type Code list.

® When the Entered Capacity Value option is selected, the entered value is used in the compliance
comparison; no capacity and limited hydraulic calculations are performed for the associated device.

® The meter Size/Type Code may be entered by typing or selected from the list of existing values. When a
new type is entered by typing, it is added to the list of existing values and can then be selected if it is used
with another station.

® The Minimum Build-Up Pressure allows the User to specify a minimum build-up pressure for the
downstream device. The build-up pressure represents the increase in pressure above the set pressure on the
inlet side of the relief valve. If the actual calculated build-up pressure is less than the specified minimum
build-up pressure, the minimum build-up pressure value is used in the compliance check. If the actual
calculated value is greater, the calculated value is used in the compliance check.
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® Multiple meters and pressure records are not supported.

® The pressure recorder Make/Type value may be entered by typing or selected from the list of existing
values. When a new type is entered by typing, it is added to the list of existing values and can then be
selected if it is used with another station.

® When the Back or Next command buttons are clicked, the data contained on the screen is saved, and the
next “logical” data screen or data tab will be displayed.
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General Station Data

When using the Schematic Data Interface - General Station Data information is accessed by clicking on one
of the General Station Data items (the “A” item group) displayed on the Schematic Data Interface. When an
appropriate item is selected, the General Station Data screen is displayed. Changes made in this screen will
be reflected on the Schematic Data Interface screen. The features associated with the screen are described
as follows.

General Station Data - Location/Configuration Tab

General Station Data...

Location/Configuration T Gas Propertiez/Mizcellaneous T Images

Location Information. ..

District Identification: |Sample

City/T own: |An5.ltuwn State: |CD hd
Legal Description: |Sec Rng Twn

Station Identification: |Sample 1

Area/Description: |PFW To Somewhere
Location: |Anywhere
* Coordinate: 22.3450 Y Coordinate: |44.5670 Degrees L/L
Configuration. .. Capacity, Mcfh.__
Operating Status: |In Service j Minimum Required: |1.l]l]
Mumber Of Buns: |1 j Maximum Required: |1l].l]l]
Stages Per Run: |1 j
<Back Cancel ‘ Cloze | Mext: |

Close & Calculate ‘

Data Items

Area/Description - Specifies any additional descriptive information about the station.
City/Town - Specifies the city or town associated with the station location.

District Identification - Specifies the pressure or operating district associated with the station.
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Legal Description - Specifies the “legal” description of the station location. For example, Southwest 1/4 of
Section 28.

Location - Specifies the descriptive location of the station. For example, the Northeast corner of 1¥ and Main
Streets.

Maximum Required - Specifies the maximum required flow capacity of the station.
Minimum Required - Specifies the minimum required flow capacity of the station.

Number Of Runs - Specifies the number of runs for the station.

Operating Status - Specifies the station’s operating status.

Stages Per Run - Specifies the number of pressure cuts/stages for each run.

State - Specifies the state associated with the station location.

Station Identification - Specifies the station’s identification assignment. For example, TBS #1.

X Coordinate/Y Coordinate - Specifies the coordinates for the station’s location.
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General Station Data - Gas Properties/Miscellaneous Tab

General Station Data...

LocationfConfiguration T Gas Properties/Mizcellaneous T Images
Gas Properties.___ Mizcellaneousz Data. .
Elevation: 0 R In-Service Date:  [07/04/2004
Atmospheric Preszure: IW Pszi [Abs] Jurisdiction: |U5 DoT ﬂ
Flowing Temperature: 60.0 F Designed By: |Jue Designer
Basze Pressure: 14.73 Psi [Abs) Design Date: |l]3.fl]E."2l]l]4
Base Temperature: IW F Entered/Revised By: |Jue Entry

Entry/Revision Date: |l]?il]?."2l]l]4

Comments/Hotes:
Specific Gravity: 0.600 Regulator/Rehef Valve
Vizcosity: 0.000007 Lbm/Ft-sec
Specific Heat Ratio: 1.300
¢Back Cancel Cloze ‘ Mext: ‘

Close & Calculate |

Data Items

Base Pressure - Specifies the pressure basis for the measured/stated volumes.
Base Temperature - Specifies the temperature basis for the measured/stated volumes.
Comments/Notes - Displays any notes associated with the station configuration, location, or operation.

Design Date - Specifies the date when the station was initially designed. Enter a value using the following
format - MM/DD/YYYY.

Designed By - Specifies who designed the station.
Elevation - Specifies the height above mean sea level of the station’s location.

Entered/Revised By - Specifies who entered or last reviewed the data for the station.

=
,5 B3PE LLC Engineering & Software Services
Revision - 002, Copyright 2024, All Rights Reserved. 157




StationManager™ 2.1 Data Screens

Table Of Contents

Entry/Revision Date - Specifies the date when the station data was entered or last revised. Enter a value
using the following format - MM/DD/YYYYY.

Flowing Temperature - Specifies the average gas flowing temperature at the station’s inlet.

In-Service Date - Specifies the date when the station was put into service. Enter a value using the following
format - MM/DD/YYYY.

Jurisdiction - Specifies the regulatory jurisdiction for the station.

Specific Gravity - Specifies the average specific gravity of the gas flowing through the station. The value
is dimensionless.

Specific Heat Ratio - Specifies the average heat ratio of the gas flowing through the station. The value is
dimensionless.

Viscosity - Specifies the average absolute or dynamic viscosity of the gas flowing through the station.

Calculated Items

Atmospheric Pressure - Displays the calculated atmospheric pressure based on the specified elevation.
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General Station Data - Images Tab
General Station Data...
Location/Configuration T Gas Properties/Miscellaneous T Images
Click To Add An Image
<Back Cancel LClose | Mext> |
Close & Calculate ‘

Displayed Items

Click To Add An Image - When clicked, the Image Specifications screen is displayed to assign a new or
additional image to the station.

Image - If an image is displayed, select the image to open the Image Specifications screen to change, view,
edit, or unassign the image.

Command Buttons

Back - Displays the data tab to the left of the current data tab, or if clicked on the leftmost data tab, makes
the rightmost data tab visible.

Cancel - Closes the screen without saving changes.

Close - Closes the screen and saves changes.

,Eé’
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Close & Calculate - Closes the screen and calculates the results for the current station. A message will be
displayed reporting the results of the calculation.

Next - Displays the data tab to the right of the current data tab, or if clicked on the rightmost data tab, makes
the leftmost data tab visible.

Notes & Considerations

® Descriptive data items, such as Area/Description and Location, are not used as part of the hydraulic
calculations, but can be used to enter any alphanumeric data values.

® The station capacity can also be entered or edited by selecting a Station Capacity data item, the “G” item
group.

® [f one of the “not calculated” items is selected for the Operating Status, the station will be ignored during
the Calculate All routine; however, the station can still be individually calculated.

® The Jurisdiction item is for reference only; it does not affect the compliance calculation. The Regulatory
Code/Specification item in the Calculation Options controls the compliance calculation method.

® When the Back or Next command buttons are clicked, the data contained on the screen is saved, and the
next “logical” data screen or data tab will be displayed.

® Sce the Image Specifications topic in the Data Screens section for more information about working with
images.

® Sce the Database Definition topic in the Appendix section for additional information on the data items
displayed on this screen.
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Inlet Pressure Data

When using the Schematic Data Interface, the Inlet Pressure Data is accessed by clicking on the Inlet
Pressure Data item (the “E” item group) displayed on the Schematic Data Interface. When the appropriate
item is selected, the Inlet Pressure Data screen is displayed. The features associated with the screen are
described as follows.

Inlet Pressure Data...

Minimum Inlet Pressure: |5|] |Psi ﬂ
Maximum Inlet Pressure: 100 Psi
¢{Back Cancel | Cloze | Mext: ‘

Close & Calculate ‘

Data Items

Maximum Inlet Pressure - Specifies the maximum actual pressure at the inlet/upstream end of the upstream
piping.

Minimum Inlet Pressure - Specifies the minimum actual pressure at the inlet/upstream end of the upstream
piping.

Command Buttons

Back - Displays the data tab to the left of the current data tab, or if clicked on the leftmost data tab, makes
the rightmost data tab visible.

Cancel - Closes the screen without saving changes.
Close - Closes the screen and saves changes.

Close & Calculate - Closes the screen and calculates the results for the current station. A message will be
displayed reporting the results of the calculation.

Next - Displays the data tab to the right of the current data tab, or if clicked on the rightmost data tab, makes
the leftmost data tab visible.
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Notes & Considerations

® When the Back or Next command buttons are clicked, the data contained on the screen is saved, and the
next “logical” data screen or data tab will be displayed.

2
,5 B3PE LLC Engineering & Software Services
162 Revision - 002, Copyright 2024, All Rights Reserved.




StationManager™ 2.1 Data Screens

Table Of Contents

Inspection Data

When using the Schematic Data Interface, the Inspection Data is accessed by clicking on the Inspection
Results data item (the “C” item group) displayed on the Schematic Data Interface. When the associated item
is selected, the Inspection Data screen is displayed. The features associated with the screen are described as
follows.

Inspection Data - Status Tab

Inspection Data...

Status T Findings T Hotes/Actions

For *ear: |2I]I]E ﬂ
Previous Inspection Date: |UT!I]5!2I]I]4

Required Inspection D ate: |1l]fl]4!2l]l]5

Inspection Status: |Ealendar Year Emmor

<Previous Station Cancel Cloze Mext Station>»

Data Items

For Year - Specifies the calendar year that the inspection was associated with.

Previous Inspection Date - Specifies the date of the most previous field inspection. Enter a value using the
following format - MM/DD/YYYY.

Calculated Items

Inspection Status - Displays the status of the field inspection for the specified calendar year.

Required Inspection Date - Displays the date of the next required field inspection.
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Inspection Data - Findings Tab

Inspection Data...
Status T Findings T Notes/Actions
Inspection Findings. ..
Item Inspection Status i‘
Enclosures OK M/A
Paint OK M/A
Site Protection OK HfA
Signs OK
Yents DK Yes
Strainers OK Yes
Valvesz OK Yes j
<Previous Station Cancel Close Mext Station: |

Data Items

Data Recorders OK - Specifies the status of the condition of any installed pressure recorders at the station.

Enclosures OK - Specifies the status of the condition of any enclosure, housing, or vault installed at the
station.

Locks OK - Specifies the status of the condition and presence of any security locks installed at the station.

OPP Capacity Field Verified - Specifies the flow capacity of the Over Pressure Protection (OPP) device
was field verified or tested.

OPP Devices Lock-Up OK - Specifies the Over Pressure Protection (OPP) device passed the “lock-up”
(shut off) test.

OPP Devices Operated - Specifies the Over Pressure Protection (OPP) device was actually operated during
the field inspection.

OPP Internals Inspected - Specifies the Over Pressure Protection (OPP) device was dismantled, and the
condition of its internal components was inspected.
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Other Observations -See Notes - Specifies any additional observations or comments are included in the
Inspection Notes.

Paint OK - Specifies the status of the condition of the paint or atmospheric corrosion protection for the
station.

Regulator Internals Inspected - Specifies whether the regulator device was dismantled and the condition
of its internal components was inspected.

Regulators Lock-Up OK - Specifies whether the regulator device passed the “lock-up” (shut off) test.

Regulators Operated - Specifies whether the regulator device was actually operated during the field
inspection.

Signs OK - Specifies the status of the condition of the warning signs and posted notices for the station.

Site Protection OK - Specifies the status of the condition of the site protection for the station. For example,
fencing, bollards, or livestock guards.

Strainers OK - Specifies the status of the condition of any strainers or filters installed at the station.
Valves OK - Specifies the status of the condition of the valves for the station.

Vents OK - Specifies the condition of the device and enclosure vents for the station.
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Inspection Data - Notes/Actions Tab

Inspection Data...

Status T Findings T Motes/Actions

Inspection Motes. ..

Ingpected Upon Completion Of Construction

Inspected By: |[Joe Inspector Date:

Required Actions...

Confirm Preszure Test

Completed By: |JDE Inspector Date: |

<Previous Station | Cancel Close | Mext Station:

Data Items

Completed By - Specifies who performed the required corrective actions.

Date (Inspection Notes) - Specifies the date when the field inspection was performed. Enter a value using
the following format - MM/DD/YYYY.

Date (Required Actions) - Specifies the date when any required actions were completed. Enter a value using
the following format - MM/DD/YYYY.

Inspected By - Specifies who performed the field inspection.
Inspection Notes - Specifies any notes and comments associated with the inspection.

Required Actions - Specifies any corrective actions that must be taken to bring the station into compliance.

Command Buttons

Cancel - Closes the screen without saving changes.

Close - Closes the screen and saves changes.
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Next Station - Displays the next station in the current report.

Previous Station - Displays the previous station in the current report.

Notes & Considerations

® For the Inspection Findings, if an item does not apply to the station, select “N/A” (Not Applicable) for the
inspection result. If an item has “passed” inspection, select “Yes” for the inspection result. If an item does
not pass inspection or was not inspected, leave the result empty. Each item must have a “Yes” or “N/A” entry
to “pass” inspection for the current inspection year.
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Pipe Settings (All Segments)

When using the Schematic Data Interface, the Pipe Data is accessed by clicking on any of the Piping Data
items (the “F” item group) displayed on the Schematic Data Interface. Items in this group include the
upstream, downstream, intermediate, and stack piping sections. When an appropriate item is selected, the
associated Pipe Settings screen is displayed. The features associated with the screen are described as follows.

Pipe Settings - Components Tab - Piping & Fittings Tabs

Upstrearn Pipe Settings...

Components T Settingzs/Results

P: 25-5TD - Len: 10.0

Segment Data...
Size/Type: |25-5TD ~| il
Length: 10 Feet
1D Numbes: |
Piping l Fittings
Add ‘ Insert | Delete |
<Back Cancel | Close | Mext: |

Close & Calculate |

Data Items

ID Number - Specifies the identification number or another description of the associated component. The
description can contain up to twenty (20) alphanumeric characters. For example, the number may represent
a valve number, a pipe section number, the facility number, or similar.

Length - Specifies the length of the piping component. This item is only displayed for Piping components.
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Piping Components - Displays the components associated with the selected piping segment. The
Components list can contain pipes and fittings. Use the command buttons directly below the list to modify
the contents. The list must contain at least one component.

Quantity - Specifies the number or quantity of the selected fitting component. This item is only displayed
for Fitting components.

Size/Type - Specifies the Size/Type Code of the associated component.
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Data Items

Upstream Pipe Settings...

Components T Settingzs/Hesults
MADP: 100 Psi [ Fized
SMY'S5: 30000 Psi
Run Type: |Wnrking - 1st Cut ﬂ
Stage Type: |Hegulatnr - Relief Yalve ﬂ

Efficiency: 95 Percent

Flow E quation: |IET-Impmved j
Mormal... Failed...
Inlet Pressure: | 50.00 | 100,00 Psi
Pressure Drop: | 0.02 | 0.07 Psi
Flow Rate: | 10.000 | 30.058 Mcth
Velocity: | 2713 | 46.03 Feet/sec
<Back | Cancel | Cloze | Mext> |

Close & Calculate

Efficiency - Specifies the pipe flow efficiency value to use for the associated piping for the selected piping

section.

Fixed - When selected, the MAOP may be adjusted by the allowable build-up during the calculations. This
item is not displayed for a stack piping section.

Flow Equation - Specifies the pipe flow equation to use for the associated piping of the selected piping

section.

MAQP - Specifies the Maximum Allowable Operating Pressure of the associated piping of the selected
piping section. This item is only displayed for upstream, intermediate, and downstream piping.
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Run Type - Specifies the operating type of the associated run. This item is only displayed for a piping
section.

SMYS - Specifies the Specified Minimum Yield Stress for the selected pipe segment. This item is not
displayed for a stack piping section.

Stage Type - Specifies the configuration type of the associated stage. This item is only displayed for an
upstream piping section.

Calculated Items

Flow Rate - Displays the calculated flow rate through the associated piping for the associated operating
conditions.

Inlet Pressure - Displays the calculated pressure at the inlet/upstream end of the selected piping section for
the associated operating conditions.

Pressure Drop - Displays the calculated linear pressure drop across the selected piping section for the
associated operating conditions.

Velocity - Displays the maximum calculated velocity in the selected piping section for the associated
operating conditions.

Command Buttons

Add - Adds an item to the Components list. The new item will be added to the end of the list.

Back - Displays the data tab to the left of the current data tab, or if clicked on the leftmost data tab, makes
the rightmost data tab visible.

Cancel - Closes the screen without saving changes.
Close - Close the screen and saves changes.

Close & Calculate - Closes the screen and calculates the results for the current station. A message will be
displayed reporting the results of the calculation.

Delete - Deletes an item from the Components list. The currently highlighted item will be deleted from the
list.

Enter - Saves changes to the selected (highlighted) component.
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Insert - Inserts an item into the Components list. The new item will be added to the list immediately before
the currently highlighted item.

Next - Displays the data tab to the right of the current data tab, or if clicked on the rightmost data tab, makes
the leftmost data tab visible.

Notes & Considerations

® To add an item to the end of the Components list, enter the associated data in the Segment Data or Fitting
Data section, then click the Add command button.

® To edit the data associated with an existing component, select the item in the Components list. The data
associated with the selected item will be displayed in the Segment Data or Fitting Data section. Make the
desired changes, then click the Enter command button to save the changes.

® To insert an item into the Components list, select the component in the list to insert the new component
before. Enter the associated data in the Segment Data or Fitting Data section, then click the Insert command
button.

® To delete an item from the Components list, select the component to delete in the list, then click the Delete
command button.

® The screen title/heading will change depending on the pipe section that was selected to access the screen.
® The SMYS value is only used under certain high-pressure/high-stress conditions where certain regulatory
codes require that the allowable build-up pressure be based on the SMYS value. In these cases, the User must

enter an appropriate value for the SMY'S value. In most cases, the value is ignored and can be left empty.

® When the Back or Next command buttons are clicked, the data contained on the screen is saved, and the
next “logical” data screen or data tab will be displayed.
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Station Capacity Data

When using the Schematic Data Interface, the minimum and maximum required Station Capacity Data is
accessed by clicking on the Station Capacity data item (the “H” item group) displayed on the Schematic Data
Interface. When an appropriate item is selected, the Station Capacity Data screen is displayed. The features
associated with the screen are described as follows.

Station Capacity Data...

Minimum Required: |1 Mcth
Maximum Required: (10 Mcth

<Back ‘ Cancel | Close | Mext> |

Cloze & Calculate |

Data Items

Maximum Required - Specifies the maximum required flow capacity of the station.

Minimum Required - Specifies the minimum required flow capacity of the station.

Command Buttons

Back - Displays the data tab to the left of the current data tab, or if clicked on the leftmost data tab, makes
the rightmost data tab visible.

Cancel - Closes the screen without saving changes.
Close - Closes the screen and saves changes.

Close & Calculate - Closes the screen and calculates the results for the current station. A message will be
displayed reporting the results of the calculation.

Next - Displays the data tab to the right of the current data tab, or if clicked on the rightmost data tab, makes
the leftmost data tab visible.
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Notes & Considerations

® The capacity values can also be entered using the General Station Data screen.

® When the Back or Next command buttons are clicked, the data contained on the screen is saved, and the
next “logical” data screen or data tab will be displayed.
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Station Configuration

When using the Schematic Data Interface, the number of runs and stages for each station can be accessed
by clicking on an empty area of the schematic display section (the “D”item group) displayed on the
Schematic Data Interface. When an appropriate area is selected, the Station Configuration screen is
displayed. The features associated with the screen are described as follows.

Station Configuration...

Runs: [ ~ Stages: 1 -

Run 1 Stage 1: |Flegulat0l - Rehef Yalve ﬂ

<Back ‘ Cancel ‘ Close | Mext> ‘

Data Items

Runs - Specifies the number of runs for the associated station.

Run X Stage Y - Specifies the devices for each run/stage of the associated station. Certain fields will be
visible or hidden depending on the number of runs and stage selected.

Stages - Specifies the number of stages for the associated station.

Command Buttons

Back - Displays the data tab to the left of the current data tab, or if clicked on the leftmost data tab, makes
the rightmost data tab visible.

Cancel - Closes the screen without saving changes.
Close - Closes the screen and saves changes.

Next - Displays the data tab to the right of the current data tab, or if clicked on the rightmost data tab, makes
the leftmost data tab visible.
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Notes & Considerations

® The configuration displayed in the schematic display area will change depending on the values entered on
the Station Configuration screen.

® The number of runs and stages can also be set using the General Station Data screen. The stage style can
also be set by selecting the Size/Type Code for the “upstream” piping section.
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Station Data Report

The Station Data Report is the primary interface for accessing data and records in the database. The report
allows various tasks to be performed on the data values and records. It also allows access to the other
interface formats. The data values and records are displayed in groups on individual data tabs. The features
associated with the screen are described as follows.

The following command buttons and icons are common to all tabs and sections of this screen.

Add Record - Adds a new record to the end of the report.

=
(o]
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TE Calculate Values For All Stations - Calculates the values for all of the stations in the report. The
background color of this icon changes depending on the status of the calculation results. “Green”
indicates that all stations have been calculated and passed the calculation and compliance checks.
“Yellow” indicates that some data values have been changed since the last calculation. “Red”

indicates that a calculation has been performed and that at least one station has failed at least one calculation

or compliance check.

1

Calculate Values For The Current Station Only - Calculates the values for the currently
selected (highlighted) station record only.

Clear Non-Default Cell Values - Clears all of the non-default data values. Using this command
will set the value for data items not associated with a default data value to zero (0) or empty,
depending on the data type associated with the item.

Delete Record - Deletes the currently selected (highlighted) record.

Display Audit Report - Displays the Audit Report for the currently selected (highlighted) record.

Display Data Entry Form - Displays the Data Entry Form for the currently selected (highlighted)
record.
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Display Schematic Interface - Displays the Schematic Data Interface screen for the currently
selected (highlighted) record.

Export To XLS - Exports the currently selected (highlighted) record to an Excel format
spreadsheet file.

Find Record - Finds a record in the report by a specific item value. When clicked, the Find
Specifications screen is displayed.

Go To Record - Displays a specific Record Number at the top of the report. When clicked, the
Go To Record screen is displayed.

Insert Record - Inserts a new record just before the currently selected (highlighted) record.

Make Selection Set - Creates a selection set of station records that meet User-specified selection
criteria. When clicked, the Query Specifications screen is displayed.

Maximize The Screen Size - Increases the report’s size to fill the StationManager display.

Merge Two Stations - Merges two station records into a single station record. When clicked, the
Merge Station Specifications screen is displayed.

Move Record - Moves the currently selected (highlighted) record to a new location in the current
report. When clicked, a message will be displayed to select the new location. Click the OK
command button to clear the message, then select the desired location.

Oops (Undelete) - Restores (undeletes) a recently deleted station record.

Perform Mass Update - Changes data en masse based on User-specified selection criteria. When
clicked, the Mass Update Specifications screen is displayed.
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Print - Prints the contents of the report. When clicked, the Print Settings screen is displayed.

Reset Screen Size - Sets the report’s size to its “normal” dimensions and position.

Reset Selection Set - Resets (clears) the current selection set. When clicked, all of the reportable
station records will now be displayed in the report.

Restore Columns - Restores the display of all of the columns (data items). When clicked, all of
the columns associated with the report will now be displayed.

Save Current Selection Set - Saves the current selection set to a new model. The saved station
records will be used to create a new model.

Set Columns - Specifies which columns (data items) are displayed in the report. When clicked,
the Columns specification screen is displayed.

Sort Ascending - Sorts the station records in ascending order (A to Z or lowest to highest value)
based on the values in the currently selected column.

Sort Descending - Sorts the station records in descending order (Z to A or highest to lowest
value) based on the values in the currently selected column.

Update Values For Current Selection Set - Changes data en masse for the current selection set.
When clicked, the Update Specifications screen is displayed.

Command Buttons

Close - Closes the report screen.
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General Tab

=l Station Record: 1 - Sample, Anytown, CO, Sample 1 EI {=] @

o=@ EE 249 S = =[5 = 2 1 Rl

Location Information | =
Station | B
Record I[Lles::;i(;:calion City/Town State Legal Description Isdl:::l?lri'calion Station Description | Location ﬁg
>1> |Sample Anytown CO Sec Rng Twn Sample 1 PRY To Somewhere Anywhere
2 Sample Anytown 1] Sec Rng Twn Sample 2 PRY To Somewhere Anywhere
3 Sample Anytown CO Sec Rng Twn Sample 3 PRY To Somewhere Anywhere
4 Sample Anytown COo Sec Rng Twn Sample 4 PRY To Somewhere Anywhere
h Sample Anytown Co Sec Rng Twn Sample b PRY To Somewhere Anywhere
b Sample Anytown CO Sec Rng Twn Sample 6 PRY To Somewhere Anywhere
K Sample Anytown COo Sec Rng Twn Sample 7 PRY To Somewhere Anywhere
8 Sample Anytown Co 5Sec Rng Twn Sample 8 PRY To Somewhere Anywhere l—
a9 Sample Anytown Co Sec Rng Twn Sample 9 PRY To Somewhere Anywhere
10 |Sample Anytown Co Sec Rng Twn Sample 10 PRY To Somewhere Anywhere
A 3
General l Hydraulic l Hormal Results l Failed Results l Ci i l Inspection l Settings l E qui t l Images
Close |
Displayed Items

Station Record - Refers to the position of the associated station record. The item is used for reference only.

Data Items

Capacity -
Maximum Required - Specifies the maximum required flow capacity of the station.
Minimum Required - Specifies the minimum required flow capacity of the station.
Configuration -
Number Of Runs - Specifies the number of runs for the station.

Operating Status - Specifies the station’s operating status.
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Stages Per Run - Specifies the number of pressure cuts/stages for each run.
Gas Properties -
Base Pressure - Specifies the pressure basis for the measured volumes.
Base Temperature - Specifies the temperature basis for the measured volumes.
Elevation - Specifies the height above mean sea level of the station’s location.
Flowing Temperature - Specifies the average gas flowing temperature at the station’s inlet.
Specific Gravity - Specifies the average specific gravity of the gas flowing through the station. To
Specific Heat Ratio - Specifies the average heat ratio of the gas flowing through the station. To

Viscosity - Specifies the average absolute or dynamic viscosity of the gas flowing through the
station.

Location Information -
City/Town - Specifies the city or town associated with the station location.
District Identification - Specifies the pressure or operating district associated with the station.

Legal Description - Specifies the “legal” description of the station location. For example, Southwest
1/4 of Section 28.

Location - Specifies the descriptive location of the station. For example, the Northeast corner of 1%
and Main Streets.

State - Specifies the state associated with the station location.

Station Description - Specifies the descriptive identification of the station.

Station Identification - Specifies the station’s identification assignment. For example, TBS #1.
X Coordinate - Specifies the x-coordinates (horizontal)for the station’s location.

Y Coordinate - Specifies the y-coordinates (vertical) for the station’s location.
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Miscellaneous Data -

Comments/Notes - Specifies any comments and notes associated with the station configuration,
location, or operation.

Design Date - Specifies the date when the station was initially designed. Enter a value using the
following format - MM/DD/YYYYY.

Designed By - Specifies who designed the station.
Entered/Revised By - Specifies the who entered or last revised the data for the station.

Entry/Revision Date - Specifies the date when the station data was entered or last revised. Enter
a value using the following format - MM/DD/YYYY.

In Service Date - Specifies the date when the station was put into service. Enter a value using the
following format - MM/DD/YYY'Y.

Jurisdiction - Specifies the regulatory jurisdiction for the station.

Calculated Items

Atmospheric Pressure - Displays the calculated atmospheric pressure based on the specified elevation.

Notes & Considerations

® The Station Data Report is the primary interface for accessing data and records in the database. The report
allows various record management tasks to be performed, allows data values to be entered or changed, and
allows access to the other interface formats. The screen must be open to perform most database edit
functions.

® [fone of the “not calculated” items is selected for the Operating Status, the station will be ignored during
the Calculate All routine; however, the station can still be individually calculated.

® The Jurisdiction item is for reference only; it does not affect the compliance calculation. The Regulatory
Code/Specification item in the Calculation Options controls the compliance calculation method.

® Cells with a white background can be edited by clicking on the cell. Cells with a yellow background color
represent items that are calculated. Cells with a grey background are fixed and cannot be changed by the
User.
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® Clicking on a cell in the Station Record column will highlight the adjacent row. Double-clicking on a cell
in the Station Record column will open the Default Data Entry screen.

® Double-clicking on a cell in the Station Record column while holding down one of the following keys will
open the associated data entry screen.

Alt key - Displays the Audit Report screen
Shift key - Displays the Schematic Data Interface screen
Ctrl key - Displays the station Data Entry Form

® Clicking on a cell representing an item name will highlight the column.

® If no column is selected when one of the sort routines is used, the records are sorted based on the values
assigned to the District Identification item.

® Sce the Mass Update Specifications topic in the Data Screens section for information on the screen
features and on the use of the Mass Update routine. When used with the Station Data Report, changes are
only applied to the records in the current selection set.

® See the Export Routine topic in the Export Routines section for information about the XLS export routine
and process.

® Sce the Database Definition topic in the Appendix section for additional information on the data items
displayed on this data tab.

2
,5 B3PE LLC Engineering & Software Services
Revision - 002, Copyright 2024, All Rights Reserved. 183




StationManager™ 2.1 Data Screens

Table Of Contents

Hydraulic Tab

=] Station Record: 1 Run: 1 Stage: 1- Sample, Anytown, CO, Sample 1 - Working - 1st Cut, Regulator - Relief Valve EI = @
=] =|r= £ F —e====la [z [+
HHA S BSEEE o —([OEE 242 5=0 =l == 1z s
Configuration Upstream Piping A=l
Station | Run Stage e hemahe R I = S —
Record | Humber | Humber n Inlet ax Inlet TEssure ipe icie
Run Type Stage Style Pressure Pressure Units Percent
1 1 1 G |working - 1st Cut Regulator - Relief Valve 50.00 100.00  Psi
2 1 1 EFH |working - 1st Cut Monitor - Upstream 50.00 100.00 Psi
3 1 1 =S |working - 1st Cut Monitor - Downstream 50.00 100.00 Psi
4 1 1 EE  |working - 1st Cut Monitor - Up Working 50.00 100.00  Psi
5 1 1 P |working - 1st Cut Regulator Only 50.00 100.00 Psi
3 1 1 ] | woiking - 1st Cut Relief Valve Only 50.00 100.00 Psi
7 1 1 PG |working - 1st Cut Dual Regulators - Relief 50.00 100.00 Psi
g : 1 G |working - 1st Cut Regulator - Relief Valve 50.00 100.00  Psi
2 B |working - 2nd Cut Regulator - Relief Yalve 45.00 45.00 Psi
. 1 1 B |working - 1st Cut Regulator - Relief Valve 50.00 100.00 Psi
2 1 G |working - 1st Cut Regulator - Relief Valve 50.00 100.00 Psi
: 1 ] | working - 15t Cut Regulator - Relief Valve 50.00 100.00  Psi
10 2 B |working - 2nd Cut Regulator - Relief Valve 40.00 40.00 Psi
2 1 B |working - 1st Cut Regulator - Relief Valve 50.00 100.00 Psi B
A - 3
General Hydraulic l Mormmal Hesullsl Failed Results l LCompliance l Inzpection l Settings l Equipment l Images
Close |
Displayed Items

Run Number - Refers to the number of the run associated with the displayed data. The item cannot be
changed by the User.

Schematic - Refers to a schematic icon for the station configuration. The item cannot be changed by the
User.

Stage Number - Refers to the number of the stage associated with the displayed data. The item cannot be
changed by the User.

Station Record - Refers to the position of the current station record. The item is used for reference only and
cannot be changed by the User.
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Data Items

Configuration -

Run Type - Specifies the operating type of the associated run.

Stage Style - Specifies the configuration type of the associated stage.
Downstream Device -

Device Count - When the downstream device is a relief valve, it specifies the quantity (number) of
devices installed.

Enter Capacity - Specifies whether the capacity value is entered or calculated.

Entered Capacity - Specifies the “entered” capacity value. This item is only enabled when the Enter
Capacity item is set to “Yes.”

Minimum Build-Up (Pressure) - When the downstream device is a relief valve, specifies a User-
defined minimum build-up pressure for the relief valve.

Pressure Units - Specifies the dimensional units for the associated pressure values.
Set Pressure - Specifies the set pressure for the downstream device.

Shared Device - When a relief valve is present and more than one run is present, specifies whether
the valve is shared by both runs.

Size/Type Code - Specifies the Size/Type Code for the downstream device. When clicked, the
Device Selection screen is displayed.

Token Relief - Specifies whether a token relief valve is installed. This item is only displayed when
the device is a regulator.

Token Relief Set Pressure - If a token relief valve is installed, specifies the set pressure for the
token relief valve. This item is only enabled when the Token Relief Installed item is set to “Yes.”

Downstream, Intermediate, Relief Stack Piping -

Flow Equation - Specifies the pipe flow equation to use for the assigned piping components of the
associated stage and run.

Pipe Efficiency - Specifies the pipe flow efficiency value to use for the assigned piping components
of the associated stage and run.
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Piping Components - Specifies the piping components assigned to the associated piping section of
the associated stage and run. When clicked, the Piping Components screen is displayed.

Upstream Device -

Enter Capacity - Specifies whether the capacity value is entered or calculated.

Entered Capacity - Specifies the “entered” capacity value. This item is only enabled when the Enter
Capacity item is set to “Yes.”

Pressure Units - Specifies the dimensional units for the associated pressure values.
Set Pressure - Specifies the set pressure for the downstream device.

Size/Type Code - Specifies the Size/Type Code for the upstream device. When clicked, the Device
Selection screen is displayed.

Token Relief - Specifies whether a token relief valve is installed.

Token Relief Set Pressure - If a token relief valve is installed, specifies the set pressure for the
token relief valve. This item is only enabled when the Token Relief Installed item is set to “Yes.”

Upstream Piping -

Flow Equation - Specifies the pipe flow equation to use for the upstream piping components of the
associated stage and run.

Maximum Inlet Pressure - Specifies the maximum actual pressure at the inlet/upstream end of the
upstream piping.

Minimum Inlet Pressure - Specifies the minimum actual pressure at the inlet/upstream end of the
upstream piping.

Pipe Efficiency - Specifies the pipe flow efficiency value to use for the upstream piping components
of the associated stage and run.

Piping Components - Specifies the piping components assigned to the upstream piping of the
associated stage and run. When clicked, the Piping Components screen is displayed.

Pressure Units - Specifies the dimensional units for the associated pressure values.
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Notes & Considerations

® Some data items may be disabled depending on the station configuration.

® Clicking on a cell representing an item name will highlight the column.

® Cells with a white background can be edited by clicking on the cell. Cells with a yellow background color
represents items that are calculated. Cells with a grey background are fixed and cannot be changed by the

User. Cells with a cyan background represent items that do not apply to the current record.

® Single-clicking in a cell in the Station Record, Run Number, or Stage Number columns will highlight the
adjacent row. Double-clicking in a cell in the Station Record column will open the default data entry screen.

® Sce the Database Definition topic in the Appendix section for additional information on the data items
displayed on this data tab.
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=] Station Record: 1 Run: 1 Stage: 1 - Sample, Anytown, CO, Sample 1 - Working - 1st Cut, Regulator - Relief Valve
™
HHA | BSBES+-—OEE 249 < S Il === | | s
Upstream Piping Upsztream Device
Station | Run Stage Status || . . i o .
Record | Mumber | Humber nlet Tessure Tessure low Rate, elocity, Tessure
Pressure tHutletbies suie Drop Units Mcth Feet/sec loleBiieszure Units
1 1 1 Passed 50.00 49.98 0.02 Psi 10.000 2713 49.98 Psi
2 1 1 Passed 50.00 49.98 0.02 Psi 10.000 2713 49.98 Psi
3 1 1 Passed 50.00 49.98 0.02 Psi 10.000 2713 49.98 Psi
4 1 1 Passed 50.00 49.98 0.02 Psi 10.000 2713 49.98 Psi
5 1 1 Passed 50.00 4998 0.02 Psi 10.000 2713 49.98 Psi
6 1 1 Passed 50.00 49.98 0.02 Psi 10.000 2713
7 1 1 Passed 50.00 49.98 0.02 Psi 10.000 2713 49.98 Psi
8 4 1 Passed 50.00 49.98 0.02 Psi 10.000 2713 49.98 Psi
2 Paszed 45.00 4498 0.02 Psi 10.000 29.41 4498 Psi
9 1 1 Passed 50.00 49.99 0.01 Psi 5.000 13.56 49.99 Psi
2 1 Passed 50.00 49.99 0.01 Psi 5.000 13.56 49.99 Psi
0 1 Passed 50.00 49.99 0.01 Psi 5.000 13.56 49.99 Psi
10 2 Passed 40.00 39.99 0.01 Psi 5.000 16.04 39.99 Psi
2 1 Passed 50.00 49.99 0.01 Psi 5.000 13.56 49.99 Psi ﬂ
4 3
G | J\ Hydraul l N 'HesullsJ\ Failed Results l LCompliance l Inzpection l Settings l E quipment l Images
LClose |
Displayed Items

Run Number - Refers to the number of the run associated with the displayed data. The item cannot be
changed by the User.

Stage Number - Refers to the number of the stage associated with the displayed data. The item cannot be
changed by the User.

Station Record - Refers to the record number of the station associated with the displayed data. The item
cannot be changed by the User.

Status - Refers to the status of the calculation results. A “Failed” value indicates that the run and stage failed
one or more of the various value checks. A “Passed” value indicates that the run and stage passed all of the
various value checks. An “Ignored” value indicates that the run and stage were ignored during the
calculation. The Calculation Message item provides additional descriptive information about the value of
the status item.
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Calculated Items

Calculation -
Message - Displays information about the status of the calculation results.
Downstream Device -

Inlet Pressure - Displays the calculated inlet/upstream pressure through the downstream device
during normal operating conditions.

Operating Mode - Displays the operating mode for the downstream device.

Outlet Pressure - Displays the calculated outlet/downstream pressure for the downstream device
during normal operating conditions.

Pressure Units - Displays the dimensional units for the associated pressure values.
Downstream, Intermediate, Relief Stack, Upstream Piping -

Flow Rate - Displays the calculated flow rate through the associated piping during normal operating
conditions.

Inlet Pressure - Displays the calculated pressure at the inlet/upstream end of the associated piping
of the associated stage and run.

Outlet Pressure - Displays the calculated pressure at the outlet/downstream end of the associated
piping of the associated stage and run.

Pressure Drop - Displays the calculated linear pressure drop across the associated piping of the
associated stage and run.

Pressure Units - Displays the dimensional units for the associated pressure values.

Velocity - Displays the maximum calculated velocity in the associated piping of the associated stage
and run.

Upstream Device -

Inlet Pressure - Displays the pressure calculated at the inlet/upstream side of the upstream device
during normal operating conditions.

Outlet Pressure - Displays the pressure calculated at the outlet/downstream side of the upstream
device during normal operating conditions.
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Pressure Units - Displays the dimensional units for the associated pressure value.

Notes & Considerations

® Cells with a white background can be edited by clicking on the cell. Cells with a yellow background color
represents items that are calculated. Cells with a grey background are fixed and cannot be changed by the
User. Cells with a cyan background represent items that do not apply to the current record.

® Single-clicking in a cell in the Station Record, Run Number, or Stage Number columns will highlight the
adjacent row. Double-clicking in a cell in Station Record column will open the default data entry screen.

® Clicking on a cell representing an item name will highlight the column.

® The “Ignored” status is generally caused by an error in the data associated with the record. The Calculation
Message item will provide additional information on the error. Only one error is described per calculation.
If multiple errors exist, the additional errors will be reported as each previous error is corrected and the
station is recalculated.

® [f “N/C” is displayed in a cell, it indicates that the associated item was not calculated.

® [f“S/C” is displayed in a cell, see the compliance data or message for additional information.

® Sece the Database Definition topic in the Appendix section for additional information on the data items
displayed on this data tab.
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Failed Results Tab
=] Station Record: 1 Run: 1 Stage: 1- Sample, Anytown, CO, Sample 1 - Working - 1st Cut, Regulator - Relief Valve EI = @
—_— == [ E : mmiles AllZ||*
|| =l 2428 ) | I = 1R s
Upstream Fiping Upstream Device A=
Station | Run Stage Status | |nlat . . e . .
Becord | HNumber | Humber nlel ressure Tessure low Hate, elocity, Tessune
Pressure Outlet Pressure Drop Units Mcth Feet/zec Inlet Pressure Units
1 1 1 Passed 100.00 99.93 0.07 Psi 30.058 46.03 99.93 Psi
2 1 1 Passed 100.00 99.99 0.01 Psi 10.000 15.31 99.99 Psi
3 1 1 Passed 100.00 99.99 0.01 Psi 10.000 15.31 99.99 Psi
4 1 1 Passed 100.00 99.99 0.01 Psi 10.000 15.31 99.99 Psi
5 1 1 Passed 100.00 99.93 0.07 Psi 30.058 46.03 99.93 Psi
6 1 1 Passed 100.00 92.31 7.69 Psi 389.811 639.45
7 1 1 Passed 100.00 99.93 0.07 Psi 29.374 44.98 99.93 Psi
8 4 1 Passed 100.00 99.72 0.28 Psi 62.402 95.73 99.72 Psi -
2 Passed 45.00 4498 0.02 Psi 8.762 25.76 4498 Psi
g 1 1 Passed 100.00 99.93 0.07 Psi 29.374 44.98 99.93 Psi
2 1 Passed 100.00 99.93 0.07 Psi 29.374 4498 99.93 Psi
0 1 Paszed 100.00 99.96 0.04 Psi 20.334 31.13 99.96 Psi
10 2 Passed 40.00 39.98 0.02 Psi 8.341 26.77 39.98 Psi
2 1 Passed 100.00 99.96 0.04 Psi 20.334 31.13 99.96 Psi j
4 »
General l Hydraulic l Normal Hesullsl Failed Results l LCompliance l Inzpection l Settings l E gquipment l Images
Cloze |
Displayed Items

Run Number - Refers to the number of the run associated with the displayed data. The item cannot be
changed by the User.

Stage Number - Refers to the number of the stage associated with the displayed data. The item cannot be
changed by the User.

Station Record - Refers to the record number of the station associated with the displayed data. The item
cannot be changed by the User.

Status - Displays the status of the calculation results. A “Failed” value indicates that the run and stage failed
one or more of the various value checks. A “Passed” value indicates that the run and stage passed all of the
various value checks. An “Ignored” value indicates that the run and stage were ignored during the
calculation. The Calculation Message item provides additional descriptive information about the value of
the status item.
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Calculated Items

Calculation -

Message - Displays information about the status of the calculation results.

Downstream Device -

Inlet Pressure - Displays the pressure calculated at the inlet/upstream side of the downstream device
during failed operating conditions.

Operating Mode - Specifies the operating mode of the downstream device.

Outlet Pressure - Displays the pressure calculated at the outlet/downstream side of the downstream
device during failed operating conditions.

Pressure Units - Displays the dimensional units for the associated pressure values.

Downstream, Intermediate, Relief Stack, Upstream Piping -

Flow Rate - Displays the calculated flow rate through the associated piping under failed operating
conditions.

Inlet Pressure - Displays the calculated pressure at the inlet/upstream end of the associated piping
of the associated stage and run.

Outlet Pressure - Displays the calculated pressure at the outlet/downstream end of the associated
piping of the associated stage and run.

Pressure Drop - Displays the calculated linear pressure drop across the associated piping of the
associated stage and run.

Pressure Units - Displays the dimensional units for the associated pressure value.

Velocity - Displays the maximum calculated velocity in the associated piping of the associated stage
and run.

Upstream Device -

Inlet Pressure - Displays the pressure calculated at the inlet/upstream end of the upstream device
during failed operating conditions.

Outlet Pressure - Displays the pressure calculated at the outlet/downstream end of the upstream
device during failed operating conditions.
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Pressure Units - Displays the dimensional units for the associated pressure values.

Notes & Considerations

® Cells with a white background can be edited by clicking on the cell. Cells with a yellow background color
represents items that are calculated. Cells with a grey background are fixed and cannot be changed by the
User. Cells with a cyan background represent items that do not apply to the current record.

® Single-clicking in a cell in the Station Record, Run Number, or Stage Number columns will highlight the
adjacent row. Double-clicking in a cell in Station Record column will open the default data entry screen.

® Clicking on a cell representing an item name will highlight the column.

® The “Ignored” status is generally caused by an error in the data associated with the record. The Calculation
Message item will provide additional information on the error. Only one error is described per calculation.
If multiple errors exist, the additional errors will be reported as each previous error is corrected and the
station is recalculated.

® [f “N/C” is displayed in a cell, it indicates that the associated item was not calculated.

® Sce the Database Definition topic in the Appendix section for additional information on the data items
displayed on this data tab.

=
,3 B3PE LLC Engineering & Software Services
Revision - 002, Copyright 2024, All Rights Reserved. 193




StationManager™ 2.1 Data Screens

Table Of Contents
L3
Compliance Tab
=] Station Record: 1 Run: 1 Stage: 1- Sample, Anytown, CO, Sample 1 - Working - 1st Cut, Regulator - Relief Valve EI = @
=] =|r= £ F —e====la [z [+
HHA S BSEEE o —([OEE 242 5=0 =l == 1z s
Capacity. Mcfh Upstream Piping sl
Station | Run Stage Stat : 3
Record | Mumber | Number | 2 t3'4% Upstream Device | Downstream Device | MAOP Allowable Build-Up | Maximum Calculated | Pressure MADP
Pressure Pressure Units
1 1 1 Passed 30.058 116.657 100.00 100.00 100.00 Psi
2 1 1 Passed 11.488 23.639 100.00 100.00 100.00 Psi
3 1 1 Passed 14.766 29.614 100.00 100.00 100.00 Psi
4 1 1 Pasged 10.885 10.885 100.00 100.00 100.00 Psi
5 1 1 Passed 29.614 100.00 100.00 100.00 Psi
6 1 1 Passed 0.000 454 243 100.00 100.00 100.00 Psi
7 1 1 Passed 29.375 116.657 100.00 100.00 100.00 Psi
8 4 1 Passzed 62.413 233.314 100.00 100.00 100.00 Psi
2 Passed 8.763 233.314 100.00 100.00 45.00 Psi
g 1 1 Passed 29.375 116.657 100.00 100.00 100.00 Psi
2 1 Passed 29.375 116.657 100.00 100.00 100.00 Psi
0 1 Passed 20.336 233.314 100.00 100.00 100.00 Psi
10 2 Passed 8.342 233.314 100.00 100.00 40.00 Psi
2 1 Passed 20.236 233314 100.00 100.00 100.00 Psi ﬂ
A 3
General l Hydraulic l Mormmal Hesullsl Failed Results l LCompliance l Inzpection l Settings l Equipment l Images
Close |

Displayed Items

Run Number - Refers to the number of the run associated with the displayed data. The item cannot be
changed by the User.

Stage Number - Refers to the number of the stage associated with the displayed data. The item cannot be
changed by the User.

Station Record - Refers to the record number of the station associated with the displayed data. The item
cannot be changed by the User.

Status - Refers to the status of the calculation results. A “Failed” value indicates that the station failed one
or more of the various value checks. A “Passed” value indicates that the station passed all of the various
value checks. A “N/C” value indicates that the station data was not calculated or has been changed since the
results were last calculated. The Calculation Message item provides additional descriptive information about
status value.
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Data Items

Calculation -

Failure Override - Specifies whether the status of a failed station is to be ignored or “overridden”
by the User. This item is only displayed when at least one stage of a station has failed.

Reviewed By - Specifies who reviewed the station data and calculation results.
Reviewed Date - Specifies the date when the station data and calculation results were reviewed.
Downstream Piping, Intermediate Piping, & Upstream Piping -

MAQOP - Specifies the Maximum Allowable Operating Pressure during normal operating conditions
for the associated piping section.

Calculated Items

Calculation -
Message - Displays information about the status of the calculation results.
Capacity -
Downstream Device - Displays the maximum calculated capacity of the downstream device.
Upstream Device - Displays the maximum calculated capacity of the upstream device.
Downstream Piping, Intermediate Piping, & Upstream Piping -
Allowable Build-Up Pressure - Displays the maximum allowable build-up pressure during failed
conditions for the associated piping section. The value is based on the requirements of the specified

Regulatory Code.

Maximum Calculated Pressure - Displays the maximum calculated pressure during failed or
normal conditions for the associated piping section.

Pressure Units - Displays the dimensional units for the associated pressure values.
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Notes & Considerations

® [f the Failure Override option is set to “Yes” for a failed station, it is suggested that a comment be added
to the notes section for the station explaining the justification for the override action.

® Cells with a white background can be edited by clicking on the cell. Cells with a yellow background color
represents items that are calculated. Cells with a grey background are fixed and cannot be changed by the

User. Cells with a cyan background represent items that do not apply to the current record.

® Single-clicking in a cell in the Station Record, Run Number, or Stage Number columns will highlight the
adjacent row. Double-clicking in a cell in Station Record column will open the default data entry screen.

® Clicking on a cell representing an item name will highlight the column.

® The “Ignored” status is generally caused by an error in the data associated with the record. The Calculation
Message item will provide additional information on the error. Only one error is described per calculation.
If multiple errors exist, the additional errors will be reported as each previous error is corrected and the
station is recalculated.

® [f “N/C” is displayed in a cell, it indicates that the associated item was not calculated.

® The Regulatory Code is specified using the Set Calculation Options item found in the Preferences
submenu of the File menu.

® Sece the Appendix section for information about how the various values are calculated.

® Sce the Database Definition topic in the Appendix section for additional information on the data items
displayed on this data tab.
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L3
Inspection Tab
=] Station Record: 1 - Sample, Anytown, €O, Sample 1 EI =
=] —[@=E —e=ie=la [z |[[*
A BSmEE+o—|CEE = 817 s
Status Inzpection Results A=l
Station
Record For Year | previous Required Completed Inspection Status Enclosures | Paint | Site Protection | Signs | Vents | Strair
Inspection Date | Inspection Date | Inspection Date p oK 0K |OK oK oK 119

1 2005 0770542004 10/04/2005 Past Due [0ld Fr) H/A N/A N/A Yes Ye
2 2005 07/05/2004 10/04/2005 07/05/2004 Past Due By 4060 Days M/A N/A N/A Yes Ye
3 2004 07/05/2004 10/04/2005 07/05/2004 Completed On Time M/A N/A N/A Yes Ye
4 2004 0770552004 10/04/2005 07/05/2004 Completed On Time M/A N/A N/A Yes Ye
5 2004 0770542004 10/04/2005 07/05/2004 Completed On Time N/A N/A N/A Yes Ye
6 2004 07/05/2004 10/04/2005 07/05/2004 Completed On Time M/iA N/A N/A Yes Ye
7 2004 07/05/2004 10/04/2005 07/05/2004 Completed On Time M/A N/A N/A Yes Ye
8 2004 0770542004 10/04/2005 07/05/2004 Completed On Time H/A N/A N/A Yes Ye—|
9 2004 07/05/2004 10/04/2005 07/05/2004 Completed On Time M/A N/A N/A Yes Ye
10 2004 07/05/2004 10/04 /2005 07/05/2004 Completed On Time L NAA N/A Yes Ye

A 3
General l Hydraulic l Mormmal Hesullsl Failed Results l LCompliance l Inzpection l Settings l Eguipment l Images

LClose |
Displayed Items

Station Record - Refers to the record number of the station associated with the displayed data. The item
cannot be changed by the User.

Data Items

For Year - Specifies the calendar year that the inspection is associated with.
Inspection Results -

Data Recorders OK - Specifies the status of the condition of any pressure recorders installed at the
station.

Enclosures OK - Specifies the status of the condition of any enclosure, housing, or vault installed
at the station.
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Locks OK - Specifies the status of the condition and presence of any security locks installed at the
station.

OPP Capacity Field Verified - Specifies the flow capacity of the Over Pressure Protection (OPP)
device was field verified or tested.

OPP Devices Lock-Up OK - Specifies whether the Over Pressure Protection (OPP) device passed
the “lock-up” (shut off) test.

OPP Devices Operated - Specifies whether the Over Pressure Protection (OPP) device was actually
operated during the field inspection or just visually inspected.

OPP Internals Inspected - Specifies whether the Over Pressure Protection (OPP) device was
dismantled and the condition of its internal components was inspected.

Paint OK - Specifies the status of the condition of the paint or atmospheric corrosion protection for
the station.

Regulator Internals Inspected - Specifies whether the regulator device was dismantled and the
condition of its internal components was inspected.

Regulators Lock-Up OK - Specifies whether the regulator device passed the “lock-up” (shut off)
test.

Regulators Operated - Specifies whether the regulator device was actually operated during the field
inspection or just visually inspected.

Signs OK - Specifies the status of the condition of the warning signs and posted notices for the
station.

Site Protection OK - Specifies the status of the condition of the site protection for the station. For
example, fencing, bollards, or livestock guards.

Strainers OK - Specifies the status of the condition of any strainers or filters installed at/on the
station.

Valves OK - Specifies the status of the condition of the valves for the station.

Vents OK - Specifies the condition of the device and enclosure vents for the station.

Miscellaneous -

Action Completed By - Specifies who performed the required corrective actions.

B3PE LLC Engineering & Software Services
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Completion Date - Specifies the date when any required actions were completed. Enter a value
using the following format - MM/DD/YYYYY.

Inspected By - Specifies who performed the field inspection.

Inspection Date - Specifies the date when the field inspection was performed. Enter a value using
the following format - MM/DD/YYYY.

Notes - Specifies any notes and comments associated with the inspection.

Other Observations (See NOTES) - Specifies whether additional observations or comments are
included in the Inspection Notes.

Required Actions - Specifies any corrective actions that must be taken to bring the station into
compliance.

Status -
Previous Inspection Date - Specifies the date of the most previous field inspection. Enter a value

using the following format - MM/DD/YYYY.

Calculated Items

Status -

Completed Inspection Date - Displays the date when the most previous field inspection was
conducted.

Inspection Status - Displays the status of the latest field inspection results for the specified year.

Required Inspection Date - Displays the date for the next required field inspection.

Notes & Considerations

® Cells with a white background can be edited by clicking on the cell. Cells with a yellow background color
represents items that are calculated. Cells with a grey background are fixed and cannot be changed by the
User. Cells with a cyan background represent items that do not apply to the current record.

® Single-clicking in a cell in the Station Record, Run Number, or Stage Number columns will highlight the
adjacent row. Double-clicking in a cell in Station Record column will open the default data entry screen.
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® Clicking on a cell representing an item name will highlight the column.

® Sce the Database Definition topic in the Appendix section for additional information on the data items
displayed on this data tab.
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L3
Settings Tab
=] Station Record: 1 Run: 1 Stage: 1- Sample, Anytown, CO, Sample 1 - Working - 1st Cut, Regulator - Relief Valve EI =
E E =] [ NIF=I=] &£ — = — [y
Upstream Device [Primary] Upstream Device [Secondary] Downstream Device [Primary] |~
Station | Bun Stage
Record| Number | Number | |nitial Setting | Final Setting | [/ | Initial Setting | Final Setting |['***'® | Initial Setting | Final Setting |}, /%5*1®
1 1 1 0.00 0.00 Psi 0.00 0.00 Psi 0.00 0.00
2 1 1 0.00 0.00 Psi 0.00 0.00
3 1 1 0.00 0.00 Psi 0.00 0.00
4 1 1 0.00 0.00 Psi 0.00 0.00
5 1 1 0.00 0.00 Psi
6 1 1 0.00 0.00
7 1 1 0.00 0.00 Psi 0.00 0.00
8 4 1 0.00 0.00 Psi 0.00 0.00
2 0.00 0.00 Psi 0.00 0.00
g 1 1 0.00 0.00 Psi 0.00 0.00
2 1 0.00 0.00 Psi 0.00 0.00
0 1 0.00 0.00 Psi 0.00 0.00
10 2 0.00 0.00 Psi 0.00 0.00
2 1 0.00 0.00 Psi 0.00 0.00 ﬂ
A 3
General l Hydraulic l Mormmal Hesullsl Failed Results l LCompliance l Inzpection l Settings l Equipment l Images
Close |
Displayed Items

Run Number - Refers to the number of the run associated with the displayed data. The item cannot be
changed by the User.

Stage Number - Refers to the number of the stage associated with the displayed data. The item cannot be
changed by the User.

Station Record - Refers to the record number of the station associated with the displayed data. The item
cannot be changed by the User.

=
27| B3PE LLC

Engineering & Software Services

Revision - 002, Copyright 2024, All Rights Reserved.

201



StationManager™ 2.1 Data Screens

Table Of Contents

Data Items

Downstream & Upstream Device (Primary & Secondary) -
Final Setting - Specifies the final (as left) settings for the associated device at the completion of the
inspection. If adjustments are made during the inspection, the value will be different than the initial

setting.

Initial Setting - Specifies the initial (as found) settings for the associated device at the beginning
of the inspection.

Inspection Data -

Date - Specifies the date when the field inspection was performed. Enter a value using the following
format - MM/DD/YYYY.

Performed By - Specifies who performed the field inspection.

Calculated Items

Pressure Units - Displays the dimensional units for the associated pressure values.

Notes & Considerations

® Cells with a white background can be edited by clicking on the cell. Cells with a yellow background color
represents items that are calculated. Cells with a grey background are fixed and cannot be changed by the
User. Cells with a cyan background represent items that do not apply to the current record.

® Single-clicking in a cell in the Station Record, Run Number, or Stage Number columns will highlight the
adjacent row. Double-clicking in a cell in Station Record column will open the default data entry screen.

® Clicking on a cell representing an item name will highlight the column.

® Sce the Database Definition topic in the Appendix section for additional information on the data items
displayed on this data tab.
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L3
Equipment Tab
= Station Record: 10 Run: 2 Stage: 2 - Sample, Anytown, CO, Sample 10 - Working - 2nd Cut, Regulator - Relief Valve EI [=] @
==X S B O EE L
+9[—|DEE] 2 YEZEE== s 2sv
Upstream Device A=l
Station | Run Stage B . B B
Record| Number | Number | 5ie/Type Code Manufacturer Model Bodygize Qi Unlicesaize Y etial Conned
Inches Inches Number
1 1 1 FC 299 142 Fisher Controls 299 1142 172 Screwe
2 1 1 FC 299 1/2 Fisher Controls 299 1-1/2 172 Screwe
3 1 1 FC 29912 Fisher Controls 299 1142 172 Screwe
4 1 1 FC 299 3/4 Fisher Controls 299 1142 3/4 Unkno¥
5 1 1 FC 299 152 Fisher Controls 299 1152 142 Screwe
6 1 1
7 1 1 FC 299 142 Fisher Controls 299 1142 172 Screwe
8 i 1 FC 299 3/4 Fisher Controls 299 1172 3/4 Screwe
2 FC 299142 Fisher Controls 299 1142 172 Screwe
q 1 1 FC 299142 Fisher Controls 299 1142 172 Screwe
2 1 FC 29912 Fisher Controls 299 1142 172 Screwe
i 1 FC 299 142 Fisher Controls 299 1142 172 Screwe
10 2 FC 293 1/2 Fizher Controls 299 1172 142 Screwe
2 1 FC 293 1/2 Fizher Controls 299 1172 142 Screthj
A 3
General l Hydraulic l Hormal Hesullsl Failed Results l Ci i l Inspection l Settings l E qui t Images
Close |
Displayed Items

Run Number - Refers to the number of the run associated with the displayed data. The item cannot be
changed by the User.

Stage Number - Refers to the number of the stage associated with the displayed data. The item cannot be
changed by the User.

Station Record - Refers to the record number of the station associated with the displayed data. The item
cannot be changed by the User.

Data Items

Downstream Device -
Connection Style - Specifies the end connection style of the device.

Diaphragm Size - Specifies the main body diaphragm size of the device.
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Diaphragm Type - Specifies the main body diaphragm type of the device.

Maximum Body Pressure - Specifies the maximum pressure of the device’s main body.
Pressure Units - Specifies the dimensional units for the associated pressure values.
Serial Number - Specifies the serial number of the device.

Spring Color - Specifies the color of the main spring used by the device.

Spring Maximum Pressure - Specifies the maximum pressure rating of the main spring.
Spring Minimum Pressure - Specifies the minimum pressure rating of the main spring.

Spring Number - Specifies the sizing/rating number of the main spring.

Downstream Pilot (Primary & Secondary) -

Manufacturer - Specifies the manufacturer’s name of the associated pilot regulator.

Maximum Body Pressure - Specifies the maximum body rating of the associated pilot regulator.
Model - Specifies the model name or number of the associated pilot regulator.

Pressure Units - Specifies the dimensional units of the associated pressure values.

Spring Color - Specifies the color of the spring used by the associated pilot regulator.

Spring Maximum Pressure - Specifies the maximum pressure rating of the spring used by the
associated pilot regulator.

Spring Minimum Pressure - Specifies the minimum pressure rating of the spring used by the
associated pilot regulator.

Spring Number - Specifies the sizing/rating number of the spring used by the associated pilot
regulator.

Meter Data -

Connection Style - Specifies the type of end connection of the meter.

Maximum Capacity - Specifies the maximum capacity of the meter installed at the station. If a
meter is installed, enter a value; otherwise, leave the data cell empty.
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Minimum Capacity - Specifies the minimum capacity of the meter installed at the station. If a meter
is installed, enter a value; otherwise, leave the data cell empty.

Pressure Rating - Specifies the maximum pressure rating of the meter installed at the station. If a
meter is installed, enter a value; otherwise, leave the data cell empty.

Rating Units - Specifies the dimensional units used to express the various rating values.

Size/Type Code - Specifies the Size/Type Code of the meter (if any) installed at the station.
Pressure Recorder Data -

High Range - Specifies the upper limit of the pressure recorder (if any) installed at the station.

Low Range - Specifies the lower limit of the pressure recorder (if any) installed at the station.

Make/Type - Specifies the manufacturer’s name and model or type of the data recorder (if any)
installed at the station.

Range Units - Specifies the dimensional units used to express the various range values.
Upstream Device -

Connection Style - Specifies the end connection style of the device.

Diaphragm Size - Specifies the main body diaphragm size of the device.

Diaphragm Type - Specifies the main body diaphragm type of the device.

Maximum Body Pressure - Specifies the maximum pressure of the device’s main body.

Pressure Units - Specifies the dimensional units for the associated pressure values.

Serial Number - Specifies the serial number of the device.

Spring Color - Specifies the color of the main spring used by the device.

Spring Maximum Pressure - Specifies the maximum pressure rating of the main spring.

Spring Minimum Pressure - Specifies the minimum pressure rating of the main spring.

Spring Number - Specifies the sizing/rating number of the main spring.
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Upstream Pilot (Primary & Secondary) -

Manufacturer - Specifies the manufacturer’s name of the associated pilot regulator.

Maximum Body Pressure - Specifies the maximum body rating of the associated pilot regulator.
Model - Specifies the model name or number of the associated pilot regulator. To

Pressure Units - Specifies the dimensional units of the associated pressure values.

Spring Color - Specifies the color of the spring used by the associated pilot regulator.

Spring Maximum Pressure - Specifies the maximum pressure rating of the spring used by the
associated pilot regulator.

Spring Minimum Pressure - Specifies the minimum pressure rating of the spring used by the
associated pilot regulator.

Spring Number - Specifies the sizing/rating number of the spring used by the associated pilot
regulator.

Calculated Items

Note - These values are taken from the associated Property Table for the specified Size/Type Code.

Downstream Device -

Body Size - Displays the body size associated with the selected Size/Type Code.

Manufacturer - Displays the manufacturer’s name associated with the selected Size/Type Code.
Model - Displays the model name or number associated with the selected Size/Type Code.
Orifice Size - Displays the orifice size associated with the selected Size/Type Code.

Size/Type Code - Displays the Size/Type Code of the selected device (for reference only).

Upstream Device -

Body Size - Displays the body size associated with the selected Size/Type Code.

Manufacturer - Displays the manufacturer’s name associated with the selected Size/Type Code.
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Model - Displays the model name or number associated with the selected Size/Type Code.
Orifice Size - Displays the orifice size associated with the selected Size/Type Code.

Size/Type Code - Displays the Size/Type Code of the selected device (for reference only).

Notes & Considerations

® Cells with a white background can be edited by clicking on the cell. Cells with a yellow background color
represents items that are calculated. Cells with a grey background are fixed and cannot be changed by the
User. Cells with a cyan background represent items that do not apply to the current record.

® Single-clicking in a cell in the Station Record, Run Number, or Stage Number columns will highlight the
adjacent row. Double-clicking in a cell in Station Record column will open the default data entry screen.

® Clicking on a cell representing an item name will highlight the column.

® Sece the Database Definition topic in the Appendix section for additional information on the data items
displayed on this data tab.
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Images Tab

=] Station Record: 1 - Sample, Anytown, €O, Sample 1
QB TEEE [ EE

2 Image Filenames
Station Record

—
VP [z

Image 1 |Image 2 |Image 3
Click To Add An Image...
Click To Add An Image...
Click To Add An Image...
Click To Add An Image...
Click To Add An Image...
Click To Add An Image...
Click To Add An Image...
Click To Add An Image...
Click To Add An Image...
Click To Add An Image...

[T-R - - B B U L L )

-
=

4 b

General l Hydraulic lﬂolmal Hesullsl Failed Hesullsl LCompliance l Inzpection l Settings l Eguipment l Images

LClose |

Displayed Items

Station Record - Refers to the record number of the station associated with the displayed data. The item
cannot be changed by the User.

Data Items

Image Filenames - If an image is assigned, the filename will be displayed in the associated cell. Click in the
associated cell to open the Image Specifications screen to assign a new or additional image to the station. The
Image Specifications screen also allows the User to change, view, edit, or unassign the image.

Notes & Considerations

® Single-clicking in a cell in the Station Record, Run Number, or Stage Number columns will highlight the
adjacent row. Double-clicking in a cell in Station Record column will open the default data entry screen.
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® Clicking on a cell representing an item name will highlight the column.

® Sce the Image Specifications topic in the Data Screens section for more information about working with
images.
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Update Specifications

Mass changes can be made to the currently selected station data records. To access this routine, |§|
click the Update Selection Set icon from the Station Data Report. The Update routine is controlled

using the Update Specifications screen. The features associated with the screen are described as
follows.

Update Specifications...

Yalue Setting._.
Set___ Equal To_..

Equip - Dn Device - Spring Mumber ﬂ

Cancel ‘ Bestore | Update

Data Items

Equal To - Specifies the new value for the specified Set item. The characteristics of the item change
depending on the Set value.

Set - Specifies the data item to be updated.

Command Buttons

Apply - Closes the screen and applies changes.
Cancel - Closes the screen without performing the routine.

Restore - Restores the data values that existed just prior to the executed update.

Notes & Considerations

® The Update routine is similar to the Mass Update routine, except that the Update routine only applies
changes to the records in the current selection set. The Mass Update routine can be used to apply changes
to records associated with User-specified selection criteria.
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Using Property Tables

The Property Table Report feature allows redundant pipe data to be included in a common file and helps
support the modeling of non-pipe hydraulic features. The Property Tables use relational data management
techniques to maintain a relation between the pipe data files and the Property Tables. A Property Table may
be thought of as a reference table. Information may be stored in the Property Table and then referenced to
or “looked up” based on a common link value (Size/Type Code). The Size/Type Code is used to establish
the link between the pipe data files and the Property Tables. The pipe data and the data contained in the
Property Tables are said to be “related” by the Size/Type Code. Through this relation, StationManager can
access the data found in the Property Tables as needed without storing all of the model-required data in the
pipe data files.

Several items in the station database can be linked to a single item in a Property Table. This feature allows
redundant data to be stored only once, reducing data storage and entry requirements. This feature also allows
mass changes to be made by changing the value one time in the Property Table and automatically changing
all of the component features that are related to that particular Property Table and item.

To demonstrate how Property Tables may be used, consider the Pipe Property Table. This Property Table
contains information about the dimensional properties of various pipe sizes and types. For each unique
Size/Type Code, the Property Table stores the wall thickness, outside diameter, and calculated inside
diameter of the pipe. The diameter for a pipe record may be entered as a Size/Type Code value instead of
entering the actual inside pipe diameter. For example, the code “2P” (which represents two-inch plastic) may
be input for a pipe’s Size/Type (diameter) instead of an actual Inside Diameter value of “1.917.” When an
actual inside diameter for the pipe is required, the Pipe Property Table will be searched for the Size/Type
Code value equal to “2P.” When a match is found, the value of the inside diameter associated with that
record is extracted from the Pipe Property Table.

There are several advantages to using the Property Tables to store the dimensional pipe data. First, it
eliminates the need for the User to remember the specific values for the various data items in their system.
By defining the Property Table using logical codes, like “2P,” to represent a two-inch plastic pipe, the User
only needs to remember these easily identified Size/Type Codes. Second, the use of Property Tables helps
to ensure the integrity of the model data. By maintaining the pipe sizes in a single location and by selecting
the Size/Type Codes from the list when entering data, entry errors may be reduced, and consistent size values
may be assured.

“Standard” Property Tables are included when StationManager is installed. The content of the various
Property Tables may be modified as necessary to meet the User’s specific needs. The Property Tables may
be revised, added to, or deleted from by the User. When choosing values to be used as the Size/Type Codes
for the data items, attempt to choose codes that are short and logical. If you choose codes that are long or
hard to understand, you have defeated one of the biggest advantages of using the Property Table features.
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To view or edit the contents of the Property Table Report, select the Property Tables item from the Edit
menu. The Property Table Report is displayed. Select the data tab associated with the desired Property Table.

The remainder of this section describes the Property Table Report.
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Property Table Report

The data contained in the various Property Tables may be viewed, printed, and edited using the Property
Table Report. The content displayed in the report will change depending on the selected type. The general
features associated with the Property Table Report are described in the following sections.

=]l Property Table Report - C:\Program Files (x86)\StatMan 2\properties\pipe.ppf @
=l i VES |V = = AllZ
.? Q@@gnl | I y |L§%ZlAl EB
Pipe T Regulator T Relief Valve T Fitting
Rec # |Display |Size!T_l,lpe |Material |Numinal Size| Uze When Sizing |Sizing Group |I]ulside Dian|\l¢l’i:
1 Ye: 1/2P-57CTS Plastic - MDPE 142 Yes Group-1 0.625
2 Yes 3/4P-598 Plastic - MDPE 3/ Yes Group-1 0.875
3 Yes: 1P-511.5CT5S Plastic - MDPE 1 Yes Group-1 1.125
4 Yes 1/2P-59.3 Plastic - MDPE 172 Yes Group-1 0.840
5 Yes 3/MP-511 Plastic - MDPE 3/ Yes Group-1 1.050
b Yes | 1P-511 Plastic - MDPE 1 Yes Group-1 1.315 =
| | »
Close ‘
Displayed Items

Rec # - Displays the Record Number of the associated Size/Type Code displayed in the Property Table. The
values are used for reference only and cannot be changed by the User.

Icons

‘ Add Record - Adds a new record to the end of the current Property Table.

=+

Copy To Clipboard - Copies the contents of the Property Table to the Windows clipboard. Once
r@ copied, the contents may be pasted into another application.

‘ Delete Record - Deletes the currently selected (highlighted) record in the current Property Table.

N
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Find Record - Finds a station record in the Property Table by the Size/Type Code. When clicked,
the Find screen is displayed.

Insert From Clipboard - Inserts data from the Windows clipboard. The data will be inserted into
the currently displayed Property Table immediately after the currently selected (highlighted)
record. The data must be in a tab-delimited format that only contains “data” values and does not
include header titles or record numbers. Generally, it is best to insert data that has been previously

copied from the Property Table using the Copy To Clipboard icon.

v = |22 [ F

Insert Record - Inserts a new record just before the currently selected (highlighted) record in the
current Property Table.

Locked Table - Indicates that the Property Table is locked from editing. Click this icon to
“unlock” the table to allow editing. Once clicked, the contents of a previously locked Property
Table may be changed.

Maximize Screen Size - Increases the Property Table’s size to fill the StationManager display.

Merge Table - Merges the contents of another Property Table into the current Property Table.
When clicked, a message will be displayed asking whether to insert the new data at the currently
selected (highlighted) record location (click the Yes command button) or at the end of the Property
Table (click the No command button) - respond appropriately. The File Selection screen is

displayed. Select the name of the desired file, then click the Continue command button. A message will be
displayed when the process is complete - click the OK command button to clear the message.

I

|0

-

Move Record - Moves the currently selected (highlighted) record to a new location in the current
Property Table. When clicked, a message will be displayed to select the new location. Click the
OK command button to clear the message, then select the desired location.

Open - Opens a previously saved Property Table file. When clicked, the File Selection screen is
displayed.

Print - Prints the contents of the current Property Table. When clicked, the Print Settings screen
is displayed.

Reset Screen Size - Sets the Property Table’s size to its “normal” dimensions and position.
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Restore Columns - Restores the display of all of the columns (data items). When clicked, all of
the columns associated with the current Property Table will displayed.

Save - Saves the contents of the current Property Table. When clicked, the File Selection screen
is displayed. Once saved, the file may be opened and used with other databases.

Set Columns - Used to specify which columns (data items) are displayed in the current Property
Table. When clicked, the Columns specification screen is displayed.

Set As Current - Sets the current Property Table as the currently assigned Property Table in the
Preference Settings. A message will be displayed when the Property Table has been set. Click the
OK command button to clear the message.

Show Help - Displays this Help Reference.

Sort Ascending - Sorts the records in ascending order (A to Z or lowest to highest value) based
on the values in the highlighted column. Note - If the Property Table is saved after the sort has
been implemented, the Property Table will be permanently saved in the new order.

Sort Descending - Sorts the records in descending order (Z to A or highest to lowest value) based
on the values in the highlighted column. Note - If the Property Table is saved after the sort has
been implemented, the Property Table will be permanently saved in the new order.

Swap Yes And No - Swaps all of the “’Yes” values in the currently selected (highlighted) column
to “No” and all of the “No” values to “Yes.”

Unlocked Table - Indicates that the Property Table is unlocked for editing. Click this icon to
“lock” the table from editing. Once clicked, the table contents can be viewed; however, the
contents cannot be changed until the Property Table is “unlocked.”

Yes To No - Changes all of the “Yes” values in the currently selected (highlighted) column from
“Yes” to “No.”

Command Buttons

Close - Closes the Property Table Report.
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Notes & Considerations

® The Property Tables use the Size/Type Code to relate devices and components assigned to the station
configuration to the individual items in the associated Property Table. When choosing values to be used for
the Size/Type Codes, attempt to choose codes that are short and logical. If codes that are long, hard to
remember, or understand are used, one of the biggest advantages of using the Property Table will be defeated.

® When a record or data cell is selected in the report, the “row” associated with the record is highlighted.
The highlighted row indicates the location of the “current” record.

® The Property Tables likely contain sizes and models that are not applicable to your situation. Undesired
items can be deleted from the table, or their Display data item value can be set to “No.” Only sizes and

models where the Display item is set to ““Yes” are included in the data lists used by the various data screens.

® Alternative Property Tables can be created and stored using different file names. The Property Table item
in the File menu can be used to indicate which property to use with the current database.

® The standard files which contain the various Property Tables are described below:

Property Table Type Filename
Fitting fitting. fpf
Pipe pipe.ppf
Regulator regulator.rpf
Relief Valve relief.lpf

® The files are normally stored in the “properties” directory of the root StationManager program directory.
For example, the files are normally located in the “\Program Files\StatMan 2\properties” directory.

® When changes are saved for a table, a backup file is created just before the changes are saved. The backup
file is named the same as the original file; however, it contains an additional “.bak” extension. The previous
file contents can be restored by manually copying or renaming the backup file to its original name. The
previous backup file is sent to the Windows Recycle Bin.

® Product specifications are stored in a set of subdirectories of the current Property Tables directory/path.
Additional specifications can be added by copying the new document to the appropriate directory location.

=
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Fitting Tab
=]l Property Table Report - Ci\cfiles\sm20\properties\fitting.fpf @
=] - VES WES == A d @
| HE Q| BES =M %, \m+"}—[%|§zlﬂ P IEN
Pipe T Regulator T Relief Yalve T Fitting

Rec # | Display |Size!T_l,|pe Code |Fitling Type |Numina| Size| Equivalent Diamelel| Houghness| D. B Units
1 Yes 1/2L-45Thd Elbow 142 0.622 0.00070 Inches e
2 Yes 1/2L-90 Elbow 142 0.622 0.00070 Inches
3 Yes 1/21-90 Thd Elbow 142 0.622 0.00070 Inches
4 Yez 1/2L-905R Thd Elbow 142 0.622 0.00070 Inches
L Yes 1/2L-180 Thd Elbow 142 0.622 0.00070 Inches
b Yes | 1/2 Pipe Exit Other 172 0.622 0.00070 Inches =

4] | v

Close ‘

Data Items

Description - Specifies a brief description of the associated fitting. The description can contain up to eighty
(80) alphanumeric characters.

Display - Specifies whether the associated record will be included in the Size/Type Code selection list when
it is displayed. Only items where the value of the Display item is set to “Yes” will be displayed in the data

lists.

Diameter, Roughness Units - Specifies the dimensional units for the equivalent diameter and roughness
values.

Efficiency - Specifies the efficiency value to be used with the associated fitting. See the following Notes &
Considerations section for additional information on the use of efficiency in the report.

Equivalent Diameter - Specifies the value of the equivalent diameter for the associated fitting. The
equivalent diameter represents the inside diameter value that was used as the basis for calculating the
equivalent length value.

Equivalent Length - Specifies the value of the calculated equivalent length of the associated fitting.

Fitting Type - Specifies the common name for the associated fitting. For example, elbow or tee.

Length Units - Specifies the dimensional units for the equivalent length values.
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Maximum Pipe ID - This item is not used by StationManager.
Minimum Pipe ID - This item is not used by StationManager.
Nominal Size - Specifies the nominal “body” size for the associated fitting.

Reference - Specifies the source for the entered information for the associated fitting. The reference can
contain up to eighty (80) alphanumeric characters.

Roughness - Specifies the value of the inside wall roughness to be used for the associated fitting.
Size/Type Code - Specifies the current fitting’s unique Size/Type Code. This item is used to relate the
Fitting Property Table to the Station Database. The Size/Type Code can be any group of alphabetic, numeric,
or special characters up to twenty (20) characters in length. Use a logical code to identify the value. For
example, 2 L-90 might represent a two-inch ninety-degree elbow.

Sizing Group - This item is not used by StationManager.

Sizing Type - This is not used by StationManager.

Specification - Specifies the name of the product specification file (if any) for the associated fitting. The file

must be located in the appropriate directory and must be saved in a Portable Document Format (PDF) file.
The name of the file can be up to forty (40) alphanumeric characters.

Notes & Considerations

® The Fitting Type can be used to model any device for which an equivalent length can be calculated.
Fittings are modeled as a segment of pipe using the equivalent length item for the pipe’s length and the
equivalent diameter item for the pipe’s diameter.

® The equivalent length can be determined from manufacturer tables, from a piping design handbook, or
calculated if the flow-pressure relationship is known. Most equivalent lengths are expressed in terms of the
length of the standard wall thickness pipe. It is important to know and correctly set the equivalent diameter
that is used to calculate the equivalent length.

® The Efficiency item from the Property Table is not used in calculation routines. The efficiency values
entered in the station run and stage data are used.

® The StationManager 2.1 Property Tables file format is compatible with the Property Table format of our
GASCalc 5.0 application. The tables can be shared between the two applications if desired.
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Pipe Tab
=l Property Table Report - Ci\cfiles\sm20\properties\pipe.ppf @
= i VES I VES == AllZ
| HE Q| BES =M %, \nu+L}—[E|§zlAl & EYEr
Pipe T Regulator T Relief Yalve T Fitting
Rec # | Display |Size!T_l,|pe Code |Materia| |N|:|mina| Size| Usze When Sizing |Sizing Group |I]ulside Diarr|\l."a:
1 Yes 1/2P-57 CTS Plastic - MDPE 122 Yes Group-1 0.625 e
2 Yes | 3/4P-59.8 Plastic - MDPE 3/4 Yes Group-1 0.875
3 Yes | 1P-511.5CTS Plastic - MDPE 1 Yes Group-1 1.125
4 Yes |1/2P-59.3 Plastic - MDPE 172 Yes Group-1 0.840
L Yes |3/P-511 Plastic - MDPE 3/4 Yes Group-1 1.050
b Yes 1P-511 Plastic - MDPE 1 Yes Group-1 1.315 =
4] | v
LClose ‘

Data Items

Description - Specifies a brief description of the associated pipe. The description can contain up to eighty
(80) alphanumeric characters.

Display - Specifies whether the associated pipe record is displayed in the data lists used by the various
StationManager data and report screens. Only items where the value of the Display item is set to “Yes” will

be displayed in the data lists.

Efficiency - Specifies the efficiency value to be used with the associated pipe. See the following Notes &
Considerations section for additional information on the use of efficiency in the report.

Material - Specifies the material type or group that the pipe is associated with.

Nominal Size - Specifies the nominal size, usually the nominal outside diameter, for the associated pipe.
Outside Diameter - Specifies the value of the outside diameter of the associated pipe. If manufacturing
tolerances are available, adjust the outside diameter to reflect the smallest possible diameter, as this will

result in a conservative inside diameter value.

Reference - Specifies the source for the entered information for the associated pipe. The reference can
contain up to eighty (80) alphanumeric characters.

Roughness - Specifies the value of the inside wall roughness to be used for the associated pipe.
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Size/Type Code - Specifies the current pipe’s unique Size/Type Code. This item is used to relate the Pipe
Property Table to the Station Database. The Size/Type Code can be any group of alphabetic, numeric, or
special characters up to twenty (20) characters in length. Use a logical code to identify the value. For
example, “2P” might represent a two-inch plastic pipe.

Sizing Group - This item is not used by StationManager.

SMYS - Specifies the Specified Minimum Yield Strength value to be used with the associated pipe. The
SMYS value is used for reporting purposes only.

Specification - Specifies the name of the product specification file (if any) for the associated pipe. The file
must be located in the appropriate directory and must be saved in a Portable Document Format (PDF) file.

The name of the file can be up to forty (40) alphanumeric characters.

Stress Units - Specifies the value of the dimensional unit associated with the SMYS (Specified Minimum
Yield Strength) value.

T, D, R Units - Specifies the value of the dimensional units associated with the wall thickness (T), the
outside and inside diameters (D), and the roughness values.

Use When Sizing - This item is not used by StationManager.
Wall Thickness - Specifies the value of the wall thickness of the associated pipe. [f manufacturing tolerances

are available, the pipe wall thickness should be adjusted so that it reflects the greatest possible thickness, as
this results in a conservative inside diameter value.

Calculated Items

Inside Diameter - Displays the calculated value of the inside diameter of the associated pipe. The value is
calculated using the wall thickness and outside diameter values. The User cannot directly modify this item.
To change the value of the inside diameter, modify the Wall Thickness or Outside Diameter values.

Notes & Considerations

® The Efficiency item from the Property Table is not used in calculation routines. The efficiency values
entered in the station run and stage data are used.

® [f manufacturing tolerances are available, the minimum outside diameter and maximum wall thickness
values can be used in the Pipe Property Table to reflect the smallest possible diameter. This value will result
in a conservative inside diameter value.
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® The StationManager 2.1 Property Tables file format is compatible with the Property Table format of our
GASCalc 5.0 application. The tables can be shared between the two applications if desired.
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Regulator Tab
=l Property Table Report - Ci\cfiles\sm20\properties\regulator.rpf @
= - s | == allz @1'
Q@@|EH " \'nn+l"_[§ LE||ZlAl IE]B
Pipe I Regulator | Relief Valve Il Fitting
Rec # |Dizplay |Size!T}lpe Code |Manul‘acturer |Mode| |Body Size |Dlifice Size |Dutlet:
1 Yes AM 2003M 1/4 American Meter 2003M 2 1/4 2 067
2 fes AM 2003M 378 American Meter 2003M 2 3/8 2.067
3 es AM 2003M 172 American Meter 2003M 2 112 2.067
4 |Yes AM 2003M 5/8 American Meter 2003 2 5/8 2.067
5 |Yes AM 2003M 3/4 American Meter 2003 2 3/4 2.067
[ Yes AM 2003M 778 American Meter 2003M 2 ire 2067
<] | >
Llose |
Data Items

Body Size - Specifies the nominal body size (pipe connection size) of the associated regulator.

Description - Specifies a brief description of the associated regulator. The description can contain up to
eighty (80) alphanumeric characters.

Display - Specifies whether the associated regulator is displayed in the data lists used by the various
StationManager data and report screens. Only items where the value of the Display item is set to “Yes” will
be displayed in the data lists.

Equation (Control) - Specifies the flow equation that will be used to describe the regulator’s pressure-flow
characteristics under normal control conditions. See the following Notes & Considerations section for a
complete description of this item.

Equation (Failed) - Specifies the flow equation that will be used to describe the regulator’s pressure-flow
characteristics under failed conditions. See the following Notes & Considerations section for a complete
description of this item.

Failed=Control - This item is not used by StationManager.

Manufacturer - Specifies the name of the manufacturer of the associated regulator.

Maximum Control Pressure - Specifies the maximum control (set) pressure of the associated regulator.

,Eé’
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Maximum Inlet Pressure - Specifies the maximum inlet pressure rating of the associated regulator.
Minimum Control Pressure - Specifies the minimum control (set) pressure of the associated regulator.

Minimum Differential - Specifies the minimum differential (to achieve full opening) of the associated
regulator.

Model - Specifies the model name of the associated regulator.

Orifice Size - Specifies the size of the valve or orifice of the associated regulator.

Outlet Diameter - Specifies the inside diameter of the outlet connection of the regulator body.
Parameter 1 (Control) - Specifies the appropriate parameter’s value under normal controlling conditions.
The definition of this item varies depending on the selected equation. See the following Notes &
Considerations section for a complete description of this item.

Parameter 1 (Failed) - Specifies the appropriate parameter’s value under failed conditions. The definition
of this item varies depending on the selected equation. See the following Notes & Considerations section for
a complete description of this item.

Parameter 2 (Control) - This item is not used by StationManager.

Parameter 2 (Failed) - This item is not used by StationManager.

Pressure Units - Specifies the dimensional units for the various pressure values.

Reference - Specifies the source for the entered information for the associated regulator. The reference can
contain up to eighty (80) alphanumeric characters.

Size/Type Code - Specifies the current regulator’s unique Size/Type Code. This item is used to relate the
Regulator Property Table to the Station Database. The Size/Type Code can be any group of alphabetic,
numeric, or special characters up to twenty (20) characters in length. Use a logical code to identify the value.
For example, FC 1098EGR 1 could be used to represent a Fisher Controls 1" Model 1098EGR Regulator.

Size Units - Specifies the dimensional units for the various size values.

Sizing Table (Control) - Specifies the name of a special format file that contains controlling capacity data
related to the associated regulator. The file must be located in the Property Tables directory specified in the
Path settings. The name of the file can be up to forty (40) alphanumeric characters. The file format is
described in the following Notes & Consideration section. This item is only used when the Equation
(Control) item is set to “Table.”
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Sizing Table (Failed) - Specifies the name of a special format file that contains failed capacity data related
to the associated regulator. The file must be located in the Property Tables directory specified in the Path
settings. The name of the file can be up to forty (40) alphanumeric characters. The file format is described
in the following Notes & Consideration section. This item is only used when the Equation (Failed) item is
set to “Table.”

Specification - Specifies the name of the product specification file (if any) for the associated regulator. The
file must be located in the appropriate directory and must be saved in a Portable Document Format (PDF)
file. The name of the file can be up to forty (40) alphanumeric characters.

Valve Factor (Control) - Specifies the published “regulating” valve coefficient of the regulator. See the
following Notes & Considerations section for a complete description of this item.

Wide-Open Factor (Failed) - Specifies the published “wide-open” valve coefficient of the regulator. For

some manufacturers, this value is the same as the “regulating” valve coefficient. See the following Notes &
Considerations section for a complete description of this item.

Notes & Considerations

® The following table summarizes the available regulator equations and their general application by
manufacturer:

Flow Equation Manufacturer

American American Meter - Non-rubber element models

American AFV American - Axial Flow Valve

Equimeter Same as Rockwell

Fisher Fisher Controls

Grove 80 Grove - Model 80 Flexflo

Grove 900 Grove - Model 900 & 83

ISA-S75.01 American Meter - Radial Flow Valve
Other regulators and control valves meeting the Instrument Society of
America - Standard S75.01

Mooney Mooney Controls

Pietro Fiorentini Pietro Fiorentini

,55 B3PELLC Engineering & Software Services
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Flow Equation Manufacturer

Rockwell Equimeter
Invensys
Sensus
Sprague
Rockwell

Table None. Use this “equation” to indicate the capacity data is contained in a
regulator capacity table. This equation type is not currently supported by
StationManager. It is included to maintain compatibility with our other
software applications.

Universal None. Use this equation with older style devices using the original
definition for the “universal gas sizing” equation to define their pressure-
flow relationship.

® The regulator flow equations are described in the Appendix section.

® The definition of the Parameter 1 (Control/Failed) item varies depending on the selected flow equation.
The following table summarizes the definition of this item based on the various flow equations:

Flow Equation Parameter 1 Definition
American Not Used

American AFV Xt - Critical Flow Factor
Equimeter Not Used

Fisher C1 - Valve Recovery Factor
Grove 80 Xt - Critical Flow Factor
Grove 900 Xt - Critical Flow Factor
ISA-S75.01 Xt - Critical Flow Factor
Mooney C1 - Valve Recovery Factor

Pietro Fiorentini

C1 - Valve Recovery Coefficient

Rockwell Not Used
Table Not Used
Universal C1 - Valve Recovery Coefficient

=
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® The definition of the Valve Factor (Control) item varies depending on the make, model, and equation
associated with the regulator. The following table summarizes the definition of the value based on each

specific flow equation:

® The value of the Wide-Open Factor (Failed) valve coefficient item varies depending on the make, model,
and equation associated with the regulator. The following table summarizes the definition of the value based

Flow Equation Applicable Coefficient

American C - Orifice Constant

American AFV Cv Factor

Equimeter K Factor - Regulator Constant

Fisher Cg (Regulating) - Gas Sizing Coefficient
Grove 80 C1 - Critical Flow Factor

Grove 900 Cv - Valve Capacity Factor

ISA-S75.01 Cv - Valve Flow Coefficient

Mooney Cg (Regulating) - Gas Sizing Coefficient

Pietro Fiorentini

Cg - Gas Sizing Coefficient

Rockwell K Factor - Regulator Constant
Table Not Used
Universal Cv - Liquid Sizing Coefficient

on each specific flow equation:

Flow Equation Applicable Coefficient

American C - Orifice Constant

American AFV Cv Factor

Equimeter K Factor - Regulator Constant

Fisher Cg (Wide-Open) - Gas Sizing Coefficient
Grove 80 Cp - Valve Wide Open Capacity Coefficient
Grove 900 Cv - Valve Capacity Factor

ISA-S75.01 Cv - Valve Flow Coefficient

B3PELLC
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Flow Equation Applicable Coefficient

Mooney Cg (Wide-Open) - Gas Sizing Coefficient

Pietro Fiorentini

Rockwell K Factor - Regulator Constant
Table Not Used
Universal

Note... . . . . .
When a separate wide-open valve factor is not published, it is sometimes customary to set the

wide-open factor equal to 1.10 times the controlling factor.

® The values of the regulator factors and parameters must be based on an equation whose dimensional units
are consistent with the following:

Equation Parameter Dimensional Units
Volumetric Flow Rate Cth

Pressure or Pressure Drop Psia

Temperature Rankine

® The StationManager 2.1 Property Tables file format is compatible with the Property Table format of our
GASCalc application. The tables can be shared between the two applications if desired.
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Relief Valve Tab
=l Property Table Report - Cih\cfiles\sm20\propertiesrelief.|pf @
= i VES I VES == AllZ
| HE Q| BES =M %, \m+"}—[§|§zlﬂ & EYEr
Pipe T Regulator T Relief ¥alve T Fitting

Rec # | Display |Size!T_l,|pe Code |Manufacluml |Model |B|:|d_l,l Size |Diameter, In |Diar|1:
1 Yes AG 81 374 -8 Anderson-Greenwood 81 374 0.825 0.82—
2 Yes AG 81 3/4x1 4 Anderzon-Greenwood a1 3/ 0.825 o0.82
3 Yes AG 81 37441 -6 Anderson-Greenwood a1 3/4 0.825 0.82!
4 Yes AG 811 -4 Anderson-Greenwood 81 1 1.049 1.04:
1 Yes AG811-6 Anderson-Greenwood 81 1 1.049 1.04
b Yes AGS11-8 Anderson-Greenwood a1 1 1.049 1.04

4] | v

Close ‘

Data Items

Body Size - Specifies nominal body size (pipe connection size) of the associated relief valve.

Description - Specifies a brief description of the associated relief valve. The description can contain up to
eighty (80) alphanumeric characters.

Diameter, Inlet - Specifies the inside diameter of the inlet side of the relief valve body.

Diameter, Outlet - Specifies the inside diameter of the outlet side of the relief valve body.

Display - Specifies whether the associated relief valve is displayed in the data lists used by the various
StationManager data and report screens. Only items where the value of the Display item is set to “Yes” will

be displayed in the data lists.

Equation - Specifies the flow equation that will be used to describe the relief valve’s pressure-flow
characteristics. See the following Notes & Considerations section for a complete description of this item.

Manufacturer - Specifies the name of the manufacturer of the associated relief valve.
Maximum Inlet Pressure - Specifies the maximum inlet pressure rating of the associated relief valve.

Maximum Set Pressure - Specifies the maximum set pressure rating of the associated relief valve.
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Minimum Differential - Specifies the minimum differential (to achieve full opening) of the associated relief
valve.

Minimum Set Pressure - Specifies the minimum set pressure rating of the associated relief valve.
Model - Specifies the model name of the associated relief valve.

Orifice Size - Specifies the size of the valve or orifice of the associated relief valve.

Orifice Area - Specifies the cross-sectional area of the valve or orifice of the associated relief valve.

Parameter 1 - The definition of this item varies depending on the selected equation. See the following Notes
& Considerations section for a complete description of this item.

Parameter 2 - This item is not used by StationManager.
Pressure Units - Specifies the dimensional units for the various pressure values.

Reference - Specifies the source for the entered information for the associated relief valve. The reference
can contain up to eighty (80) alphanumeric characters.

Reset Differential - Specifies the reset differential of the associated relief valve. See the following Notes
& Considerations section for a complete description of this item.

Size/Area Units - Specifies the dimensional units for the size and area values. Although the actual
dimensional units for the size (diameter) and area values are different, the dimensional units for both are
taken from the assigned value. For example, if the value is set to “Inches,” the “Inches” unit will be used for
the size item, and the “Inches sq” unit will be used for the area item.

Size/Type Code - Specifies the current relief valve’s unique Size/Type Code. This item is used to relate the
Relief Valve table to the Station Database. The Size/Type Code can be any group of alphabetic, numeric,
or special characters up to twenty (20) characters in length. Use a logical code to identify the value. For
example, RW 250S 4 4 could be used to represent a Rockwell Model 2508 4-inch body 4-inch orifice relief
valve.

Specification - Specifies the name of the product specification file (if any) for the associated regulator. The
file must be located in the appropriate directory must be saved in a Portable Document Format (PDF) file.
The name of the file can be up to forty (40) alphanumeric characters.

Valve Factor - Specifies the published valve coefficient for the relief valve. The definition of this item varies
depending on the selected flow equation. See the following Notes & Considerations section for a complete
description of this item.

2
,5 B3PE LLC Engineering & Software Services
Revision - 002, Copyright 2024, All Rights Reserved. 31




StationManager™ 2.1 Property Tables

Table Of Contents

Notes & Considerations

® The following table summarizes the available relief valve flow equations and their general application:

Flow Equation Manufacturer

American AFV American Meter - Axial Flow Valve

API 520 Anderson-Greenwood
Mercer
Taylor Tool
Other relief valves meeting the American Petroleum Institute
Specification 520

ASME BPV Relief valves meeting the American Society Of Engineers Boiler &
Pressure Vessel specification

Equimeter Same as Rockwell

Fisher Fisher Controls

ISA-S75.01 American Meter - Radial Flow Valve

Other relief valves and control valves meeting the Instrument Society of
America - Standard S75.01

Mooney Mooney Controls
Rockwell Equimeter
Invensys
Sensus
Rockwell

® The definition of the Parameter I item varies depending on the selected flow equation. The following table
summarizes the definition of this item based on the various flow equations:

Flow Equation Parameter 1 Definition
American AFV Xt - Critical Flow Factor
API 520 Kb - Capacity Correction Factor
ASME BPV Kb - Capacity Correction Factor
Equimeter Not Used
Fisher C1 - Valve Recovery Factor
=
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Flow Equation Parameter 1 Definition
ISA-S75.01 Xt - Critical Flow Factor
Mooney C1 - Valve Recovery Factor
Rockwell Not Used

® The relief valve flow equations are described in the Appendix section.

® The definition of the Valve Factor item varies depending on the selected flow equation. The following
table summarizes the applicable values based on each specific flow equation:

Flow Equation Applicable Coefficient
American AFV Cv Factor

API 520 Not Used

ASME BPV Kd - Discharge Coefficient
Equimeter K Factor - Regulator Constant
Fisher Cg - Capacity Sizing Factor
ISA-S75.01 Cv - Valve Flow Coefficient
Mooney Cg - Capacity Sizing Factor
Rockwell K Factor - Regulator Constant

® The values of the relief valve factors and parameters must be based on an equation whose dimensional
units are consistent with the following:

Equation Parameter Dimensional Units
Volumetric Flow Rate Cth

Pressure or Pressure Drop Psia

Temperature Rankine

® The StationManager 2.1 Property Tables file format is compatible with the Property Table format of our
GASCalc application. The tables can be shared between the two applications if desired.
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Import & Merge Routines

This section provides descriptions and requirements for importing and merging data from the various
supported file formats. The additional data screens used to further define the import and merge specifications
will be described later in this section.

StationManager provides translation routines for importing and merging associated with several types of file
formats. Using the Import/Merge routine, data contained in database files and spreadsheet files may be used
with StationManager. The following table describes the Import and Merge File Types supported by
StationManager.

File Type Supports

Import Merge

dBase 3 Database X

dBase 4 Database

GASCalc 5.0 - Monitor Regulator Station

GASCalc 5.0 - Regulator/Relief Valve Station

GASCalc 5.0 - Regulator/Relief 2 Stage Station

GasValve Database

Microsoft Access Database

o R A A

Microsoft Excel 8.0 & 97 Workbook

When importing data files, ensure that the data values and dimensional units contained in the Source file are
compatible with the values supported by StationManager. When importing or merging a file, the file to be
imported is referred to as the “Source” file, and the StationManager database being imported into is referred
to as the “Target” file. When exporting a file, the StationManager database to be exported is referred to as
the “Source” file, and the file being created is referred to as the “Target” file.

The import (source) file does not need to be completely inclusive. Items not included in the file will be set
to applicable default values and may be revised after the import is complete using the Mass Update or data
edit routines. The default values can be set before importing a file using the Set Defaults Values item from
the Utilities menu.

The Import and Merge routines are accessed through the Import/Merge item of the Utilities menu. When
selected, the Import/Merge screen is displayed. The features associated with the screen are described as
follows.

2
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Import/Merge...
File Type... -

Access Database
dBasze 3 Database
dBase 4 Database
E xcel Workbook

GASCalc 5.0 Regulator/Relief ¥alve Station
GASCalc 5.0 Regulator/Relief 2 Stage Station

Import/Merge Log. ..

GASCalc 5.0 Monitor Regulator Station

Import/Merge Idle...

pe: GASCalc 5.0 Monitor Regulator Station

Proceszing Record: |

Merge | Import

Displayed Items

Import/Merge Log - Displays the activity (status) of the Import/Merge routine.

Processing Record - Displays the number of the record or line currently being processed or the number of

records that were processed when completed.

Data Items

File Type - Displays the type of file to be processed.

Command Buttons

Cancel/Close - The function and caption of this command button vary depending on the current activity and
status of the translation routine. When “Close” is displayed, it closes the Import/Merge screen. When

“Cancel” is displayed, it closes the translation activity.
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Import - Starts the Import routine. When clicked, the File Selection is displayed.

Merge - Starts the Merge routine. When clicked, the File Selection is displayed.

Notes & Considerations

® The features associated with the File Selection screen are described in the Data Screens section.

® Sclecting certain file types may cause an additional option or data screen to be displayed. These screens
allow additional translation specifications to be defined. These screens are discussed later in this section.

® The Merge routine allows a file to be merged with the currently open StationManager file. For certain file
formats, when using the Merge routine, the import (source) file is compared to the StationManager (target)
file. Where matching records are found, only the defined data fields are updated. If a matching record is not
found in the target file, a new record is added to the StationManager file.

® The Import routine creates a new set of StationManager database files. If existing database files are
present, they will be sent to the Windows Recycle Bin before the Import routine is executed.

® When importing data to create a new StationManager database. Default, zero (0), or empty values are
assigned to data items that are not assigned in the import specification. Data items that are assigned in the
import specification are assigned the associated values found in the source file.

® Certain file types are only supported by certain import and merge processes. When a file type is selected
from the File Type list, the command buttons will be enabled or disabled depending on what process is
supported for that file type.

® Files that are opened by another application, like a database or spreadsheet application, cannot be
processed by the Import or Export routines until they are closed by the outside application.
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When importing certain format files, StationManager requires the User to assign data fields found in the
Source database or file to data items in the Target (StationManager) database. The Import Specifications
screen is used to make the assignments. The features associated with the screen are described as follows.

=]

Import Specification...
Data Table Name: |Authors
Data Field Assignments...
Data Item... Aszzigned Databasze Field. ..
District Site_ID_NO
City/Town
State
Legal Description
Station ldentification
Area/Deszcription STATE
Location
Dperating Status
Capacity - Maximum Required
Capacity - Minimum Required
Clear Specification | Print
Cancel | LContinue.__

Data Items

Data Table Name - Specifies which table or worksheet to use for the Source data. Some databases and data
files contain multiple data tables or worksheets.

Data Field Assignments -

Assigned Database Field - Specifies the Source data fields assigned to the associated Target data

item.

Data Item - Specifies the StationManager data items.

Command Buttons

Cancel - Closes the screen without performing the routine.
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Clear Assignments - Clears all of the data items and field assignments.
Continue - Proceeds with the Import routine.

Print - Displays the Print Settings screen to print the data items and field assignments.

Notes & Considerations

® The import files may contain data not necessarily related to the station configuration. Not all data items
or data fields are required to be assigned.

® When using the Merge routine, the specified link item or items must be assigned to an appropriate data
field.

® The item and field name assignments are saved when the specification screen is closed. The next time the
screen is displayed, the previous assignments are displayed. Use the Clear Specifications command button
to clear the previous assignments.
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Import Access Databases

A database saved in Microsoft Access format (.mdb) may be imported to create a StationManager database.
When importing a file in this format, StationManager requires the User to assign data fields found in the
Source (Access) database to data items in the Target (StationManager) database. The Import Specifications
screen is used to make the assignments. See the Import Specifications topic in the Import & Merge Routines
section for additional information on making the required assignments.

StationManager expects the Source file to be in Microsoft Access 97 format. Other version Access files and
files created by other compatible applications may also be acceptable.
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Import dBase Format Files

When importing a dBase format file, StationManager requires the User to assign data fields found in the
Source (dBase) database to data items in the Target (StationManager) database. The Import Specifications
screen is used to make the assignments. See the Import Specifications topic in the Import & Merge Routines
section for additional information on making the required assignments.

Depending on the selected File Type, StationManager expects the Source file to be a dBase I11 (3.0), II1(3.0)
Plus, or IV (4.0) format; however, other version dBase files and files created by other dBase compatible
applications may also be acceptable.
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Import GASCalc Calculation Files

Certain types of GASCalc calculation files can be imported or merged as “runs and stations” into a
StationManager database. The GASCalc file version must match the selected “file type.” Once the
appropriate Source and Target files are selected, no additional specification or assignment is required to
import the calculation files.
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Import A GasValve Database

GasValve is a dBase application that was used to create station databases similar to StationManager. The
application was originally developed and marketed by People’s Natural Gas of Council Bluffs, lowa. It was
later supported by ENERGROUP an affiliate of People’s Natural Gas. It was a popular application, and many
pipeline and utility companies created databases using the application. ENERGROUP discontinued business
operations around 1991, and the GasValve program has not been commercially supported since that time.

Most GasValve databases can be imported to create a StationManager database. Because different versions
of the GasValve application existed over time, and not all permutations are known, some version files may
have issues during the import process.

A GasValve database consists of up to eight dBase files, which are identified by special names. The files are
linked using various key fields contained in the data files. At a minimum, the following files must exist for
the Import routine to be successful.

header.dbf
piping.dbf
reg_info.dbf
rel_info.dbf

To import a GasValve database, select the Import GasValve File item from the Utilities menu. A File
Selection screen is displayed. Select the appropriate Source and Target locations, enter the desired
StationManager database name, and then click the Continue command button. A message will be displayed

when the import process is complete. Click the OK command button to clear the message.

The File Selection screen for the Gas Valve import is described earlier in this section.

Default Values

The following values and dimensional units are assumed to apply to the data contained in the GasValve
database.

Item Default/Assumed Value
Base Pressure 14.73 Psia
Base Temperature 60 Fahrenheit
Viscosity 0.000007 Lbm/Ft-Sec
Specific Heat Ratio 1.3
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Item Default/Assumed Value
Pipe Flow Efficiency 100 Percent
Pipe Flow Equation IGT - Improved
Flow Units Mcth
Pressure Units Psig
Length Units Feet
Diameter Units Inches
Temperature Units Fahrenheit

Known Issues

Some issues that have been discovered when importing a GasValve database include:

® Pipe sizes in GasValve are stored as an actual inside diameter value. After being imported into
StationManager, they need to be converted to a pipe Size/Type Code. This can be done using the Mass
Update routine.

® GasValve did not use a Size/Type Code to specify assigned regulators and relief valves. When processing
the file, the Import routine derives a Size/Type Code by combining values from several data fields. Generally,
the derived Size/Type Codes do not correspond to the existing Size/Type Codes in StationManager. Once
imported, the derived Size/Type Codes can be added to the StationManager Property Tables or the Mass
Update routine can be used to change derived Size/Type Codes to StationManager Size/Type Codes, or the
Size/Type Codes in the StationManager Property Tables can be changed to match the derived/imported
Size/Type Codes.

® Often similar but different Size/Type Codes are derived during the import process, all referring to the same
make, model, and size of the device. It is best to manually correct or use the Mass Update routine to change
the Size/Type Codes to a consistent value.

® In addition to pipe lengths, GasValve stored equivalent diameter and length values for various piping
segments. When encountered, the values are added as an additional component to the appropriate piping
component list.

® GasValve did not consistently maintain information on the intermediate piping. It appears that intermediate
piping may have only been stored or required for stations with relief valves assigned to them. When
intermediate piping values are not available, default values are assigned in StationManager.
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® GasValve was apparently lenient in the assignment of piping data. It appears that various pipe segment data
could be unassigned and that the database and calculations were still functional. Depending on preference
settings in StationManager, it may require that all of its hydraulic data items be assigned a value. In cases
where associated data values are not assigned in GasValve, the Import routine will assign default values as
previously defined in StationManager. The Allow Empty Components List in the preference settings can be
selected to allow empty components lists; this is sometimes useful when dealing with an imported GasValve
database.

® Several versions of GasValve were produced. In general, StationManager supports all of the data fields
that were included in the last version of GasValve. Some data items included in StationManager were not
included in GasValve. For example, the intermediate piping item found in StationManager was not included
in the GasValve database. Values for unsupported items are either set to default values, left blank or empty,
or the Import routine attempts to “derive” a value for the item based on other information found in the
GasValve database.

® [t was common practice to try to “trick” GasValve into handling configurations and makes and models of
regulators and relief valves that it not normally handle. These tricks may or may not be translated by
StationManager correctly. Upon completion of the import process, these special cases may require particular
revision in StationManager.

® Passive monitor stations contained in GasValve are assumed to be upstream monitor type configurations
and are imported as such, except where the downstream set pressure is greater than the upstream set pressure;
in those cases, the station is assumed to be a downstream monitor configuration. If this is not the case, the
stage style for the affected stations can be changed in StationManager after the import is complete.

® GasValve allowed more than two runs in a station. When three runs are encountered, the import process
assigns two runs to one station, then creates an additional station and assigns the third and fourth runs to it.

Up to four runs are handled by the import routine.

® [f the “rating” item for a regulator or relief valve is assigned to a non-number value in the GasValve
database, the value is set to 0 during the import.

® The default dimensional units should be set to appropriate values before performing the import.
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GasValve Data Field Name StationManager Data Notes
Item

header.dbf

DISTRICT District Identification Combined with other fields to create a
unique identification number to link
with the other data files.

TOWN City/Town Combined with other fields to create a
unique identification number to link
with the other data files.

DRS NO Station Identification Combined with other fields to create a
unique identification number to link
with the other data files.

AREA Station Description

STATE State

LOCATION Location

TYPE Not directly assigned. Used | SR = Single stage with relief valve

to determine station style, | DR = Two stage with relief valve

device types, and number of | WM = Single stage upstream

stages. working monitor
PM = Single stage upstream monitor
Other codes = Single stage upstream
monitor

NO_RUNS Number of Runs

TBS_CAP Maximum Meter Capacity

MAX FLOW Maximum Required

Capacity
ATM_PRESS Indirectly assigned to the | The value is used to calculate a
Elevation item corresponding elevation value. The
resulting value is assigned to the
Elevation item.
GAS TEMP Flowing Temperature
Z
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GasValve Data Field Name StationManager Data Notes

Item
SP_ GRAV Specific Gravity
MAOP_IN Upstream MAOP
MAOP_INT Intermediate MAOP
MAOP_OUT Downstream MAOP
PR_MANU Pressure Recorder Concatenated with the PR_TYPE to
Make/Type create the assigned value.

PR _TYPE Pressure Recorder Concatenated with the PR_MANU to
Make/Type create the assigned value.

PR _RANGE Indirectly assigned to the [ The value is parsed and assigned to the
Pressure Recorder Low and | appropriate data items.
High Range items

PERSONI1 Designed By

HDATE1 Design Date

PERSON2 Entered/Revised By

HDATE2 Entry/Revision Date

REMARKS Comments/Notes In General Station Data

piping.dbf

DISTRICT Not assigned Combined with other fields to create a
unique identification number to link
with the other data files.

TOWN Not assigned Combined with other fields to create a
unique identification number to link
with the other data files.

DRS NO Not assigned Combined with other fields to create a
unique identification number to link
with the other data files.

LENGTHI1 Upstream component Combined with associated diameter to

piping length create an individual component.
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GasValve Data Field Name StationManager Data Notes
Item

DIAMETERI1 Upstream component Combined with associated length to
piping diameter create an individual component.

LENGTH?2 Upstream component Combined with associated diameter to
piping length create an individual component.

DIAMETER2 Upstream component Combined with associated length to
piping diameter create an individual component.

LENGTH3 Upstream component Combined with associated diameter to
piping length create an individual component.

DIAMETER3 Upstream component Combined with associated length to
piping diameter create an individual component.

LENGTH4 Upstream component Combined with associated diameter to
piping length create an individual component.

DIAMETER4 Upstream component Combined with associated length to
piping diameter create an individual component.

LENGTHS Upstream component Combined with associated diameter to
piping length create an individual component.

DIAMETERS Upstream component Combined with associated length to
piping diameter create an individual component.

IN_EQ LE Upstream component Combined with associated diameter to
piping length create an individual component.

OUT EQ LE Downstream component Combined with associated diameter to
piping length create an individual component.

IN_EQ DI Upstream component Combined with associated length to
piping diameter create an individual component.

OUT_EQ DI Downstream component Combined with associated length to
piping diameter create an individual component.

IN_VEL Not assigned

OUT_VEL Not assigned

IN_PDROP Not assigned

OUT_PDROP Not assigned
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GasValve Data Field Name StationManager Data Notes

Item

T EQ LEN Not assigned

T EQ DIA Not assigned

NOTES Comments/Notes Added to the General Station
Comments/Notes

reg_info.dbf

DISTRICT Not assigned Combined with other fields to create a
unique identification number to link
with the other data files.

TOWN Not assigned Combined with other fields to create a
unique identification number to link
with the other data files.

DRS NO Not assigned Combined with other fields to create a
unique identification number to link
with the other data files.

RUN_NO Not assigned Used to determine which run to assign
the data to.

REG NO Not assigned Used to determine which run to assign
the data to.

REG_MAKE Not directly assigned Combine with other fields to create a
Size/Type Code for the device.

REG TYPE Not directly assigned Combine with other fields to create a
Size/Type Code for the device.

REG BODY Not directly assigned Combine with other fields to create a
Size/Type Code for the device.

REG_ORIF Not directly assigned Combine with other fields to create a
Size/Type Code for the device.

REG_CONN Device Equipment

Connection
REG RATING Device Pressure Rating
RG_MAXPR Maximum Inlet Pressure
Z
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Item
RG_MINPR Minimum Inlet Pressure
RG_SETPR Device Set Pressure
RG_MAXCAP Not assigned
RG_MINCAP Not assigned
RG _FLDCAP Not assigned
RG _SYSCAP Not assigned
RG _RGBU Not assigned
RG_PLTSPR Primary Pilot Spring
Number
RG _PLTCLR Primary Pilot Spring Color
RG _PLTRNG Primary Pilot Spring The value is parsed and assigned to the
Minimum and Maximum appropriate data items.
Pressure Ratings
RG_MNBSPR Device Spring Number
RG_MNBCLR Device Spring Color
RG_MNBRNG Device Spring Minimum The value is parsed and assigned to the
and Maximum Pressure appropriate data items.
Ratings
RG_PSMDL Primary Pilot Model
RG PSSET Set Pressure Only assigned if the value of
RG_SETPR equal 0
RG_MPMDL Secondary Pilot Model
RG_MPSET Monitor Set Pressure
RG_MPSPR Secondary Pilot Spring
Number
RG_MPCLR Secondary Pilot Spring
Color
Z
B |B3PELLC Engineering & Software Services

252

Revision - 002, Copyright 2024, All Rights Reserved.



StationManager™ 2.1

Import & Merge Routines

Table Of Contents
GasValve Data Field Name StationManager Data Notes
Item

RG_MPRNG Secondary Pilot Spring The value is parsed and assigned to the
Minimum and Maximum appropriate data items.
Pressure Ratings

RG_NOTES Comments/Notes Added to the General Station
Comments/Notes

rel data.dbf

DISTRICT Not assigned Combined with other fields to create a
unique identification number to link
with the other data files.

TOWN Not assigned Combined with other fields to create a
unique identification number to link
with the other data files.

DRS NO Not assigned Combined with other fields to create a
unique identification number to link
with the other data files.

RUN_NO Not assigned Used to determine which run to assign
the data to.

REL NO Not assigned Used to determine which stage to
assign the data to.

REL MAKE Not directly assigned Combine with other fields to create a
Size/Type Code for the device.

REL TYPE Not directly assigned Combine with other fields to create a
Size/Type Code for the device.

REL BODY Not directly assigned Combine with other fields to create a
Size/Type Code for the device.

REL ORIF Not directly assigned Combine with other fields to create a
Size/Type Code for the device.

REL CONN Downstream Device

Connection Type
REL _RATNG Downstream Device
Pressure Rating
Z
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Item
REL _LOC Not Assigned
RL _SETPR Downstream Device Set
Pressure
RL RBUPR Not assigned
RL RBUCAP Not assigned
RL PBUPR Not assigned
RL TBUPR Not assigned
RL PBU2R Not assigned
RL TBU2R Not assigned
RL MAXPR Not assigned
RL VLVIN Not assigned
RL VLVOUT Not assigned
RL VLVCAP Not assigned
RL SYSCAP Not assigned
RL SYSCP2R Not assigned
RL RGBU Not assigned
RL _SBCAP2R Not assigned
RL PROPR Not assigned
RL PROP2RL Not assigned
RL _SUBCAP Not assigned
RL REASNI1 Not assigned
RL REASN2 Not assigned
RL PLTSPR Downstream Primary Pilot
Spring Number
RL PLTCLR Downstream Primary Pilot
Spring Color
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GasValve Data Field Name StationManager Data Notes
Item

RL PLTRNG Downstream Primary Pilot | The value is parsed and assigned to the
Spring Minimum and | appropriate data items.
Maximum Pressure Ratings

RL MNBSPR Downstream Device Spring
Number

RL MNBCLR Downstream Device Spring
Color

RL_MNBRNG Downstream Device Spring | The value is parsed and assigned to the
Minimum and Maximum appropriate data items.
Pressure Ratings

RL _INLEN Intermediate component Combined with associated diameter to
piping length create an individual component.

RL _INDIA Intermediate component Combined with associated length to
piping diameter create an individual component.

RL OUTLEN Stack component piping Combined with associated diameter to
length create an individual component.

RL OUTDIA Stack component piping Combined with associated length to
diameter create an individual component.

RL UPLEN Upstream component Combined with associated diameter to
piping length create an individual component.

RL _UPDIA Upstream component Combined with associated length to
piping diameter create an individual component.

RL NOTES Comments/Notes Added to the General Station

Comments/Notes
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GasValve Data Field Name StationManager Data Notes

Item

inspect.dbf

DISTRICT Not assigned Combined with other fields to create a
unique identification number to link
with the other data files.

TOWN Not assigned Combined with other fields to create a
unique identification number to link
with the other data files.

DRS NO Not assigned Combined with other fields to create a
unique identification number to link
with the other data files.

INSP1A Enclosures OK

INSP2A Paint OK

INSP3A Site Protection OK

INSP4A Signs OK

INSP5A Vents OK

INSP6A Strainers OK

INSP7A Valves OK

INSP8A Locks OK

INSP9A Regulators Operated

INSP10A Regulators Lock-Up OK

INSP11A Reg Internals Inspected

INSP12A OPP Devices Operated

INSP13A OPP Devices Lock-Up OK

INSP14A OPP Internals Inspected

INSPI5A OPP Capacity Field

Verified
INSP16A Data Recorders OK
]
_Z | B3PE LLC Engineering & Software Services

256

Revision - 002, Copyright 2024, All Rights Reserved.



StationManager™ 2.1

Import & Merge Routines

Table Of Contents
GasValve Data Field Name StationManager Data Notes
Item
RGI111A Not assigned
RGI11FA Not assigned
RG121A Not assigned
RG22FA Not assigned
RLI1IA Not assigned
RLI11FA Not assigned
RLI2IA Not assigned
RLI12FA Not assigned
RG211A Not assigned
RG21FA Not assigned
RG221A Not assigned
RG22FA Not assigned
RL21IA Not assigned
RL21FA Not assigned
RL22IA Not assigned
RL22FA Not assigned
INSPNAMEA Inspected By
INSPDATEA Inspection Date
NOTEIA Inspection Notes
NOTE2A Not assigned
CAUSEI1 Not assigned
CAUSE2 Not assigned
INSPDATEB Previous Inspection Date

Note - GasValve allowed the storage of data for multiple inspection years. These values are stored in
additional data fields that are not listed. StationManager only supports the listed data fields as indicated.
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Import Excel 5.0 & 95, 8.0 & 97 Workbook Format Files

When importing this format file, StationManager requires the User to assign data fields found in the Source
(Excel) file to data items in the Target (StationManager) database. The Import Specifications screen is used
to make the assignments. See the Import Specifications topic in the Import & Merge Routines section for
additional information on making the required assignments.

StationManager expects the Source file to be in one of the listed Microsoft Excel Workbook formats. Files
created by other compatible applications may also be acceptable.

Generally, the StationManager formats apply to the following files:
Excel 5.0 & 95 - Excel “5.0” format files, or files created using Microsoft Excel 5-7, and/or Excel 95
Excel 8.0 & 97 - Excel “8.0” format files, or files created using Microsoft Excel 97 - 2002

When importing a workbook that contains more than one worksheet to the Data Table item, assign the
worksheet name that contains the desired data values.
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Export Routine

This section provides descriptions and requirements for exporting data from StationManager into a supported
file format. The additional data screens used to further define the export specifications will be described later
in this section.

StationManager provides translation routines for exporting data associated with several types of file formats.
Using the Export routines, data contained in database files and spreadsheet files may be used with
StationManager. The following table describes the Export File Types supported by StationManager.

File Type

Common Separated Value (CSV) Text File

Microsoft Excel 8.0 & 97 Workbook

The Export routine is accessed by selecting the Export item in the Utilities menu. When selected, the Export
screen is displayed. The features associated with the Export screen, along with the specific requirements
associated with each supported file type, are described in the following sections.
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Export Screen

Export...
File Type... -

Comma Separated Yalues [C5Y] File
Excel 8.0 & 97 Workbook
Excel 8.0 & 97 Workbook [Single Sheet]

™

xport Log._.

Export Idle. ..

Processing Record:

Cloze Export

Displayed Items

Export Log - Displays the activity (status) of the Export routine.

Processing Record - Displays the number of the record or line that is currently being processed or the
number of the records that were processed when completed.

Data Items

File Type - Displays the available file types that may be exported.

Command Buttons

Cancel/Close - The function and caption of this command button varies depending on the current activity
and status of the translation routine. When “Close” is displayed, it closes the Export screen. When “Cancel”
is displayed, it cancels the translation activity.
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Export - Begins the Export routine. When clicked, the File Selection screen is displayed.

Notes & Considerations

® The features associated with the File Selection screen are described in the Data Screens section.

® Sclecting certain file types may cause an additional option or data screen to be displayed. These screens
allow additional translation specifications to be defined. These screens are discussed later in this section.

® The Export routine creates a new set of files in the specified format. It does not change the format or
content of the StationManager database data files.

=
,5 B3PE LLC Engineering & Software Services
Revision - 002, Copyright 2024, All Rights Reserved. 263




StationManager™ 2.1 Export Routines

Table Of Contents

Export Specifications

When exporting certain format files, StationManager requires the User to indicate which data items to
include in the exported file. The Export Specifications screen is used to make the assignments.

Two methods are available for creating the export specification. The Quick method allows items to be
selected from an item list - the items are exported in the order shown in the list. The Ordered method allows
items to be selected and their output order to be specified by the User. The specification method associated
with the currently displayed specification data tab is used to create the exported file.

The features associated with the screen are described as follows.

Quick Selection Tab

Export Specifications..,

Quick Selection T Ordered Selection

Select Which Items To Include. .

Comphance - Downstream Device Capacity -
Compliance - Downstream Pipe MAOP
Compliance - Intermediate Pipe MAOP
Compliance - PazzfFail 5tatus
Compliance - Review Date

Comphance - Review Name

Compliance - Upstream Device Capacity
Compliance - Upstream Pipe MAOP
Equip - Dn Device - Connection

Equip - Dn Device - Diaphragm Size
Equip - Dn Device - Diaphragm Type
Equip - Dn Device - Max Body Pressure
Equip - Dn Device - Senal Humber
Equip - Dn Device - Spring Color

Equip - Dn Device - Spring Max Rating W
Clear 5pecification ‘ Select All ‘
Cancel Open | Save ‘ Print Continue. .. ‘

Data Items

Select Which Items To Include - When selected, the data items in the StationManager database are included
in the exported file.
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Ordered Selection Tab

Export Specifications...

Quick Selection T Ordered Selection

2|2}
Z 1| A
Indicate The Output Order Of The Items To Include. ..

Output Order |Dala Item.__ i‘

Compliance - Downstream Device Capacity

Comphance - Downstream Pipe MADP
Comphance - Intermediate Pipe MAOP
Comphance - Pass/Fail Status
Compliance - Review Date
Compliance - Review Mame

Compliance - Upstream Device Capacity

Comphance - Upstream Pipe MAOP -
4 3

Clear Specification | Select All |

Cancel | Open ‘ Save ‘ Print | Continue. .. |

Data Items

Data Item - Specifies the various data items found in the StationManager database.

Output Order - Specifies the output order of the associated data items. Items with no (empty) assignment
will not be included in the export file.

Icons

A Sort Ascending - Sorts the records in ascending order (A to Z or lowest to highest value) based
rd l on the Output Order values.

el Sort Descending - Sorts the records in descending order (Z to A or highest to lowest value) based
A l on the Output Order values.
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Command Buttons

Cancel - Closes the screen without proceeding with the Export routine.

Clear Specification - Clears all of the data item selections for the currently displayed data tab.
Continue - Proceeds with the Export routine.

Open - Opens a previously saved export specification.

Print - Displays the Print Settings screen to print the contents of the currently displayed specification data
tab.

Save - Saves the contents of the current export specification.

Select All - Selects all of the items in the StationManager database for inclusion in the exported file.

Notes & Considerations

® A StationManager database contains a large number of data items. Generally, not all of these items are
required or desired to be included in the exported file. To make the exported file more manageable, it is
suggested that only the minimum required or desired items be included in the exported file.

® See the individual export topics for more information about the export process and results.

® The item selections are saved when the specification screen is closed. The next time the screen is
displayed, the previous selections are displayed. Use the Clear Specification command button to clear the
previous selections.

® The values assigned in the output order item indicate the order in which the associated data item will listed
in the export file. If a new item needs to be inserted in an existing specification, assign the desired location
value (even if it is already assigned); the order values for items from that location will automatically be
renumbered.

® Gaps may exist in the output order values; for example, it is acceptable to only have values assigned like
1,2,5,6.
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Export Microsoft Excel Files

StationManager provides a routine for creating Microsoft Excel spreadsheet files from a StationManager
database.

When exporting to an Excel 5.0 or 8.0 Workbook, a single workbook (.xls extension) with multiple
worksheets will be created. The file may be opened and manipulated using any application that supports the
Excel 5.0 or 8.0 Workbook format. The content of the exported file will vary depending on which items were
selected for inclusion in the Import Specifications. The data items are grouped by general subject; for
example, general station information is grouped together, hydraulic data is grouped together, etc. If items
from more than one group are included, they will grouped by subject on individual worksheets within the
workbook.

When using the XLS export routine (icon) from the Station Data Report screen, a single sheet workbook is
created.
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Calculation Method

StationManager uses several methods to calculate the flows and pressures for a station’s piping and devices.
The method used depends on the operating conditions and station configuration. The various methods are
described on the following pages.

General Calculation Methods

Normal Conditions

In general, the calculation of flows and pressures through the station piping and devices under normal
conditions is a straightforward hydraulic pressure drop calculation. The minimum inlet pressure is used as
the supply pressure to the upstream piping. The maximum downstream flow is used as the flow rate through
the station. All devices are assumed to be operating normally - that is, it is assumed that monitor regulators
are in a wide open position, relief valves are in a closed position, and controlling regulators are in some
intermediate position and controlling at their respective set pressures.

The calculation method involves calculating the pressure drop across each piping section and device. A
calculation error will occur if the minimum operating pressures cannot be maintained. For example, if the
inlet pressure to a regulator is not sufficient to maintain the set pressure, either for capacity or minimum
differential pressure reasons, an error is generated during the calculation.

Failed Conditions

In general, the calculation of flows and pressures through the station piping and devices under failed
conditions requires a trial-and-error solution method. The maximum inlet pressure is used as the supply
pressure to the upstream piping; for stations containing a relief valve, the flow through the station is equal
to the summation of the minimum downstream flow and the flow rate through the relief device and stack;
for stations containing a monitor regulator, the flow through the station is equal to the maximum required
downstream flow. All control devices are assumed to be failed wide open, monitor devices are assumed to
be controlled at their respective set pressures, and relief devices are assumed to be operating in a wide open
position.
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For configurations containing a relief valve, the general calculation method involves assuming an initial flow
rate through the relief valve and stack; the pressure drop is calculated across each piping section and device
from the stack back through the station to the inlet end of the upstream piping section. The calculated inlet
pressure value is compared to the specified maximum inlet pressure; if the values are equivalent within a
certain tolerance, the calculation is complete. If the difference in the values is not within the tolerance, a new
flow rate is calculated, the pressure drop values are re-calculated, and the inlet pressure check is repeated.
This process continues until the difference between the calculated inlet pressures is within the preset
allowable tolerance.

All failed calculations assume that no “backflow” occurs from the downstream system. If the downstream
system is supplied by multiple sources, depending on system pressures, it may be possible for the
downstream system to flow toward the failed station and affect the capacity of the overpressure protection
device.

For configurations containing a monitor regulator, the general calculation method involves calculating the
pressure drop across each piping section and device. A calculation error will occur if minimum operating
pressures cannot be maintained. For example, if the inlet pressure to a regulator is not sufficient to maintain
the set pressure, either for capacity or minimum differential pressure reasons, an error is generated during
the calculation.

Maximum Regulator Capacity

For normal conditions, the minimum inlet pressure is used to calculate the maximum flow that can be passed
through the piping and devices upstream of the regulator while maintaining the required set pressure and
minimum differential pressure requirements. The calculation method uses a trial-and-error solution method.

For failed conditions, where a relief valve is present, the maximum inlet pressure is used to calculate the

maximum flow that can be passed through the upstream piping and regulator while the outlet pressure is no
less than the reset pressure of the relief valve.

Maximum Relief Valve Capacity

For normal conditions, no calculation is performed.

For failed conditions, the relief valve is assumed to be in a wide-open position. The MAOP plus allowable
build-up pressure is used as the inlet pressure to the intermediate piping upstream of the relief valve. The
maximum flow through the intermediate piping, relief valve, and stack piping is calculated. The relief valve
capacity may be limited by the intermediate or stack piping capacity and optionally by the velocity of the
stack flow.
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If the Limit Stack Velocity To Atmospheric Pressure calculation option is selected, the outlet pressure of the
stack is assumed to be at atmospheric pressure (gauge pressure equal zero (0)). If the option is not selected,
the stack outlet pressure is not limited and may be greater than atmospheric pressure, depending on the flow
conditions.

Sonic Velocity Handling

When flow velocity in the associated station piping reaches sonic velocity, the flow condition is referred to
as choked or critical flow. No further flow can be passed through the section at the current pressure
conditions when choked flow is present. If the “Limit Pipe Flow To Sonic Velocity” calculation option is
selected, the flow velocity through each piping section is limited during the calculation process to a flow rate
no greater than the value that would produce a flow velocity equal to the sonic velocity value at the
encountered conditions. If the Limit Pipe Flow To Sonic Velocity calculation option is selected, the flow
velocity is unlimited.

An additional message or note may be displayed when the flow velocity in one of the piping components
reaches sonic velocity. When using the Schematic Data Interface, the stack component item will be colored

orange if the stack flow velocity has reached sonic velocity (choked flow).

The sonic velocity values are calculated using the GPSA calculation method.

Pipe and Fitting Component Handling

Pipe and fittings associated with a piping section are entered using one of the component entry methods.
During the calculations, the resistance of the components is calculated by combining the equivalent length
values of the attached components. When components of varying inside diameter are used, a common or base
inside diameter value is established, and all equivalent values are converted to the base diameter. The
pressure drop for a segment is calculated using the base diameter value and the sum of the associated
equivalent lengths. When multiple sizes are used, the flow velocity value is based on the smallest diameter
and lowest pressure.
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The order of the component entry is not
significant except when “branch” fittings are
used in the intermediate piping component list.
On stations configured with regulator and relief
valve stages, the intermediate piping
components are used to describe the pipe and Relief Branch - First
fittings located between the regulator outlet and I

the relief valve inlet. By this definition, in most IntEmEAIRERIDING HoNnsteesntRiping
cases, the intermediate piping includes the
piping that connects to the outlet piping and
supplies the downstream system. Usually, atee  Figure 1

or other branch connection is installed to

connect the relief valve to the intermediate piping, with the branch piping only experiencing flow when the
relief valve is venting. In this case, a special component can be used to better define the intermediate piping
components. It is the “Relief Branch - First” component and is listed on the Fittings data tab of the Piping
Components screen. The Relief Branch - The first component is used to indicate where the vent piping
“branches” from the intermediate piping at the beginning of the branch that runs to the relief valve. The flow
through the piping upstream of the First Relief Branch is equal to the flow through the relief valve plus any
downstream flow. The flow through the piping downstream of the First Relief Branch is equal to the flow
through the relief valve only. See Figure 1 for further explanation.

Vent Stack

Relief Valve

When more than one relief valve is present,
each valve and stack are assumed to be Vent Stack
identical. In the case of multiple valves, two
special components can be used to better define
the intermediate piping components. They are
the “Relief Branch - First” and “Relief Branch - ; ;
Second” components and are listed on the relierBranch -Frst— - Relief Branch - Second
Fittings data tab of the Piping Components Upstream Piping Downstream Piping

screen. The Relief Branch - The first
component is used to indicate where the vent
piping “branches” from the intermediate piping  Figure 2

at the beginning of the common run to the

valve cluster. The Relief Branch - The second component is used to indicate where the vent piping
“branches” from the common run to each individual valve. The flow through the piping upstream of the First
Relief Branch is equal to the flow through all of the relief valves plus any downstream flow. The flow
through the common run between the First and Second Relief Branches is equal to the flow through the relief
valves only. The flow through the piping downstream of the Second Relief Branch is equal to the flow
through a single relief valve only. The flow through each of the relief valves is assumed to be identical. See
Figure 2 for further explanation.

Relief Valve
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Allowable Build-Up Pressure Handling

The allowable build-up pressure during a failure is handled differently depending on the selected Regulatory
Code and certain calculation options. Where the selected regulatory code allows the MAOP value to be
increased during failed conditions, the allowable build-up pressure is calculated based on this criteria. The
User may prevent the MAOP from being increased by selecting the “Fixed” option on the associated piping
data screen.

It is assumed that the first stage upstream piping section is not subject to “failure,” and the MAOP of this
section is not increased.

In certain high-pressure/high-stress conditions, certain regulatory codes require that the allowable build-up

pressure be based on the SMYS value of the associated components. In these cases, the User must enter an
appropriate value for the SMYS value.

Token Relief Valve Handling

A “token” relief valve refers to a device that is used as a signal for a certain pressure situation. The device
is not intended to be used for overpressure protection. The device is usually comparatively small and usually
set to indicate that the monitor regulator of a monitor-style configuration has taken control. They are
sometimes referred to as a whistle because their small size tends to produce a high-pitched audible sound
when they are operating.

StationManager allows a token relief valve to be specified for stages containing a regulator. If a token relief

is indicated, the set pressure may be entered. Neither the device nor its set pressure is used as part of the
capacity or compliance calculations.

Calculation Tolerances

Many of the StationManager calculations involve the use of trial-and-error solution methods. In these cases,
the calculations are repeatedly performed until a certain check parameter is within a specified tolerance. For
pressure-type parameters, the tolerance is set at 0.001 psi. For volumetric flow type parameters, the tolerance
is set at 0.001 Mcfh. The tolerances are preset and cannot be changed by the User.
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Specific Calculation Methods

The following describes the general calculation assumptions and methods used in computing values for the
specific stage configurations and conditions supported by the software.

Regulator Only

In this type of configuration, the stage is assumed to contain only an upstream device. No intermediate piping
is used.

Normal Conditions -

The regulator is assumed to be operating normally. The supply pressure is set at the minimum inlet pressure.
The maximum required downstream flow rate is used for all portions of the stage piping. The pressure drop
across the upstream piping section is computed. If the outlet pressure of the upstream piping is sufficient to
allow the regulator’s minimum differential pressure and capacity requirements to be met, the pressure drop
is calculated across the downstream piping. If the outlet pressure of the upstream piping is not sufficient, a
calculation error will occur.

Failed Conditions -

The regulator is assumed to be operating wide-open. The supply pressure is set at the maximum inlet
pressure. The maximum wide-open flow rate is calculated and reported. The supply pressure is reported as
the maximum pressure for all portions of the stage piping. The pressure values downstream of the regulator
under failed conditions represent the pressures that would be present if the regulator were allowed to flow
wide open; if the flow is restricted, the downstream pressures could increase to a level equal to the supply
pressure.

Relief Valve Only

In this type of configuration, the stage is assumed to contain only a downstream device. No intermediate
piping is used.

Normal Conditions -
No calculation was performed.
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Failed Conditions -

The relief valve is assumed to be wide-open. The supply pressure is set at the maximum inlet pressure. The
flow through the upstream piping is equal to the stack flow plus the minimum downstream flow rate. The
flow through the relief valve and the stack are equivalent. The pressure at the outlet end of the stack piping
is set depending on the value of the Limit Stack Outlet Pressure To Atmospheric Pressure option, as
described earlier. The relief valve capacity may be limited by the stack capacity and/or flow velocity in the
stack. The flow through the stack, relief valve, and upstream piping is calculated using a trial-and-error
method.

Regulator & Relief Valve

In this type of configuration, the stage is assumed to contain piping segments along with an upstream device
(the regulator) and a single downstream device (the relief valve).

Normal Conditions -

The regulator is assumed to be operating normally. The relief valve is assumed to be closed. The supply
pressure is set at the minimum inlet pressure. The maximum required downstream flow rate is used for the
non-stack portions of the stage piping. The pressure drop across the upstream piping section is computed.
If the outlet pressure of the upstream piping is sufficient to allow the regulator’s minimum differential
pressure and capacity requirements to be met, the pressure drop is calculated across the intermediate and
downstream piping. If the outlet pressure of the upstream piping is not sufficient, a calculation error will
occur.

Failed Conditions -

The regulator is assumed to be wide-open. The relief valve is assumed to be wide-open. The supply pressure
is set at the maximum inlet pressure. The flow through the upstream piping, upstream device, and
intermediate piping is equal to the stack flow plus the minimum downstream flow rate. The flow through the
relief valve and the stack are equivalent. The pressure at the outlet end of the stack piping is set depending
on the value of the Limit Stack Outlet Pressure To Atmospheric Pressure option, as described earlier. The
relief valve capacity may be limited by the stack capacity and/or flow velocity in the stack. The flow through
the stack, relief valve, and upstream piping is calculated using a trial-and-error method.

If a relief valve branch component is used, the flow through the intermediate piping and components up to
the first branch component is equal to the stack flow plus the minimum downstream flow. Flow through
components after the first branch component is equal to the relief valve and stack flow.
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The calculation of the station pressures downstream of the regulator varies depending on whether the failed
capacity of the regulator is greater than or less than the capacity of the relief valve. In the case where the
regulator capacity is greater than the relief valve, the downstream pressures are calculated based on the flow
rate of the relief valve and will generally reflect values greater than allowed. Where the regulator capacity
is less than the relief valve, the downstream pressures are based on the flow of the regulator. The reported
values will vary depending on certain calculation options. If the Limit Relief Valve Inlet Pressure To No Less
Than Reset Pressure option is selected, the values will be calculated such that inlet pressure to the relief
valve is greater than or equal to the relief valve reset pressure. When this option is not selected, the reported
pressures represent the predicted pressures if the relief valve were not allowed to reset and there was no
backflow from the downstream system.

Regulator & Multiple Relief Valves

In this type of configuration, the stage is assumed to contain an upstream device (the regulator) and multiple
downstream devices (multiple relief valves). The relief valves, stack piping, and intermediate piping to the
relief valves are assumed to be identical.

Normal Conditions -

The regulator is assumed to be operating normally. The relief valves are assumed to be closed. The supply
pressure is set at the minimum inlet pressure. The maximum required downstream flow rate is used for the
non-stack portions of the stage piping. The pressure drop across the upstream piping section is computed.
If the outlet pressure of the upstream piping is sufficient to allow the regulator’s minimum differential
pressure and capacity requirements to be met, the pressure drop is calculated across the intermediate and
downstream piping. If the outlet pressure of the upstream piping is not sufficient, a calculation error will
occur.

Failed Conditions -

The regulator is assumed to be wide-open. The relief valves are assumed to be wide-open. The supply
pressure is set at the maximum inlet pressure. The flow through the upstream piping, upstream device, and
intermediate piping is equal to the total of the stack flows plus the minimum downstream flow rate. The flow
through each of the relief valves and the stacks are equivalent. The pressure at the outlet end of the stack
piping is set depending on the value of the Limit Stack Outlet Pressure To Atmospheric Pressure option, as
described earlier. The relief valve capacity may be limited by the stack capacity and/or flow velocity in the
stack. The flow through each of the stack, relief valve, and upstream piping is calculated using a trial-and-
error method.

If a relief valve branch component is used, the flow through the intermediate piping and components up to
the first branch component is equal to the total of the stack flow plus the minimum downstream flow. Flow
through components after the first branch component and before the second branch component is equal to
the total of the relief valves and stack flows. Flow through components after the second branch component
is equal to flow for a single relief valve and stack.

=
,3 B3PE LLC Engineering & Software Services
278 Revision - 002, Copyright 2024, All Rights Reserved.




StationManager™ 2.1 Appendix

Table Of Contents

The pressures downstream of the regulator are reported and calculated as described in the Regulator & Relief
Valve calculation description.

Dual Regulators & Relief Valve

In this type of configuration, the stage is assumed to contain piping segments along with two upstream
devices (two identical regulators) and one or more downstream devices (the relief valve or valves). The
upstream piping and intermediate piping are assumed to be connected directly to the regulators - this
assumption tends to overestimate the pressure loss.

Normal Conditions -

Both regulators are assumed to be operating normally. The relief valve or valve is assumed to be closed. The
supply pressure is set at the minimum inlet pressure. The maximum required downstream flow rate is used
for non-stack portions of the stage piping. The pressure drop across the upstream piping section is computed.
If the outlet pressure of the upstream piping is sufficient to allow the regulators’ minimum differential
pressure and capacity requirements to be met, the pressure drop is calculated across the intermediate and
downstream piping. If the outlet pressure of the upstream piping is not sufficient, a calculation error will
occur.

If the regulator set pressures are not equal, for calculation purposes, the outlet pressure of both regulators
is assumed to be equal to the lower of the regulator set pressures.

Failed Conditions -

It is assumed that only one regulator fails, that the failed regulator is assumed to be wide-open, and that the
non-failed regulator shuts off due to the increased downstream pressure. The relief valve is assumed to be
wide-open. The supply pressure is set at the maximum inlet pressure. The flow through the upstream piping,
upstream device, and intermediate piping is equal to the stack flow plus the minimum downstream flow rate.
The flow through the relief valve and the stack are equivalent. The pressure at the outlet end of the stack
piping is set depending on the value of the Limit Stack Outlet Pressure To Atmospheric Pressure option, as
described earlier. The relief valve capacity may be limited by the stack capacity and/or flow velocity in the
stack. The flow through the stack, relief valve, and upstream piping is calculated using a trial-and-error
method.

Ifrelief valve branch components or multiple relief valves are used, the flow through the intermediate piping
and components are calculated as described in the previous topics.

The pressures downstream of the regulator are reported and calculated as described in the Regulator & Relief
Valve calculation description.
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Regulator & Regulator (Downstream Monitor)

In this type of configuration, the stage is assumed to contain upstream, intermediate, and downstream piping,
a single upstream device (controlling regulator), and a single downstream device (monitor regulator).

Normal Conditions -

The upstream (controlling) regulator is assumed to be operating normally. The downstream (monitor)
regulator is assumed to be wide-open. The supply pressure is set at the minimum inlet pressure. The
maximum required downstream flow rate is used for all portions of the stage piping. The pressure drop across
the upstream piping section is computed. If the outlet pressure of the upstream piping is sufficient to allow
the upstream regulator’s minimum differential pressure and capacity requirements to be met, the pressure
drop is calculated across the intermediate piping, downstream device, and downstream piping. If the outlet
pressure of the upstream piping is not sufficient, a calculation error will occur.

Failed Conditions -

The upstream (controlling) regulator is assumed to be failed wide-open. The downstream (monitor) regulator
is assumed to be controlling. The supply pressure is set at the minimum inlet pressure. The maximum
required downstream flow rate is used for all portions of the stage piping. The pressure drop across the
upstream piping, upstream device, and intermediate piping is computed. If the outlet pressure of the
intermediate piping is sufficient to allow the downstream regulator’s minimum differential pressure and
capacity requirements to be met, the pressure drop is calculated across the downstream piping. If the outlet
pressure of the intermediate piping is not sufficient, a calculation error will occur.

Regulator & Regulator (Upstream Monitor)

In this type of configuration, the stage is assumed to contain upstream, intermediate, and downstream piping,
a single upstream device (monitor regulator), and a single downstream device (controlling regulator).

Normal Conditions -

The upstream (monitor) regulator is assumed to be wide-open. The downstream (controlling) regulator is
assumed to be operating normally. The supply pressure is set at the minimum inlet pressure. The maximum
required downstream flow rate is used for all portions of the stage piping. The pressure drop across the
upstream piping section is computed. If the outlet pressure of the upstream piping is sufficient to allow the
upstream regulator’s minimum differential pressure and capacity requirements to be met, the pressure drop
is calculated across the intermediate piping, downstream device, and downstream piping. If the outlet
pressure of the upstream piping is not sufficient, a calculation error will occur.

=
,5 B3PE LLC Engineering & Software Services
230 Revision - 002, Copyright 2024, All Rights Reserved.




StationManager™ 2.1 Appendix

Table Of Contents

Failed Conditions -

The downstream (controlling) regulator is assumed to be failed wide-open. The upstream (monitor) regulator
is assumed to be controlling. The supply pressure is set at the minimum inlet pressure. The maximum
required downstream flow rate is used for all portions of the stage piping. The pressure drop across the
upstream piping is computed. If the outlet pressure of the upstream piping is sufficient to allow the upstream
regulator’s minimum differential pressure and capacity requirements to be met, the pressure drop is
calculated across the intermediate piping, downstream device, and downstream piping. If the outlet pressure
of the upstream piping is not sufficient, a calculation error will occur.

Regulator & Regulator (Upstream Working Monitor)

In this type of configuration, the stage is assumed to contain upstream, intermediate, and downstream piping,
a single upstream device (working monitor regulator), and a single downstream device (controlling
regulator).

Normal Conditions -

The upstream (working monitor) regulator is assumed to be controlling at its set working pressure. The
downstream (controlling) regulator is assumed to be operating normally. The supply pressure is set at the
minimum inlet pressure. The maximum required downstream flow rate is used for all portions of the stage
piping. The pressure drop across the upstream piping section is computed. If the outlet pressure of the
upstream piping is sufficient to allow the upstream regulator’s minimum differential pressure and capacity
requirements to be met, the pressure drop is calculated across the intermediate piping. If the outlet pressure
of the intermediate piping is sufficient to allow the downstream regulator’s minimum differential pressure
and capacity requirements to be met, the pressure drop is calculated across the downstream piping. If the
outlet pressure of either the upstream or intermediate piping is not sufficient, a calculation error will occur.

Failed Conditions -

The downstream (controlling) regulator is assumed to be failed wide-open. The upstream (working monitor)
regulator is assumed to be controlling at its monitor set pressure. The supply pressure is set at the minimum
inlet pressure. The maximum required downstream flow rate is used for all portions of the stage piping. The
pressure drop across the upstream piping is computed. If the outlet pressure of the upstream piping is
sufficient to allow the upstream regulator’s minimum differential pressure and capacity requirements to be
met, the pressure drop is calculated across the intermediate piping, downstream device, and downstream
piping. If the outlet pressure of the upstream piping is not sufficient, a calculation error will occur.
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Regulators & Shared Relief Valve

In this type of configuration, two runs are considered together. One run is assumed to contain a regulator and
relief valve combination, and the other run is assumed to contain a single regulator. The relief valve is
assumed to be “shared” by the two runs. The regulators’ Size/Type Code may be different. Each run is
essentially calculated as if it were an independent run configured with a regulator and relief valve.

Normal Conditions -

The regulator is assumed to be operating normally. The relief valve is assumed to be closed. The supply
pressure is set at the minimum inlet pressure. The maximum required downstream flow rate is used for the
non-stack portions of the stage piping. The pressure drop across the upstream piping section is computed.
If the outlet pressure of the upstream piping is sufficient to allow the regulator’s minimum differential
pressure and capacity requirements to be met, the pressure drop is calculated across the intermediate and
downstream piping. If the outlet pressure of the upstream piping is not sufficient, a calculation error will
occur.

Failed Conditions -
It is assumed that only one regulator fails at a time. The capacity of each individual regulator is compared

against the capacity of the regulator during the compliance check.

A failed calculation is performed for each run as described in the Regulator & Relief Valve calculation
description.

Regulator & Combined Relief Valves

In this type of configuration, both stages of a run are considered together. The upstream stage is assumed to
contain an upstream device (regulator) and a downstream device (relief valve). The downstream stage is
assumed to contain a single downstream device (relief valve). The relief valves’ Size/Type Code may be
different.

Normal Conditions -

The regulator is assumed to be operating normally. The relief valves are assumed to be closed. The supply
pressure is set at the minimum inlet pressure. The maximum required downstream flow rate is used for the
non-stack portions of the stage piping. The pressure drop across the upstream piping section is computed.
If the outlet pressure of the upstream piping is sufficient to allow the regulator’s minimum differential
pressure and capacity requirements to be met, the pressure drop is calculated across the intermediate and
downstream piping. If the outlet pressure of the upstream piping is not sufficient, a calculation error will
occur.
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Failed Conditions -

The regulator is assumed to be wide-open. The relief valves are assumed to be wide-open. The supply
pressure is set at the maximum inlet pressure. The flow through the upstream piping, upstream device, and
intermediate piping is equal to the total of the stack flows plus the minimum downstream flow rate. The flow
through the upstream relief valve and the stack is calculated. If the flow through the upstream device is
greater than or equal to the flow through the upstream device, then the flow through the downstream relief
valve is assumed to be zero (0). If the flow through the upstream device is less than the flow through the
upstream device, then the flow through the downstream relief valve is calculated. The pressure at the outlet
end of the stack piping is set depending on the value of the Limit Stack Outlet Pressure To Atmospheric
Pressure calculation option, as described earlier. The relief valve capacity may be limited by the stack
capacity and/or flow velocity in the stack. The flow through each of the stack, relief valve, and upstream
piping is calculated using a trial-and-error method.

If a relief valve branch component is used, the flow through the intermediate piping and components up to
the first branch component is equal to the total of the stack flow plus the minimum downstream flow. Flow
through components after the first branch component and before the second branch component is equal to
the total of the relief valves and stack flows. Flow through components after the second branch component
is equal to flow for a single relief valve and stack.

The combined capacity of the relief valves (summation of the capacity of each valve) is checked against the
failed capacity of the regulator during the compliance check.

The pressures downstream of the regulator are reported and calculated as described in the Regulator & Relief
Valve calculation description.

Regulator With Internal Relief Valve

This type of device is not specifically handled; however, the configuration can be accommodated by entering
it as a regulator and relief configuration and entering the capacity of the internal relief valve. Using this
configuration, the normal and failed calculations will be performed similarly to a regulator and relief valve
configuration. If this option is used, add a notation to the station comments to explain the situation.
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Working With The Calculation Options

There are a variety of User-selectable options that affect the way the calculations are performed and the
results are reported. Some general notes on their use and effects are described in the following.

Allow Empty Component Lists

Selecting this option allows the various piping sections to be left empty. When this option is selected, the
pressure drop across the associated segment is not calculated, it is assumed to be zero (0). This makes data
entry easier; however, depending on which segment is affected, it may yield either conservative or
unconservative results. This option controls how the empty component lists are handled during the
calculation process.

Regulator And Relief Valve Style Stages -
Ignoring the inlet piping under failed conditions will yield conservative results - that is, the failed capacity
of the regulator will be overestimated.

Ignoring the intermediate piping yields varied results. In one case, it increases the inlet pressure to the relief
valve, resulting in an optimistic (unconservative) relief valve capacity. In the other case, the pressure for the
inlet of the downstream piping would be calculated higher than if the intermediate piping were included,
yielding conservative results with respect to the MAOP comparison.

Ignoring the stack yields an optimistic (unconservative) relief valve capacity.

Ignoring any of'the piping sections under normal conditions will yield unconservative results - overestimating
the capacity of the regulator and stage.

Regulator/Monitor Style Stages -
Ignoring any of the piping sections under failed or normal conditions will yield unconservative results -
overestimating the capacity of the regulator and stage.

Ignore Inlet/Relief Valve Or Security Set Pressure Check

ISSUE

This option does not affect the actual calculations. Normally, the relief valve set pressure is expected to be
less than the inlet pressure to the station. When this option is not selected, an error message will occur, and
the station will be ignored during the calculation process if the inlet pressure is found to be less than the
reliefvalve set pressure. Selecting this option disables the error check and allows the station to be calculated.
This option applies to the failed calculation for regulator and relief valve style stages.
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Ignore Relief Valve Build-Up Pressure Check

Under failed regulator conditions, the inlet pressure to the relief valve is assumed to increase to a value at
least equal to the set point for the relief valve. The relief valve is assumed to open at that point.

During the failed calculations, it is assumed that the relief valve is in a continuous wide-open position. The
inlet pressure to the relief valve is normally allowed to reach whatever value provides a balanced flow
between the failed regulator and the wide-open relief valve, all piping pressure drops included. If the capacity
of the failed regulator and relief valve are similar, or the capacity of the regulator is greater than the relief
valve, the calculated inlet pressure will be above the relief valve set point. If the relief valve capacity is large
compared to the regulator capacity, the calculated inlet pressure to the relief valve will generally be less than
the set point. In actual operation, this situation would usually cause the relief valve to reset until the pressure
increased again to the set point, reopening the valve and repeating the process.

In some cases, the relief valve will not fully open until the inlet pressure to the valve (the build-up pressure)
is some incrementally higher value than the set pressure. In this case, the minimum build-up pressure value
can be used to specify the incrementally required build-up pressure for a full opening.

This option controls how the inlet (build-up) pressure for a device is handled during the calculation process.
When this option is selected, the pressures along the intermediate piping may be less than the relief valve
set pressure and reflect the estimated values that would be present if the relief valves were not able to reset
and were allowed to flow continuously. The calculated pressures are based on the stack outlet pressure.

When this option is not selected, the pressures along the intermediate piping reflect values that would be
present if the inlet pressure to the relief valve was maintained at or above the relief valve set pressure plus
minimum build-up pressure at the balanced flow rate. In this case, the calculated pressure values are
generally higher than the expected actual values. The calculated pressures are based on the relief valve set
pressure plus minimum build-up pressure.

This option affects the failed pressure calculations for stages regulator and relief valve style stages only. It
does not affect the capacity or MAOP comparisons.

Ignore Minimum Differential Pressure Check

Some regulators and relief valves require that the differential pressure across the device to be fully open. As
used by StationManager, the differential pressure is the difference between the inlet and outlet pressure. This
option controls how the differential across a device is handled during the calculation process.

If this option is not selected, an attempt is made during the calculation process to maintain the differential
across a device to meet or exceed the specified minimum differential value. If this option is selected, any
differential greater than zero (0) is allowed during the calculations.
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This option affects both normal and failed pressure calculations for any type of configuration. An error is
generated if the option is not selected and the minimum differential cannot be achieved.

Ignore Reset Differential Handling

Some relief valves require that the inlet pressure decrease a certain amount below the set pressure before the
valve will reseat or reset itself. If this option is not selected, an attempt is made during the calculation process
to maintain the differential across a device to meet or exceed the specified minimum differential value. If this
option is not selected, the specified minimum reset differential must be achieved before the valve is
considered to reset during the calculations. If this option is selected, the valve is assumed to reset when the
calculated pressure is less than the set pressure.

This option affects the failed pressure calculations for relief valve devices only.

Limit Pipe Flow To Sonic Velocity

During the calculation process, the flow velocity along the various piping sections is calculated based on the
flow rate and pressure values. The velocity varies along an individual pipe section, with the velocity at the
upstream end of the pipe always being higher than the velocity at the downstream end. There is a natural
limit for the maximum velocity that can be achieved in pipe flow; the value is equal to the speed of sound
for a specific gas composition and conditions - sonic velocity. Most regulator and relief valve flow equations
account for this limit, using different flow equations for sonic and subsonic conditions. Pipe flow equations
do not; they generally let the velocity increase limitlessly. This option controls how the sonic velocity limit
is handled in pipe flow calculations.

When this option is selected, the pipe flow velocities are limited to no more than sonic velocity. When this
option is not selected, pipe flow velocities are not limited. Limiting the velocity provides more realistic
results. Not limiting the velocity yields unrealistic results. Unlimited stack velocity values yield optimistic
(unconservative) relief valve and vent capacity values.

This option affects pressure and capacity calculations for all types of stages and devices.

Ignore Relief Inlet To Less Than Reset Pressure

The background for this option is similar to the one described in the Ignore Relief Valve Build-Up Pressure.
In this case, the relief inlet pressure is compared to the reset pressure (set pressure less minimum reset
differential pressure). When this option is not selected, the inlet pressure to the relief valve is maintained at
or above the reset pressure. The calculated pressures are based on the relief valve set pressure plus minimum
build-up pressure. When this option is selected, the inlet pressure is not adjusted during the calculation
process. The calculated pressures are based on the stack outlet pressure.
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This option affects the failed pressure calculations only for stages containing a relief valve device. It does
not affect the capacity or MAOP comparisons.

Limit Relief Stack To Outlet To Atmospheric Pressure

During failed conditions, high-velocity values may be experienced through all of the piping sections, but
especially through the vent stack. It is common for the velocity in the vent stack to reach sonic velocity and
for the flow in the vent stack to become “choked.” When the stack flow becomes choked, the flow through
the stack is limited or restricted by the velocity. Most stacks vent directly to the atmosphere, so the pressure
normally found at the downstream end of the pipe is the same as atmospheric pressure. It has been common
practice over the years to assume that the pressure at the downstream end of the stack is always equal to
atmospheric pressure. However, under choked flow conditions, it is common for the pressure at the
downstream end of the stack to increase above atmospheric pressure. This option controls how the outlet
pressure for the stack is handled during the calculations.

When this option is selected, the pressure at the downstream (outlet) end of the stack is maintained at
atmospheric pressure. Limiting the outlet pressure limits the capacity of the stack and consequently limits
the capacity of the relief valve, producing conservative results. When this option is not selected, the pressure
at the downstream (outlet) end of the stack is not limited. Not limiting the outlet pressure yields more
realistic results. When the stack is choked, the velocity at the outlet end of the stack is the same in either
case; however, when the pressure is allowed to increase, the gas density also increases, allowing more
“standard” volume of gas to flow through the stack.

This option affects the failed pressure and capacity calculations only for stages containing a relief valve
device.
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StationManager uses a proprietary database to maintain its files. The database is made up of a number of
various data files, with each file containing a set of data fields or items. The content and management of the
database files are described in the following.

Data Files

StationManager uses several data files to create its database. With the exception of the Default Data file, the
data files are linked together using an internally generated key field. The Station Data file serves as the main
or server file for the database. The other data files are linked to the Station Data file by way of the key field.
The data file relationships are shown in the following figure.

Station Data f— Equipment

Run Data

Data

Default Data Inspection

Data

All of the data files associated with a specific database possess the same name as the database with different
extensions. The content and use of the various data files are shown below.

Data Files
File Type Extension Description
Default Data .dft Contains default data values, global data values, and various
settings and options.
Station Data .sdb Contains general station and configuration values.
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Data Files
File Type Extension Description
Run Data .rdb Contains hydraulic and equipment setting values and results.
Equipment Data .edb Contains equipment values.
Inspection Data .idb Contains inspection values and results.

StationManager automatically manages the handling of the files in terms of its operational use; however, if
the files are manually copied, moved, or deleted, the User must ensure that all of the files are included as
appropriate.

Prior to performing various routines and operations, a set of backup data files will be created. The backup
files end in a double extension, with a second extension of “.bak.” The content of the backup files can be
restored to the database using the Restore Previous Database item in the File menu. When a new backup file
is created, the previous backup file is sent to the Windows Recycle bin.

When a database is “opened,” the content of the data files is read into a set of temporary working data files.

Until the database is saved, changes to the database are maintained only in the temporary files. The
temporary files are deleted when the database is closed.

Data Items

General Station Data

Item Name Item Description Item Type Required
(See Notes) For
Calculation

Location Information

City/Town Specifies the city or town associated with the | Entered N
station location. String
Up to 20 characters

District Specifies the pressure or operating district | Entered N
Identification associated with station. String
Up to 40 characters

Legal Specifies the “legal” description of the | Entered N
Description station location. String
Up to 40 characters
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Item Name Item Description Item Type Required
(See Notes) For
Calculation
Location Specifies the descriptive location of the | Entered N
station. String
Up to 40 characters
State Specifies the state associated with the station | Entered N
location. String
Up to 10 characters
Station Specifies the descriptive identification of the | Entered N
Description station. String
Up to 40 characters
Station Specifies the identification assignment for | Entered N
Identification the station. String
Up to 40 characters
X Coordinate Specifies the X (east-west) coordinate value | Entered N
for the station’s location. Double Precision
number or String
value
Up to 10 characters
Y Coordinate Specifies the Y (north-south) coordinate | Entered N
value for the station’s location. Double Precision
number or String
value
Up to 10 characters
Configuration
Number Of Specifies the number of runs for the station. | Entered Y
Runs Integer
lor2
Operating Specifies the station’s operating status. Entered Y
Status Index
Stages Per Run | Specifies the number of pressure cuts/stages | Entered Y
for each run. Integer
lor2
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General Station Data
Item Name Item Description Item Type Required
(See Notes) For
Calculation
Capacity
Maximum Specifies the maximum required flow | Entered Y
Required capacity of the station. Single Precision
>=0
Minimum Specifies the minimum required flow | Entered Y
Required capacity of the station. Single Precision
>=0
Gas Properties
Atmospheric Specifies the atmospheric pressure value | Calculated
Pressure associated with the specified elevation value. | Single Precision
Base Pressure Specifies the pressure basis for the measured | Entered Y
and calculated volumes. Single Precision
>=0
Base Specifies the temperature basis for the | Entered Y
Temperature measured and calculated volumes. Single Precision
>=0
Elevation Specifies the height above mean sea level of | Entered Y
the station’s location. Single Precision
Any
Flowing Specifies the average gas flowing | Entered Y
Temperature temperature at the station’s inlet. Single Precision
>= Absolute 0
Specific Gravity | Specifics the average specific gravity of the | Entered Y
gas flowing through the station, as compared | Single Precision
to dry air at same conditions. >=0
Specific Heat Specifies the average heat ratio of the gas | Entered Y
Ratio flowing through the station. Ratio of the | Single Precision
specific heat at constant pressure to specific | >=0
heat at constant volume.
Viscosity Specifies the average absolute or dynamic | Entered Y
viscosity of the gas flowing through the | Single Precision
station. >=0
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Item Name Item Description Item Type Required
(See Notes) For
Calculation
Miscellaneous Data
Comments / Specifies comments and notes associated | Entered N
Notes with the station configuration, location, or | String
operation. Up to 40 characters
Design Date Specifies the date when the station was | Entered N
initially designed. Date
Designed By Specifies the name of the person that | Entered N
designed the station. String
Up to 40 characters
Entered/Revised | Specifies the person that entered or last | Entered N
By reviewed data for the station. String

Up to 40 characters

Entry/Revision | Specifies the date when the station data was | Entered N

Date entered or last revised. Date

In-Service Date | Specifies the date when the station was | Entered N
placed into service. Date

Jurisdiction Specifies the regulatory jurisdiction for the | Entered N
station. Index

Image Data

Image Filename | Specifies the name of an attached image file. | Entered N
Up to ten files may be attached. String

Up to 120 characters

Notes

® The General Station data is stored in the “station database” file. The station database file ends in a
“.sbd” extension.

® The /tem Type item lists whether the associated data item is Entered or Calculated, the value data type,
and any value restrictions. Entered means that the value can be entered by the User. Calculated means that
the value is computed and entered by the software. The data types are defined in the Program Limitations
topic.

® The Required For Calculation item indicates whether the item is required for a hydraulic calculation
to be performed. A “Y” value means that the item is required. An empty or “N” value means that the value
is optional. Optional items can be used to store alternative item values at the User’s discretion.
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Hydraulic Data
Item Name Item Description Item Type Required
(See Notes) For
Calculation

Configuration
Run Type Specifies the operating type of the associated | Entered Y

run. Index
Stage Style Specifies the configuration type ofthe | Entered Y

associated stage. Index

Downstream Device - If a downstream device is present the following data items are required as

indicated.
Device Count For relief valves, specifies the quantity | Entered Y
(number) of devices installed. Not used for | Integer
regulators. 1,20r3
Enter Capacity Specifies whether the capacity of the device | Entered Y
is calculated or entered. Boolean
Entered Capacity | If the capacity is specified as entered, | Entered Y
specifies the entered capacity of the device. | Single Precision
>=0
Minimum Build- | For relief valves, specifies a User-defined | Entered Y
Up Pressure minimum build-up pressure for the relief | Single Precision
valves. Not used for regulators. >=()
Pressure Units Specifies the dimensional units to use for the | Entered Y
associated pressure values. Fixed String
Set Pressure Specifies the set pressure for the downstream | Entered Y
device. Single Precision
>= minus 1
atmosphere
Shared Device When a relief valve is present and more than | Entered Y
one run is present, this item specifies whether | Boolean
the valve is shared by both runs. Not used for
regulators.
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Item Name Item Description Item Type Required
(See Notes) For
Calculation
Size/Type Code Specifies the Size/Type Code for the | Entered Y
downstream device. The value must | Fixed String
correspond to a value found in the respective | Up to 20 characters
Property Table.
Token Relief Indicates whether a token relief valve is | Entered N
installed. This item is only displayed when | Boolean
the downstream device is a regulator.
Token Relief Set | If a token relief valve is installed, this item | Entered N
Pressure specifies the set pressure for the token relief | Single Precision
valve. >=minus 1
atmosphere
Piping Section - Downstream, Intermediate, Relief Stack Piping
Flow Equation Specifies the pipe flow equation to use for | Entered Y
the associated piping section. Index
Pipe Efficiency Specifies the pipe flow efficiency value to | Entered Y
use for the associated piping section. Single Precision
>=0
Piping Specifies the pipe and fitting components | Entered Y
Components assigned to the associated piping section. Up | Component
to ten components may be assigned to a
piping section.
Upstream Device
Enter Capacity Specifies whether the capacity of the device | Entered Y
is calculated or entered. Boolean
Entered Capacity | If the capacity is specified as entered, | Entered Y
specifies the entered capacity of the device. | Single Precision
>=0
Pressure Units Specifies the dimensional units to use for the | Entered Y
various pressure values. Fixed String
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Hydraulic Data
Item Name Item Description Item Type Required
(See Notes) For
Calculation
Set Pressure Specifies the set pressure for the upstream | Entered Y
device. Single Precision
>= minus 1
atmosphere
Size/Type Code Specifies the Size/Type Code forthe | Entered Y
upstream device. The value must correspond | Fixed String
to a value found in the respective Property | Up to 20 characters
Table.
Token Relief Indicates whether a token relief valve is | Entered N
installed. This item is only displayed when | Boolean
the upstream device is a regulator.
Token Relief Set | If a token relief valve is installed, this item | Entered N
Pressure specifies the set pressure for the token relief | Single Precision
valve. >=minus 1
atmosphere
Upstream Piping
Flow Equation Specifies the pipe flow equation to use for | Entered Y
the upstream piping. Index
Maximum Inlet Specifies the maximum actual pressure at the | Entered Y
Pressure inlet/upstream end of the associated upstream | Single Precision
piping. Only used for the first stage of the | >= minus I
first run in the station. atmosphere
Minimum Inlet Specifies the minimum actual pressure at the | Entered Y
Pressure inlet/upstream end of the upstream piping. | Single Precision
Only used for the first stage of the first runin | >= minus 1
the station. atmosphere
Pipe Efficiency Specifies the pipe flow efficiency value to | Entered Y
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Item Name Item Description Item Type Required
(See Notes) For
Calculation

Piping Specifies the pipe and fitting components | Entered Y
Components associated with the upstream piping. Up to | Component

ten components may be assigned to the stack.
Pressure Units Specifies the dimensional units to use for the | Entered Y

associated pressure values. Fixed String

Calculation Results - The following items are maintained for normal and failed calculation results for
the various pipe sections and devices.

each piping section including the stack.

Flow Rate Specifies the flow through the associated | Calculated N
piping section or device. Single Precision

Maximum Specifies the maximum flow capacity of the | Calculated N

Device Capacity | associated device. Single Precision

Pressure Drop Specifies the maximum pressure drop across | Calculated N
the associated pipe section. Single Precision

Pressures Specifies the inlet and outlet pressure values | Calculated N
for each device, piping section, and stack. Single Precision

Velocity Specifies the maximum flow velocity through | Calculated N

Single Precision

Setting Values - The following values are maintained for both the upstream and downstream devices.

Final Primary Set | Specifies the final (as left) set pressure of the | Entered N
Pressure associated device or the primary pilot for the | Single Precision
associated device.
Final Secondary | Specifies the final (as left) set pressure of the | Entered N
Set Pressure secondary pilot for the associated device. Single Precision
Initial Primary Specifies the initial (as found) set pressure of | Entered N
Set Pressure the associated device or the primary pilot for | Single Precision
the associated device.
Initial Specifies the initial (as found) set pressure of | Entered N
Downstream the secondary pilot for the downstream | Single Precision
Secondary Set device.
Pressure
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Item Name Item Description Item Type Required
(See Notes) For
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Notes

® The Hydraulic data is stored in the “run database” file. The run database file ends in a “.rbd” extension.
A run record is maintained for each stage of each run in a station.

® The /tem Type item lists whether the associated data item is Entered or Calculated, the value data type,
and any value restrictions. Entered means that the value can be entered by the User. Calculated means that
the value is computed and entered by the software. The data types are defined in the Program Limitations
topic.

® The Required For Calculation item indicates whether the item is required for a hydraulic calculation
to be performed. A “Y” value means that the item is required. An empty or “N” value means that the value
is optional. Optional items can be used to store alternative item values at the User’s discretion.

® Piping Section Items are maintained for the upstream, intermediate, downstream, and stack piping
sections.

® The pressure units for the upstream device are also used as the pressure units for the intermediate
piping.

® For aregulator, the pressure units for the downstream device are also used as the pressure units for the
downstream piping. For a relief valve, the pressure units for the downstream device are also used as the
pressure units for the stack piping.

Inspection Data

Item Name Item Description Item Type Required
(See Notes) For
Calculation

For Year Specifies the calendar year thatthe | Entered N
inspection is associated with. Integer

Status

Completed Specifies the date when the most previous | Entered N

Inspection Date field inspection was conducted. Date

Inspection Status | Displays the status of the latest field | Calculated N
inspection results.* String

Previous Specifies the date of the most previous field | Entered N

Inspection Date inspection. Date
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Item Name Item Description Item Type Required
(See Notes) For
Calculation
Required Displays the date for the next required field | Calculated N
Inspection Date inspection.* Date
Inspection
Data Recorders Specifies the status of the condition of any | Entered N
OK installed pressure recorders. Boolean
Enclosures OK Specifies the status of the condition of any | Entered N
station enclosure, housing, or vault. Boolean
Locks OK Specifies the status of the condition and | Entered N
presence of any security locks. Boolean
OPP Capacity Specifies whether the flow capacity of the | Entered N
Field Verified Over Pressure Protection (OPP) device was | Boolean
field verified or tested.
OPP Devices Specifies whether the Over Pressure | Entered N
Lock-Up OK Protection (OPP) device passed the “lock-up” | Boolean
(shut ofY) test.
OPP Devices Specifies whether the Over Pressure | Entered N
Operated Protection (OPP) device was actually | Boolean
operated during the field inspection.
OPP Internals Specifies whether the Over Pressure | Entered N
Inspected Protection (OPP) device was dismantled and | Boolean
the condition of'its internal components were
inspected.
Paint OK Specifies the status of the condition of the | Entered N
paint or atmospheric corrosion protection for | Boolean
the station.
Regulator Specifies whether the regulator device was | Entered N
Internals dismantled and the condition of its internal | Boolean
Inspected components were inspected.
Regulators Lock- | Specifies whether the regulator device passed | Entered N
Up OK the “lock-up” (shut off) test. Boolean
]
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Item Name Item Description Item Type Required
(See Notes) For
Calculation
Regulators Specifies whether the regulator device was | Entered N
Operated actually operated during the field inspection. | Boolean
Signs OK Specifies the status of the condition of the | Entered N
warning signs and posted notices for the | Boolean
station.
Site Protection Specifies the status of the condition of the | Entered N
OK site protection for the station. For example, | Boolean
fencing, bollards, or livestock guards.
Strainers OK Specifies the status of the condition of any | Entered N
strainers or filters installed at/on the station. | Boolean
Valves OK Specifies the status of the condition of the | Entered N
valves for the station. Boolean
Vents OK Specifies the condition of the device and | Entered N
enclosure vents for the station. Boolean
Miscellaneous
Actions Specifies the name of the person who | Entered N
Completed By performed the required corrective actions. String
Up to 20 characters
Action Specifies the date when any required actions | Entered N
Completion Date | were completed. Date
Inspected By Specifies the name of the person who | Entered N
performed the field inspection. String
Up to 20 characters
Inspection Date Specifies the date when the field inspection | Entered N
was performed. Date
Notes Specifies any notes and comments associated | Entered N
with the inspection. String
Upto 120
characters
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Item Name Item Description Item Type Required
(See Notes) For
Calculation
Other Specifies whether additional observations or | Entered N
Observations comments are included in the Inspection | Boolean
Notes.
Required Actions | Specifies any corrective actions that must be | Entered N
taken to bring the station into compliance. String
Upto 120
characters
Notes

® The Inspection data is stored in the “inspection database” file. The inspection database file ends in a
“.ibd” extension. An inspection record is maintained for the devices in each stage of each run in a station.
® The /tem Type item lists whether the associated data item is Entered or Calculated, the value data type,
and any value restrictions. Entered means that the value can be entered by the User. Calculated means that
the value is computed and entered by the software. The data types are defined in the Program Limitations
topic.

® The Required For Calculation item indicates whether the item is required for an inspection calculation
to be performed. A “Y” value means that the item is required. An empty value means that the value is
optional. Optional items are to be used to store alternative item values at the User’s discretion.

* This item is calculated on the “fly” the item is not actually saved in the database.

Equipment Data
Item Name Item Description Item Type Required
(See Notes) For
Calculation

Device Data - Maintained for both Downstream and Upstream devices.

Connection Style | Specifies the end connection style for the | Entered N
device. Index
Diaphragm Size | Specifies the main body diaphragm size for | Entered N
the device. String
Up to 10 characters
Diaphragm Type [ Specifies the main body diaphragm type for | Entered N
the device. String

Up to 20 characters
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Item Name Item Description Item Type Required
(See Notes) For
Calculation
Maximum Body [ Specifies the maximum pressure for the | Entered N
Pressure device’s main body. Single Precision
>= Absolute 0
Pressure Units Specifies the dimensional units for the | Entered N
associated pressure values. Fixed String
Serial Number Specifies the serial number for the device. Entered N
String
Up to 20 characters
Spring Color Specifies the main spring color for the device. | Entered N
Index
Spring Maximum | Specifies the maximum pressure rating for the | Entered N
Pressure main spring. Single Precision
>= Absolute 0
Spring Minimum | Specifies the minimum pressure rating for the | Entered N
Pressure main spring. Single Precision
>= Absolute 0
Spring Number Specifies the sizing/rating number for the | Entered N
main spring. String
Up to 20 characters
Meter Data
Connection Style | Specifies the meter end connection type for | Entered N
the meter. Index
Maximum Specifies the maximum capacity for the meter | Entered N
Capacity installed at the station. Single Precision
>=0
Minimum Specifies the minimum capacity for the meter | Entered N
Capacity installed at the station. Single Precision
>=0
Pressure Rating Specifies the maximum pressure rating for the | Entered N
meter installed at the station. Single Precision
>= Absolute 0
Z
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Calculation

Rating Units Specifies the dimensional units used to | Entered N

express the various rating values. Fixed String
Size/Type Code Specifies the Size/Type Code for the meter (if | Entered N

any) installed at the station. String

Pilot Data - Down

stream & Upstream - Primary & Secondary*

Up to 20 characters

Manufacturer Specifies the manufacturer’s name for the | Entered N
associated pilot regulator. String
Up to 20 characters
Maximum Body [ Specifies the maximum body pressure rating | Entered N
Pressure for the associated pilot regulator. Single Precision
>= Absolute 0
Model Specifies the model name or number for the | Entered N
associated pilot regulator. String
Up to 20 characters
Pressure Units Specifies the dimensional units for the | Entered N
associated pressure values. Fixed String
Spring Color Specifies the spring color for the associated | Entered N
pilot regulator. Index
Spring Maximum | Specifies the maximum pressure rating for the | Entered N
Pressure spring for the associated pilot regulator. Single Precision
>= Absolute 0
Spring Minimum | Specifies the minimum pressure rating for the | Entered N
Pressure spring for the associated pilot regulator. Single Precision
>= Absolute 0
Spring Number Specifies the sizing/rating number for the | Entered N
spring for the associated pilot regulator. String
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Item Name Item Description Item Type Required
(See Notes) For
Calculation
Pressure Recorder Data
High Range Specifies the upper limit of the pressure | Entered N
recorder installed at the station. Single Precision
>= Absolute 0
Low Range Specifies the lower limit of the pressure | Entered N
recorder installed at the station. Single Precision
>= Absolute 0
Make/Type Specifies the name of the manufacturer and | Entered N
model or type of the data recorder (if any) | String
installed at the station. Up to 30 characters
Range Units Specifies the dimensional units usedto | Entered N
express the various range values. Fixed String

Notes

® The Equipment data is stored in the “equipment database” file. The equipment database file ends in a
“.ebd” extension. An equipment record is maintained for the devices in each stage of each run in a station.
® The /tem Type item lists whether the associated data item is Entered or Calculated, the value data type,
and any value restrictions. Entered means that the value can be entered by the User. Calculated means that
the value is computed and entered by the software. The data types are defined in the Program Limitations
topic.

® The Required For Calculation item indicates whether the item is required for a hydraulic calculation
to be performed. A “Y” value means that the item is required. An empty value means that the value is
optional. Optional items can be used to store alternative item values at the User’s discretion.

® Each of the items listed in the Device Data section is maintained for both the downstream and upstream
devices.

® Each of the items listed in the Pilot Data section is maintained for both the downstream and upstream
devices and the primary and secondary pilots for those devices.

* For upstream working monitor configurations, the primary upstream pilot is assumed to be associated
with the working/controlling pilot, and a secondary upstream pilot is assumed to be associated with the
monitor pilot.
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Equation Reference

StationManager 2.1 uses the same set of equation definitions supported by the GASCalc 5.0 software. As
an alternative to reproducing those definitions in this document - the appropriate GASCalc 5.0 calculation
references have been distributed with the StationManager software. Select the appropriate document from
the View Calculation References submenu of the Help menu to view the associated documentation.
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Personalize StationManager

Many Users have their own preferences on how they like to do their work and how they like the software to
react to certain actions. StationManager attempts to accommodate these personal preferences by allowing
a variety of preference and behavior settings to be made by the User. Some of these settings are applied only
to the StationManager operating environment; others are applied and saved with the database data. The
following table lists some of these settings, what they do, how they are set, and whether they apply to the
StationManager operating environment or to the database data. Not all of the settings and options are
included in the table. Descriptions of other options are included with the program features that they are
associated with.

Setting/Behavior Description Set Using

Operating Environment (Saved with StationManager)

Path (Files Locations)

Database Files Sets the location where StationManager The Paths (File Locations)
looks for database files. item of the File menu.

Image Files Sets the location where StationManager The Paths (File Locations)
looks for image files. item of the File menu.

Initialization Files Sets the location where the initialization files | The Paths (File Locations)

are saved. This item is useful if multiple | item of the File menu.
Users are using StationManager in a network
environment. This item can be used to set a
location for saving initialization and
preference settings for each User.

License File Sets the location where StationManager | The Paths (File Locations)
looks for the license file. This item is useful | item of the File menu.
when using StationManager in a network
environment.

Property Files Sets the location where StationManager | The Paths (File Locations)
looks for the assigned Property Tables. This | item of the File menu.
item is useful if multiple Users are using
StationManager in a network environment.
The value can be set to a common location so
that all Users are using the same set of
Property Tables and values.
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Setting/Behavior

Description

Set Using

Preferences

Automatically
Open Database

Indicates whether the previously opened
database is automatically re-opened each
time StationManager is started.

The Set Preferences item
of the Preferences
submenu of the File menu.

Hide...

Indicates whether the associated data items
and related messages are hidden from the
display. This item is useful if a certain group
of data items is not used - hiding their display
makes the User interface a bit less cluttered
and a bit easier to use.

The Set Preferences item
of the Preferences
submenu of the File menu.

Set Image Editor

Assigns the image editor to be used to
“view/edit” attached image files. If the item
is left empty (blank), the default Windows
image editor is used. If a value is entered,
enter the full path and executable filename
with the extension.

The Set Image Editor item
of the Preferences
submenu of the File menu.

Show Tooltips

Indicates whether “pop up” tooltips are
displayed when the mouse pointer is left idle
over a command button, data field, or data
list.

The Set Preferences item
of the Preferences
submenu of the File menu.

Database Environment (Saved With Database)

Calculation Options

Allow Empty
Component Lists

Specifies whether an error message should be
displayed when a station contains a piping
section with no components assigned.

The Set Calculation
Options item of the
Preferences submenu of
the File menu.

Atmospheric
Calculation Method

Specifies the method used to calculate the
atmospheric pressure values.

The Set Calculation
Options item of the
Preferences submenu of
the File menu.

Failure Style For
Two Stage Set

Specifies the mode of failure for runs
containing two pressure stages.

The Set Calculation
Options item of the
Preferences submenu of
the File menu.
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Setting/Behavior

Description

Set Using

Ignore Inlet/Relief
Or Security Valve
Set Pressure Check

Specifies whether the relief valve set
pressure is checked against the maximum
station supply pressure during calculations.

The Set Calculation
Options item of the
Preferences submenu of
the File menu.

Ignore Minimum
Differential
Pressure Check

Specifies whether an error message should be
displayed when the minimum differential
across a device is not achieved during the
calculation.

The Set Calculation
Options item of the
Preferences submenu of
the File menu.

Limit Pipe Flow To
Sonic Velocity

Specifies whether the flow velocity through
various pipe sections associated with a
station will be limited to sonic velocity
(choked/critical flow).

The Set Calculation
Options item of the
Preferences submenu of
the File menu.

Outlet To Set
Pressure Ratio

Specifies the check value for the station
outlet to the control device set pressure ratio.

The Set Calculation
Options item of the

Limit Preferences submenu of
the File menu.

Regulatory Specifies the code to use during the | The Set Calculation

Code/Specification | compliance check and calculation. Options item of the

Preferences submenu of
the File menu.

Reset Review Date
When Station Is

Specifies whether the “review date” data
item is automatically set to the current date

The Set Calculation
Options item of the

Failed Conditions

failed condition checks.

Calculated when a calculation is performed. Preferences submenu of
the File menu.
Velocity Limit - Specifies the maximum velocity limit for the | The Set Calculation

Options item of the
Preferences submenu of
the File menu.

Velocity Limit -
Normal Conditions

Specifies the maximum velocity limit for the
normal condition checks.

The Set Calculation
Options item of the
Preferences submenu of
the File menu.
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Setting/Behavior

Description

Set Using

Hydraulic Values and Units

Default Data
Values

Indicates the default values to be used to
populate various items for newly created
stations, runs, and stages.

The Set Default Values
item of the Utilities menu.

Default
Dimensional Units

Indicates the default and global dimensional
units for the various data values.

The Set Default Values
item of the Utilities menu.

Report Options

Number Of
Decimals To Report

Indicates the number of decimal places to be
displayed after the decimal point when
displaying or reporting data values.

The Set Report Options
item of the Report menu.

Coordinate Heading

Indicates the caption to be used for the
coordinate values.

The Set Report Options
item of the Report menu.

Coordinate Data

Indicates the format of the values entered for

The Set Report Options

Type the coordinate items. item of the Report menu.
Default Data Indicates which data entry screen to display | The Set Report Options
Screen when the Station Record column is double- | item of the Report menu.
clicked in the Station Data Report.
Z
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Query Features

The Mass Update routine is controlled, and the content of a report is modified using a User-defined query
specification. A query specification is a means of telling StationManager which records to display or modify.
Only records that meet the specification are used, while records that do not match the specification are
ignored. When used with the Mass Update routine, the query specification tells StationManager which
records to change. When used with the Station Data report, the query specification tells StationManager
which records to include in the report. When used with the report, multiple queries can be sequentially
implemented.

The following table summarizes the StationManager query features:

Desired Operation Applicable Query Operator

Find records equal to a Use the equal “=" operator.
specific value
For example, Size/Type Code =4P. This would find all records
where the Size/Type Code equals “4P.”

Find records not equal to a Use the not-equal “< > operator.
specific value
For example, Size/Type Code < > 4P. This would find all
records where the Size/Type Code is not equal to “4P.”

Find records less than a Use the less-than “<” operator.
specific value
For example, Pressure < 10. This would find all records where
the Pressure value is less than 10.

Find records greater than a Use the greater-than “>"" operator.
specific value
For example, Pressure > 10. This would find all records where
the Pressure value is greater than 10.

Find records less than or Use the less-than-or-equal “<=" operator.
equal to a specific value
For example, Pressure <= 10. This would find all records where
the Pressure value is less than or equal to 10.

Find records greater than or Use the greater than or equal “>=" operator.
equal to a specific value
For example, Pressure >= 10. This would find all records where
the Pressure value is greater than or equal to 10.

Find all records Use the “ALL” operator.
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Desired Operation

Applicable Query Operator

Find records similar to a
string value

Use the “LIKE” operator.

For example, Location LIKE Main St. This would find the
records where the location values contain the string “Main St.”

Find records not similar to a
string value

Use the “NOT LIKE” operator.

For example, Location NOT LIKE Main St. This would find the
records where the location values do not contain the string
“Main St.”

Find records with the
smallest values

Use the minimum “MIN” operator.

For example, Pressure MIN 10. This would find the records
associated with the ten lowest pressure values.

Find records with the largest
values

Use the maximum “MAX” operator.

For example, Pressure MAX 10. This would find the records
associated with the ten highest pressure values.

Find records that start with a
certain string value

Use the “STARTS WITH” operator.

For example, Station Identification starts with “HP.” This would
find all node records where the Station Identification starts with
the string “HP.”

Find records that end with a
certain string value

Use the “ENDS WITH” operator.

For example, Size/Type Code ends with “PE.” This would find
all records where the pipe Size/Type Code ends with the string
‘GPE"’

Note - Some data items are not supported by some operations.
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Standard Dimensional Units

The following table describes the standard or “native” units used by StationManager in its Solution and
Calculation routines. All other units are converted to these native units during the computations and then
converted back to the original units when the computation is complete.

Parameter Type Standard Dimensional Unit
Elevation Feet
Temperature Rankine
Pipe Diameter Inches
Pipe Roughness Inches
Pipe Length Feet
Pipe Efficiency Decimal
Pressure Drop Psi
Velocity Feet/sec
Viscosity Lbm/Ft-sec
Volumetric Flow Rate Cth
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StationManager Files

The following table describes the various files used by StationManager. Depending on the nature and features
included in a specific database and the routines used, some of these files may not always be present.

Category Filename Description
Program Files sm20.exe The StationManager program file.
smgdi.dll Contains the StationManager support functions.
smlic.dll Contains the StationManager license information.
Database Data Files databasename.sdb Contains general station data values.
databasename.edb Contains equipment data values.
databasename.idb Contains inspection data values.
databasename.rdb Contains hydraulic and equipment setting data values.
databasename.dft Contains default and global data values and various User
settings and option values.
Property Tables fitting.fpf Fitting Properties table
pipe.pfp Pipe Properties table
regulator.rpf Regulator Properties table
relief.lpf Relief Valve Properties table

Temporary Files

databasename.opn

When present indicates that the database is open.

randomnumber.sdb

When present contains the working copy of the general
station data values.

randomnumber.edb

When present contains the working copy of the
equipment data values.

randomnumber.idb

When present contains the working copy of the
inspection data values.

randomnumber.rdb

When present contains the working copy of the hydraulic
and equipment setting data values.

=
27| B3PE LLC

Engineering & Software Services

312

Revision - 002, Copyright 2024, All Rights Reserved.



StationManager™ 2.1

Appendix

Table Of Contents

Category

Filename

Description

Screen Initialization
Files

StatMan.ini

Contains StationManager preference settings and default
values.

*.ini Contains default values for various StationManager
routines and data screens.
Back-Up Files * bak Back-Up data file.
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StationManager Limitations

StationManager is a very powerful tool for managing and calculating data associated with a variety of types
of pressure control stations. However, it does have some limitations. The “station capacity” of the software
is related to the capacity of the particular version purchased; the remaining limitations apply to all versions.
The limitations of StationManager are:

Data Types

The Data Limitations and Database Definition refers to a variety of data types. In the context of the
descriptions contained in that table, the following data type definitions will apply.

Double Precision Numeric - Allows up to 15 significant digits. Unless otherwise specified, values of this
type can range from -1.7*107308 to 1.7*107308.

Integer Numeric - Allows up to 5 significant digits. Unless otherwise specified, values of this type can
range from -32000 to 32000.

Long Integer Numeric - Allows up to 10 significant digits. Unless otherwise specified, values of this type
can range from -2.1*10"9 to 2.1*¥10"9.

Single Precision Numeric - Allows up to 7 significant digits. Unless otherwise specified, values of this
type can range from -3.4*10% to 3.4*10%,

String Value - Allows entry of various length alphanumeric (text) string values. Special characters are
allowed.

Date Value - Allows date values in the MM/DD/YYYY format. Where MM means month in two-digit
format, DD means day in two-digit format, and YYYY means year in four-digit format.

Index - Allows an item value to be entered by specifying an index value in a data list. The index value is
generally generated internally by the software.

Fixed String - Used to enter various alphanumeric values, such as dimensional units. The index value is
generated internally by the software.

Boolean - Used to enter a true or false, yes or no, or selected or unselected value. Options and responses
are generated internally by the software.

Component - Used to identify a pipe or fitting component assigned to a piping section.
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Data Limitations

The contents of this table list the absolute minimum and maximum values allowed by the various general
parameters used in StationManager. The Database Definition contains descriptions of the various data
items and their respective data types.

Record Capacity - Version and memory dependent.

Pressure values may be any floating point number in the range from minus one atmosphere to the
maximum allowed single precision number.

Load and flow values may be any valid positive single precision number.

Pipe Diameter, Wall Thickness, and Roughness values may be any valid positive single precision number.

Pipe Lengths may be any valid positive single precision number.

Gas Properties may be any valid positive single precision number.

Temperatures may be any valid single precision number greater than absolute zero.

Elevation values may be any valid single precision number.

Dimensional units are restricted to those fixed string values displayed in the various data lists.

Up to ten images may be attached to a station record.

Up to ten components may be attached to a piping section.

Up to two runs may be configured for a station.

Up to two stages may be configured for each run.
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Supported Dimensional Units

StationManager uses a “standard” set of dimensional units for its internal calculations. When a value
expressed in a different unit is encountered, it is converted internally for use by StationManager. The
following table lists the supported dimensional units and the conversion factors used for internal use.

Unit Group Supported Types Conversion Factor

Coordinates Degrees L/L N/A - No Calculation
Lat/Long N/A - No Calculation
Feet, ft N/A - No Calculation
Kilometers, Kilometres, km N/A - No Calculation
Meters, Metres, m N/A - No Calculation
Miles, mi N/A - No Calculation

Diameter Centimeters, Centimetres, cm 0.3937
Feet, ft 12
Inches, in 1
Meters, Metres, m 39.37
Millimeters, Millimetres, mm 0.03937

Efficiency Decimal 1
Percent, % 0.01

Elevation Feet, ft 1
Meters, Metres, m 3.281

Flow Rate Ccf/mo (hundred cubic feet per month) 0.13689
Cfd (cubic feet per day) 0.041667
Cfth (cubic feet per hour) 1
Cfm (cubic feet per minute) 60
Liters/min, Litres/min (liters per minute) 2.1186
Ma3/d, M3d (cubic meters per day) 1.47125
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Unit Group Supported Types Conversion Factor
M~3/hr, M3/hr, M3h (cubic meters per hour) 35.31
Mecfd (thousands of cubic feet per day) 41.667
Mcfh (thousands of cubic feet per hour) 1000
Mcf/mo (thousands of cubic feet per month) 1.3689
Mm3/d, Mm3d (thousands of cubic meters per day) | 1471.25
Mm3h (thousands of cubic meters per hour) 35310
MMecfd (millions of cubic feet per day) 41667
MMcfth (millions of cubic feet per hour) 1000000
MMm3d (millions of cubic meters per day) 1471250
Length Centimeters, Centimetres, cm 0.03281
Feet, ft 1
Inches, in 1/12
Kilometers, Kilometres, km 3281
Meters, Metres, m 3.281
Miles, mi 5280
Pressure (Abs) in-wc (Abs) (inches of water column) 0.036092
in-HG (Abs) (inches of mercury) 0.491154
Psi (Abs) (pounds per square inch) 1
Pressure (Gauge) Atmosphere, atm 14.7
Bar 14.504
Feet H20, ft-wc 0.4335
Inches H20, in-wc (inches of water column) 0.036092
Inches HG, in-HG (inches of mercury) 0.491154
KPa (thousands of Pascals) 0.14504
Millibar, mBar 0.014504
MPa (millions of Pascals) 14504
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Osi (ounces per square inch) 0.0625
Pascals, pa 0.00014504
Psi, Psig (pounds per square inch) 1
Temperature Celsius, C °C * 1.8 +491.67
Fahrenheit, F °F +459.67
Kelvin, K K*1.8
Rankine, R 1
Velocity Feet/sec, FPS (feet per second) 1
KMeters/hr, KMetres/hr, Kph 091139
Meters/sec, Metres/sec, MPS (meters per second) 3.281
Miles/hr, Mph (miles per hour) 1.4667
Viscosity Centipoise, Cpoise, cp 0.000672
Lbf-sec/Ft*2 (pound force second per square foot) 32.2
Lbm/Ft-sec (pound mass per foot second) 1
Micropoise 6.72 E-08
Pascal-sec, Pa-sec (Pascal second) 0.672
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Temperature Calculations

StationManager assumes that the gas flowing temperature remains constant throughout the station piping and
devices. This, of course, is not true; however, the assumption results in conservative results in terms of
pressure drop and flow capacity - it tends to overestimate pressure drop and underestimate flow capacity. No
temperature calculations are performed as part of the StationManager calculation routines.
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The following table describes some of the terms associated with the StationManager database environment.

Term

Definition

Atmospheric Pressure

The pressure exerted on an object by the atmosphere. Defined in the Support
Equations section of the Appendix.

Base Pressure

Refers to the pressure used as the basis for stating a volume or volumetric
flow rate. Usually specified by tariff or sales agreement.

Base Temperature

Refers to the temperature used as the basis for stating a volume or
volumetric flow rate. Usually specified by tariff or sales agreement.

Calculated Value Display panels highlighted with a yellow background color represent
calculated data values. The value cannot be directly edited by the User.

Database The combination of various linked files that are used to represent the data
used by StationManager, including the default data, station data, run data,
equipment data, and inspection data.

Diameter Refers to the Size/Type Code or inside diameter of a pipe segment.

Fitting A piping component that represents an actual pipe fitting (For example, an
elbow, tee, etc.) or a component that can be represented by an equivalent
length value (For example, a valve).

Pipe A piping component that represents an actual pipe segment, as opposed to
a fitting.

Property Table A set of data files that contain common data associated with the various

pipes, devices, and fittings used by StationManager. Each Property Table
contains specific information about the type it represents. For instance, the
Pipe Property Table contains information on the pipe type features, such as
the Inside Diameter value.

Schematic Data Interface

A line representation of the station.
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